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1 Interface Basics

FoxPro’s interface consists of menus, windows, dialogs and other
features that make it easy for you to communicate with FoxPro.

The interface is non-procedural, so you can perform operations
without typing commands. It is also event-driven — it waits for
you to tell it what to do next. You control the sequence of actions
that the computer performs.

FoxPro is designed for use with a mouse or a standard keyboard.
With a keyboard, you use the arrow keys and keystroke combina-
tions to choose objects and controls in the interface. Although
FoxPro does not require a mouse, we recommend it for its ease-of-
use. With the click of a button, a mouse can accomplish the
equivalent of a single keystroke or many keystrokes on the key-
board.

This chapter is divided so that keyboard users can refer to the
Keyboard Techniques portion and mouse users can refer to the
Mouse Techniques portion. Mouse users who wish to use the key-
board for certain activities may want to read the Keyboard Techni-
ques section, also. At the end of the chapter, several general topics
are discussed that relate to both mouse and keyboard users.
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Keyboard Techniques

Keyboard Techniques
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Every FoxPro operation can be controlled with the keyboard, as
described in this section. However, keyboard users might find it
handy to use the mouse for certain operations. For example, with
a mouse you can control system windows by clicking and dragging.
This is often faster and easier than using the keystroke
equivalents.

Throughout the FoxPro documentation, certain terms appear fre-
quently. These terms are defined in the Glossary in the FoxPro
Getting Started manual.

Interface Basics



Using Menus with the Keyboard

Using Menus with the Keyboard

The FoxPro menu system consists of the following parts: menu bar,
menu pads, menu popups and menu options. The menu system
allows you to communicate with FoxPro without programming.
Each part of the menu system is described below.

Menu Pad

System File Edit JPEYEVECTE Record Program UWindou

Menu Bar

Menu Popup —

Setup...
Brouse

NI —— Menu Option

Copy To...
Sort...
Total...

Average. ..
Count...
Sum. ..
Calculate...
Report...
Label...

Pack
Reindex

Menu System

Menu Bar

A menu bar is located along the top of the screen. The menu bar
displays names for menu popups. These names on the menu bar
are called menu pads.

The content of the menu bar changes as you access different parts
of the interface. Different actions cause menu pads to be added to
and removed from the menu bar.

Menu Pads

Menu pads appear on the menu bar and display the names of
menu popups. You can use the keyboard to display the menu
popup associated with each menu pad. Sometimes, certain menu
pads appear dimmed and cannot be chosen. These menu pads are
disabled.
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Using Menus with the Keyboard
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To access the menu bar, press the Alt key (or press F10). The
System menu pad appears highlighted because it is selected.
Press the Right and Left Arrow keys to move from menu pad to
menu pad. When you are ready to exit the menu bar, press one of
the following keys: Escape, Alt or F10.

Dimmed text is deemphasized so that it has little contrast
with its surroundings.

Highlighted text is emphasized so that it stands out from
the surroundings. Highlighting something typically indicates
that it is selected or is about to be chosen.

The appearance of dimmed and highlighted text may vary
depending on the type of monitor and color settings that you
use.

Menu Popups

G1l-4

Menu pads control menu popups. Menu popups are lists of related
options. When you choose an option from a menu popup, you are
telling FoxPro what action to take. Choose means to activate a
selection (highlighted option) by pressing the Spacebar.

Sometimes, certain menu pads appear dimmed and cannot be
chosen. These menu pads are disabled. You cant display the
menu popup if the menu pad is disabled.

To display a menu popup, do one of the following:

¢ Press Alt then press the hot key in the menu pad name. The
hot key is highlighted and is usually the first letter in the
menu pad name.

® Press F10 then press the hot key in the menu pad name.

If you are already in the menu bar, you can display a popup by
pressing the hot key in the menu pad name. You can also press
the Left and Right Arrow keys until the menu pad is selected, then
press the Spacebar to display the menu popup.

Once a menu popup is displayed, you will usually choose an avail-
able option, as described in the next section. If you wish to deac-
tivate a menu popup without choosing an option, press Escape, Alt
or F10.
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Menu Options

Menu popups contain options. The options on each menu popup
are logically related to the menu pad name. On a single menu
popup, options may be further grouped to indicate that they
produce similar outcomes. These groups are separated by divider
lines.

Certain menu options are followed by an ellipsis (...). When you
choose this type of option, a dialog appears to request additional
information.

Some menu options have a Control key shortcut listed next to
them on the popup. You can use a Control key combination to
choose the menu option without displaying the menu popup.

Sometimes, a menu option appears dimmed and cannot be chosen.
This menu option is disabled.

Before you choose a menu option, use one of the methods discussed
in the previous section to display the menu popup. Once the
popup appears, choose an option in one of the following ways:

® Press the hot key for the option.

e TUse the Up and Down Arrow keys to select the desired option,
then press the Spacebar.

When you choose a menu option, an action occurs. A window may
open or close, a switch may be set, a dialog may appear or a com-
mand may be generated in the Command window.

When you use the interface, you're actually generating commands
in the Command window. You can also type commands directly in
the Command window.
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Using Dialogs with the Keyboard
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Radio
Butto

When you choose a menu option that is followed by an ellipsis (...),
the box that appears is called a dialog. Dialogs also appear at
other times during your FoxPro session when more information is
required to complete a command or an expression.

Dialogs contain a variety of controls that you use to designate, con-
firm or cancel actions. These controls are explained below.
Methods of moving in dialogs are discussed in the next section.

When a dialog is displayed, you must exit it before you can use
any other features of FoxPro. To exit a dialog, choose the ap-
propriate push button or press Escape (to cancel the dialog). If a
dialog is displayed and you try to perform an action outside of it,
other than select an active menu pad, the computer beeps.

[X]1 Wrap uwords Tab size: K]
[X] Auto indent
[X]1 Make backup [ 1 Use these preferences
[X] Add line feeds as default for files
[ 1 Status line uith no extension
[ 1 Add Ctrl-2 [ 1 Save preference
ns (> Left Jjustify
C > Right justify « OK » <Cancel>
C > Center justify ]
|
Push Buttons

Preferences Dialog

Push Button — A push button is enclosed in angle brackets, as
shown, and contains key words that describe the action it triggers.
The action associated with a push button occurs immediately when
you choose the push button unless it contains an ellipsis (...). The
ellipsis indicates that another dialog will appear.

The « » push button (with double angles) is the default push but-
ton. To choose the default push button, press Ctrl+Enter from any
location in the dialog, or Tab to the push button and press the
Spacebar.
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Check Box — A check box is a pair of square brackets followed by
text. Settings can be turned on and off by choosing the check box
with the Spacebar. If a check box has an X in it, the setting is on.
More than one box in a group can be checked at the same time.

Radio Button — A radio button is a set of parentheses followed by
text. Unlike check boxes, only one radio button in a group can be
chosen at any given time. Select a radio button and press the
Spacebar to choose it. When a radio button is chosen, a bullet
appears in the parentheses and any previously chosen radio button
in the group becomes deselected.

Save fAs: “
[..] Drive o II o———ﬁ
CLABEL. LBL

CONFIG. FP g‘;fl‘tlﬁ)l .
List CREDITS. PRG ‘
—— | CSTLEDGR. PRG Directory | SAMPLE II
CUSTLABE. PRG
CUSTLIST. PRG |
CUSTMENU. PRG « Save »
: [X1 All Files < Cancel >
Text
Box r |

L

Save As Dialog

Popup Control — The rectangle with double lines on the right
and bottom edges is a popup control that you can choose to display
the associated popup.

To display the popup, Tab to the popup control and press the
Spacebar. Now you can use PgDn and PgUp to scroll the list one
full window at a time. Home and End move you to the first or last
option on the popup. To choose an option, press the Up and Down
Arrow keys to select the option, then press the Spacebar.

Interface Basics G1-7



Using Dialogs with the Keyboard

Some popups are alphabetized. To move directly to an option on
an alphabetized popup, type enough letters to uniquely identify the
option. The letters you type don’t appear on the screen. When the
appropriate option is selected, press the Spacebar to choose it.

List — This box contains a list of items like directories, files and
fields that you can select. Once you Tab to the list, you can move
through the list in the following ways:

® Press the Up and Down Arrow keys to move through the list
item-by-item.

¢ Press PgUp and PgDn to display the previous or next window
of list options.

® Press Home and End to select the first or last item in the list.

Some lists are alphabetized. To move directly to an item in an
alphabetized list, type enough letters to uniquely identify the item.
The letters you type don’t appear on the screen. FoxPro highlights
the first item that begins with the typed letters. After a short
time, FoxPro is ready to accept the next set of letters to find a
different item in the list.

Depending on the action that you want to occur, you may need to
press the Spacebar or Enter to choose the item.

Text Box — This bar, as shown, indicates where you may enter
text. To enter text in a text box, press the Tab key until the text
box is selected. Type and edit as usual.

Movement in Dialogs with the Keyboard

G1-8

In a dialog, you can always use the Tab key to move from control
to control. Other methods for maneuvering in dialogs also exist.

In many dialogs, each control has a hot key for your convenience.
A hot key is a highlighted letter that you can type to immediately
choose the desired control.

When a dialog doesn’t have hot keys, an additional menu pad is
usually added to the menu bar. The menu popup is for use with
the dialog and contains Control key shortcuts you can use to
navigate in the dialog. If a menu option has a Control key
shortcut, the shortcut appears next to the option on the menu

popup.

Interface Basics



Using Dialogs with the Keyboard

The following keys allow you to maneuver in dialogs with the key-
board.

Escape — Exits the dialog without taking any action.

Ctrl+Enter — Ignores the current selection and chooses the
default push button. The default push button is delimited with
double angles (« »).

Tab — Selects the next dialog control.
Shift+Tab — Selects the previous dialog control.

Up/Down Arrows — When in a list or menu popup, the Up/Down
Arrows move up and down through the list, item-by-item.

Home and End — When in a list or popup, Home and End select
the first or last item in the list.

PgUp and PgDn — When in a list or popup, PgUp and PgDn dis-
play the previous or next window of the list.

Repositioning Dialogs on the Screen

Dialogs can be repositioned on the screen. To move a dialog using
the keyboard, press Ctrl+F7. The border flashes. Use the arrow
keys to move the dialog by small increments in the desired direc-
tion. Press PgUp or PgDn to move the dialog to the top or bottom
of the screen. Home or End moves the dialog to the left or right
edge of the screen. When you're finished, press Enter. The border
stops flashing.
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Controlling System Windows with the Keyboard

Open

Close

G1-10

FoxPro windows can be manipulated in several ways. Besides
opening and closing a window, you can hide, move, size, zoom and
scroll most windows.

Windows can be opened in a variety of ways. The Command win-
dow is automatically opened when you begin a FoxPro session. If
you close the Command window, you can open it again by choosing
Command from the Window menu popup. The Debug, Trace and
View windows can be opened by choosing their names from the
Window menu popup. To open the Browse window, you can choose
Browse from the Database menu popup, choose the Browse push
button in the View window, or press the Spacebar twice (or press
Enter) on a work area with an open database.

To open other system windows, choose Open... from the File menu
popup. The Open File dialog appears. Through this dialog, you
can open program editing windows, text editing windows, Report
Layout windows and Label Layout windows. For information
about the Open File dialog, refer to the File Menu chapter.

When you open a window, it becomes the frontmost window on
your screen. You can recognize the frontmost window because it is
the only window with controls drawn on it and its title appears
different than any other window titles. The names of open win-
dows are listed at the bottom of the Window menu popup if the
window name is not already an option on the Window menu.

When a window is closed, you can no longer see its contents. To
close the active window, press Escape or choose Close from the
File menu popup. Escape doesn’t close the Command window.

If you want to close all open windows, hold down the Shift key and
display the File menu popup (Shift+Alt+F). Choose Close All from
the File menu popup and all open windows are closed.
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Hide
Hiding a window makes it invisible without closing it. To hide a

window, choose Hide from the Window menu popup. The window
disappears.

To hide or display all open windows, hold down the Shift key and
display the Window menu popup (Shift+Alt+W). The Hide option
is replaced with options that allow you to Hide All windows and
Show All windows. To momentarily hide all windows in front of
the current output window (which may be the screen), hold down
Shift+Ctrl and press Alt.

To bring a hidden window to the front again, choose its name from
the bottom of the Window menu popup. If the window is a memo
editing window, program editing window, text editing window,
Report Layout or Label Layout window, its contents will appear
the same as when the window was hidden.

Move

To move a window to a new location, choose Move from the Win-
dow menu popup (or press Ctrl+F7). The window border flashes,
indicating that it is ready to be moved. Now you can use the
arrow keys, PgUp, PgDn, Home and End to position the window on
your screen. When the window is relocated, press the Enter key
and the window stops flashing.

Size
To change the size of a window, choose Size from the Window
menu popup (or press Ctrl+F8). The window border flashes, in-
dicating that it is ready to be sized. Press the arrow keys to adjust
the right and bottom borders of the window. When the window is
the desired size, press Enter and the window stops flashing.
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Zoom T

Zoom |

To zoom a window, choose Zoom T from the Window menu popup
(or press Ctrl+F10). The window expands to fill the screen. If a
window is already full size and you choose Zoom T, the window
contracts to its previous size.

To minimize a window, choose Zoom | from the Window menu
popup (or press Ctrl+F9). The window becomes one line tall by 16
characters wide with the title of the window displayed.

To minimize and “dock” the window in the lower right corner of
the screen, do one of the following:

® Press Shift+Ctrl+F9.
* Hold down the Shift key and choose Zoom ..

To return a minimized window to its original size, do one of the
following:

® Choose Zoom | from the Window menu popup.
® Press Ctrl+F9.

Cycling Among Open Windows

Scroll

G1-12

Cycle refers to the process of rearranging open windows to bring
successive ones to the front. To cycle, choose Cycle from the Win-
dow menu popup (or press Ctrl+F1) until the window of your
choice is the frontmost window.

You can move through a window’s contents with the keyboard by
using the following keys: arrow keys, PgUp, PgDn, Home and End.
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Mouse Techniques

It is particularly convenient to operate FoxPro with a mouse. To
do this, you must load the mouse driver and attach a mouse to
your computer. When you complete these steps and start FoxPro,
a pointer appears on your screen. The pointer is a solid box that
contrasts with whatever it rests upon.

When you roll the mouse, the pointer moves. You can position the
pointer and click (press and release the mouse button) to anchor
the cursor. The cursor marks the location where an action will
occur.

Mouse users may wish to use the keyboard to take advantage of
Control key shortcuts. By pressing a Control key combination, you
can choose most menu options without displaying the menu popup.

Before you begin to use a mouse with FoxPro, read the following:

® Place the mouse on a flat surface to the left or right of your
keyboard, whichever is most comfortable.

¢ Place your palm on top of the mouse with your fingertips
resting on the mouse buttons and practice rolling the mouse.

¢ In FoxPro, you'll notice that rolling the mouse forward and
backward on the flat surface causes the pointer (a solid box)
to move up and down on your screen.

¢ Rolling the mouse right and left moves the pointer right and
left.

® Roll your mouse to the edge of the flat surface, pick it up and
move it back to the center of the surface, and continue rolling.
Notice that the pointer does not move while the mouse is in
the air, but resumes from the place it left off once the mouse
is replaced on the surface.

Note that the left button on your mouse is the only button FoxPro
usually requires.
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Using Menus with the Mouse

The FoxPro menu system consists of the following parts: menu bar,
menu pads, menu popups and menu options. The menu system
allows you to communicate with FoxPro without programming.

Menu Pad

System File Edit SILVEIS-M Record Program Windou

Menu Bar

Menu Popup —

Setup...
Brouse

(T Menu Option

Copy To...
Sort...
Total...

Average. ..
Count...
Sum. ..
Calculate...
Report...
Label...

Pack
Reindex

Menu System

Menu Bar

A menu bar is located along the top of the screen. The menu bar
displays titles for menu popups. These titles on the menu bar are
called menu pads.

The content of the menu bar changes as you access different parts
of the interface. Different actions cause menu pads to be added to
and removed from the menu bar.

Menu Pads

G1-14

Menu pads appear on the menu bar and display the names of
menu popups. You can use the mouse to display the menu popup
associated with each menu pad. Sometimes, certain menu pads
appear dimmed and cannot be chosen. These menu pads are dis-
abled.
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N Dimmed text is deemphasized so that it has little contrast
- @ - with its surroundings.

Highlighted text is emphasized so that it stands out from
the surroundings. Highlighting something typically indicates
that it is selected or is about to be chosen.

The appearance of dimmed and highlighted text may vary
depending on the type of monitor and color settings that you
use.

Menu Popups

Menu pads contain menu popups. Menu popups are lists of related
options. When you choose an option from a menu popup, you are
telling FoxPro what action to take.

Sometimes, certain menu pads appear dimmed and cannot be
chosen. These menu pads are disabled. You can’t display the
menu popup if the menu pad is disabled.

To display a menu popup, point to a menu pad and press the
mouse button. If STICKY is SET ON (the default), the menu popup
will remain on the screen until you choose an option or click
anywhere off of the menu popup.

If STICKY is SET OFF, you must continue to hold down the mouse
button after you point to the menu pad to keep the menu popup on
the screen. When you release the mouse button, the menu popup
is removed from the screen. For more information about SET
STICKY, refer to the FoxPro Commands & Functions manual.

Menu Options

Menu popups contain options, as shown in the illustration of the
menu system. The options on each menu popup are logically re-
lated to the menu pad. On a single menu popup, options may be
further grouped to indicate that they produce similar outcomes.
These groups are separated by divider lines.

Certain menu options are followed by an ellipsis (...). When you
choose this type of option, a dialog appears to request additional
information.

Some menu options have a Control key shortcut listed next to
them on the popup. You can use a Control key combination as a
shortcut to choose a menu option without displaying the menu
popup.
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Sometimes, a menu option appears dimmed and cannot be chosen.
This menu option is disabled.

Before you choose a menu option with STICKY SET ON (the default),
point to the menu pad and click. The menu popup appears. Click
on the desired option to choose it. The menu popup disappears.

Before you choose a menu option with STICKY SET OFF, point to the
menu pad and hold down the mouse button. The menu popup ap-
pears. While still holding down the mouse button, drag until the
appropriate option is selected. Now you can release the mouse
button to choose the option. The menu popup disappears.

When you choose a menu option, an action occurs. A window may
open or close, a switch may be set, a dialog may appear or a com-
mand may be generated in the Command window.

When you use the interface, you're actually generating commands
in the Command window. You can also type commands directly in
the Command window.
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Using Dialogs with the Mouse

When you choose a menu option that is followed by an ellipsis (...),
the box that appears is called a dialog. Dialogs also appear at
other times during your FoxPro session when more information is
required to complete a command or expression. A dialog requires
you to provide additional information before a command can ex-
ecute.

Dialogs contain a variety of controls that you use to designate, con-
firm or cancel actions. These controls are explained below. Using
the mouse, you can move in dialogs by positioning the pointer,
selecting and clicking the mouse button to choose.

Once a dialog is displayed, you must exit it before you can use any
other features of FoxPro. To exit a dialog, choose the appropriate
push button or press Escape (to cancel the dialog). If a dialog is
displayed and you try to perform an action outside of it, other than
select an active menu pad, the computer beeps.

[X]1 Urap words Tab size: 4

[X] Auto indent

[X1 Make backup [ 1 Use these preferences
[X] Add line feeds as default for files
[ ] Status line uith no extension

[ 1 Add Ctrl-Z [ 1 Save preference

Radio (-> Left justif
+) Left Jjustify
Buttons () Right justify « QOK » <Cancel>
¢ ) Center justify I
|
Push Buttons

Preferences Dialog

Push Button — A push button is enclosed in angle brackets, as
shown, and contains key words that describe the action it triggers.
The action associated with a push button occurs immediately when
you choose a push button unless it contains an ellipsis (...). The
ellipsis indicates that another dialog will appear.

The « » push button (with double angles) is the default push but-
ton. To choose the default push button, click with the mouse or
press Ctrl+Enter.
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List

Text
Box

Check Box — A check box is a pair of square brackets followed by
text. Settings can be turned on and off by clicking the check box
with the mouse. If a check box has an X in it, the setting is on.
More than one box in a group can be checked at once.

Radio Button — A radio button is a set of parentheses followed by
text. Unlike check boxes, only one radio button in a group can be
chosen at any given time. Click a radio button to choose it. When
a radio button is chosen, a bullet appears in the parentheses and
any previously chosen radio button in the group becomes
deselected.

Save fAs: ]

[..] Drive C
CLABEL. LBL
CONFIG.FP
CREDITS. PRG
CSTLEDGR. PRG Directory SAMPLE "
CUSTLABE. PRG
CUSTLIST. PRG
CUSTMENU. PRG « Save »
[X] All Files < Cancel >
I
I
Save As Dialog

Popup Control — This rectangle with double lines on the right
and bottom edges, as shown, is a popup control that you can
choose to display the associated menu popup.

To display the popup, point to the popup control and hold down the
mouse button. Once a popup is displayed, drag to select the ap-
propriate option and release the mouse button. The option is
chosen.

List — This box contains a list of items like directories, files and
fields that you can select. If necessary, click on the arrow at either
end of the scroll bar to move through the list. Click on the desired
item to select it. Now you can choose the appropriate push button.

Text Box — This bar indicates where you may enter text. To enter
text in a text box, click on the text box to position the cursor. Type
and edit as usual.
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Repositioning Dialogs on the Screen

Dialogs can be repositioned on the screen. To move a dialog using
the mouse, point to the top border and drag until the dialog is in
the desired location. Release the mouse button.
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Controlling System Windows with the Mouse

FoxPro system windows can be manipulated in several ways. Be-
sides opening and closing a window, you can hide, move, size, zoom
and scroll most windows.

Close Box Title Zoom Control

Scroll Bar

Size Control —J

Command Window

Open

Windows can be opened in a variety of ways. The Command win-
dow is automatically opened when you begin a FoxPro session. If
you close the Command window, you can open it again by choosing
Command from the Window menu popup. The Debug, Trace and
View windows can be opened by choosing their names from the
Window menu popup. You can open a Browse window by choosing
Browse from the Database menu popup. In the View window, you
must click the Browse push button, choose Browse from the
Database menu popup or double-click on a work area with an open
database to open a Browse window. To double-click, press and
release the mouse button two times in succession.

To open other system windows, choose Open... from the File menu
popup. The Open File dialog appears. See the File Menu chapter
for more information about the Open File dialog.
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When you open a window, it becomes the frontmost window on
your screen. You can recognize the frontmost window because it is
the only window with controls drawn on it and its title appears
different than any other window titles. The names of open win-
dows are listed at the bottom of the Window menu popup if the
window name is not already an option on the Window menu.

Close

To close an open window, choose Close from the File menu popup
or click the close box. The close box is located in the upper left
corner of all system windows. When a window is closed, you can
no longer see its contents.

To close all open windows, hold down Shift and choose Close All
from the File menu popup.

Hide
Hiding a window makes it invisible without closing it. To hide a
window, choose Hide from the Window menu popup.

If you wish to hide or display all open windows, hold down the
Shift key and display the Window menu popup. The Hide option
is replaced with options that allow you to Hide All windows and
Show All windows.

To momentarily hide all windows in front of the current output
window (which may be the screen), hold down Shift+Ctrl+Alt.

To display a hidden window again, choose its name from the bot-
tom of the Window menu popup. If the window is a memo editing
window, program editing window, text editing window, Report
Layout or Label Layout window, its conténts will appear the same
as when the window was hidden.

User-defined windows can be hidden by choosing Hide from the
Window menu popup or by using the HIDE WINDOW command. If a
user-defined window is defined with the CLOSE option, you can also
hide it by holding down the Shift key and clicking the mouse on
the close box in the upper left corner of the window.

To redisplay a hidden user-defined window, choose its name from
the bottom of the Window menu popup or use the SHOW WINDOW
command.

Interface Basics G1-21



Controlling System Windows with the Mouse

Move

Size

Zoom T

Zoom |

G1-22

To move a window to a new location, position the pointer on the
window title, hold the mouse button down and drag the window.
When the window is in its new location, release the mouse button.

When you have several windows (system or user-defined) on the
screen at one time, moving a window with the mouse brings the
window to the front of all the windows. To move a window and
maintain its position relative to other windows, hold down the
Shift key and drag the window with the mouse. The window will
pass behind or in front of other windows, maintaining its position
relative to other windows.

To change the size of a window, use the size control. The size
control is located in the lower right corner of a window. To size a
window, position the pointer on the size control, hold down the
mouse button and drag until the window is the desired size.

The Zoom T option from the Window menu popup and the zoom
control in the upper right corner of the window act as a toggle
between current window size and full screen size.

To minimize a window, choose Zoom | from the Window menu
popup or double-click the mouse on the top border of the window.
The window becomes one line tall by 16 characters wide with the
title of the window displayed.

To minimize and “dock” the window in the lower right corner of
the screen, do one of the following:

¢ Hold down the Shift key and double-click the mouse on the
top border of the window.

® Hold down the Shift key and choose Zoom ..

To return a minimized window to its original size, do one of the
following:

¢ Double-click the mouse on the top border of the window.

¢ Choose Zoom | from the Window menu popup.
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Cycle

Cycle refers to the process of rearranging open windows to bring
successive ones forward. Choose Cycle from the Window menu
popup as many times as necessary to bring the window of your
choice to the front. You can also click on the desired window to
bring it forward. You may have to move and size overlapping win-
dows so that you can bring the desired window forward.

Scroll

Scroll bars are located along the right edge and, sometimes, along
the bottom edge of system windows. Click the arrows at either
end of the scroll bar to move through the contents of a window a
little at a time. Click one time in the page up or page down region
to move up one page or down one page. Drag the diamond-shaped
thumb to move through the window contents rapidly. The position
of the thumb also indicates your position in the file. When the
thumb is in the middle of the scroll bar, the data in your window
is from the middle of your file.
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Command Window

The Command window is a FoxPro system window. When you
choose options from menu popups, youre actually generating
FoxPro commands in the Command window.

You can also type FoxPro commands directly in the Command win-
dow — just position the cursor in the Command window and type.
Press Escape to delete text you've typed in the Command window
if you haven't pressed Enter yet.

FoxPro stores all commands in a history list so that you can recall,
edit and re-execute them. Commands can be recalled by scrolling
through the Command window until you find the command. To
re-execute a command, position the cursor anywhere on the ap-
propriate command line and press Enter.

To edit a command, scroll through the Command window until you
find the appropriate command. Add, delete or change any informa-
tion in the command using FoxPro’s text editing capabilities. For
more information, refer to the Text Editor section of this chapter.

Command Continuation
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Lengthy commands, such as an SQL SELECT command or a BROWSE
with multiple options, frequently extend beyond the right margin
of the Command window. When this happens, you can split the
command onto multiple lines for easier editing and viewing. Lines
in programs can also be split in the same manner.

To keep a long command from extending beyond the right margin
in the Command window:

1. Type a semi-colon (;) where you want to split the command. The
semi-colon must follow a space in the command.

9. Press Enter to move the cursor to the next line in the Com-
mand window.

3. Type the remainder of the command.

Although your command is now on more than one line, FoxPro
reads the separate lines as a single command. To execute a com-
mand split onto multiple lines, place the cursor at the end of the
command and press Enter.
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Automatic Indentation

Automatic indentation is available when you enter commands in
the Command window. Auto indent allows you to easily construct
indented program code.

To indent a command in the Command window, press Tab. You
may press Tab repeatedly for additional indentation.

After a line is indented in the Command window, any continuation
lines are automatically indented the same amount when you press
Enter.

Indentation greatly improves the readability of commands split
onto multiple lines in the Command window. See the discussion
on command continuation above for information on splitting com-
mands onto multiple lines.
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Alerts
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An alert is a box that contains a warning or an error message. It
appears on the screen when you ask the computer to do something
it can’t do, or you're about to do something that will destroy infor-
mation.

Alerts can be repositioned on the screen. To move an alert using
the mouse, point to the top border and drag until the alert is in
the desired location. Release the mouse button.

To move an alert using the keyboard, press Ctrl+F7. The border
flashes. Use the arrow keys to move the alert by small increments
in the desired direction. Press PgUp or PgDn to move the alert to
the top or bottom of the screen. Home or End moves the alert to
the left or right edge of the screen. When you’re finished, press
Enter. The border stops flashing.

One example of an alert is shown below:

Syntax error.

If the alert contains no push buttons, use one of the following
methods to remove it from the screen:

® (Click the mouse button.

® Press any key except for function keys, modifier keys (Ctrl
and Shift) and Alt.

Now you can continue the action you were involved in before the
alert appeared.
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Another example of an alert is shown below:

»x% INTERRUPTED ’ex

« Cancel » < Suspend > < Ignore >

If the alert contains push buttons, use one of the following
methods to remove it from the screen:

® (lick the mouse button on the appropriate push button.
® Tab to the appropriate push button and press Enter.
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System Messages

A system message is a box that contains information about the
action you are performing. It differs from an alert because the
information is not in the form of a warning or an error message.

Use one of the following methods to remove a system message
from the screen:

® Move the mouse.

® Press Shift or Ctrl. Pressing either of these keys has no effect
on the current text area.

The “Press any key to continue” message is an exception.
You can momentarily hide it by pressing Shift or Ctrl. When
you release Shift or Ctrl, this message reappears. You must
press a different key or the mouse button to continue. This
particular system message can be moved in the same man-
ner as an alert.

Another exception is the “Recording...” message that ap-
pears when you are recording a new macro. This message
cannot be hidden.

After you remove the system message from the screen, you can
continue the action you were involved in before the message ap-
peared. An example of a system message is shown below:

Expression is valid
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Shortcuts for Menu Options

FoxPro provides shortcuts for choosing menu options. These
shortcuts are called hot keys and Control keys.

You can use hot keys to choose a menu option once the appropriate
menu popup is displayed. A hot key is a letter that is highlighted.
First, press Alt (or F10) and press the hot key in the menu pad
name to display the menu popup. Notice that each available menu
option contains a hot key. Instead of using the arrow keys and
Spacebar to choose an option, press the appropriate hot key.

Control key shortcuts allow you to choose certain menu options
without displaying the menu popup. All you need to do is press
the Control key combination that is listed next to the desired op-
tion on the menu popup. Control key shortcuts are listed on the
following page.
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Control Key Shortcuts

Key Action
Ctrl+A Select All
Ctrl+C Copy
Ctrl+D Do
Ctrl+E Replace And Find Again
Ctrl+F Find
Ctrl+G Find Again
Ctrl+K Continue
Ctrl+M Resume
Ctrl+Q Same as Escape
Ctrl+R Redo
Ctrl+U Undo
Ctrl+V Paste
Ctrl+W Exit current edit and save any modifications
Ctrl+X Cut
Ctrl+F1 Cycle windows
Ctrl+F2 Display Command window
Ctrl+F7 Move window
Ctrl+F8 Size window
Ctrl+F10 Zoom window
Escape Exit current edit without saving modifications;

exit dialog without taking action
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Function Keys

The default values assigned by FoxPro to the function keys F1
through F10 are listed below.

Key Function

F1 (Activate online help)

F2 Set

F3 List

F4 Dir(ectory)

F5 Display Structure

F6 Display Status

F7 Display Memory

F8 Display

F9 Append
(Activate/deactivate

F10 the system menu
bar — same as Alt)

You can assign new values to F1 through F10 by choosing
Macros... from the System menu popup or with the SET FUNCTION
command. Function keys beyond F10 are not supported in FoxPro.
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Text Editor

A text editor allows you to type and modify text. In FoxPro, you
can edit text in program, text and memo editing windows, in the
Command window and in dialog text editing regions and text
boxes. Eight basic keys and two modifier keys, Shift and Ctrl, con-
trol all cursor action in the editor.

The FoxPro editor is handy to use for all sorts of text manipula-
tion. It has a variety of features that allow users to enter and
modify text. The FoxPro editor:

¢ Handles very large files

® Opens as many windows as memory allows

® (Cuts, copies and pastes text within files and between files
® Searches for strings

® Wraps words

® And more

You can easily modify the FoxPro editor to behave like your
favorite word processor using keyboard macros. Macros are dis-
cussed in the System Menu chapter of this manual.

Creating a New File

To create a new file, choose New... from the File menu popup. A
dialog appears with a list of file types.

Because you want to edit text, choose either the File radio button
(to create a text file) or the Program radio button (to create a pro-
gram file).

Choose the OK push button to verify your choice. An UNTITLED
editing window appears and you are ready to begin entering text.

If you want to learn about the command to create a text or pro-
gram file, refer to MODIFY COMMANDFILE in the FoxPro
Commands & Functions manual.

Opening an Existing File
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To open an existing file for editing, choose Open... from the File
menu popup. A dialog appears with a list of available files.
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From the Type popup, choose the type of the file you wish to edit
(File or Program) to list all files of that type.

If the file you wish to edit is not located in the current directory,
choose the desired directory from the Directory menu popup. The
new directory now appears on the popup control and the options in
the list correspond to the new directory.

Similarly, you can change the current drive. Choose the ap-
propriate drive from the Drive menu popup. The options on the
list now change to correspond to the selected drive.

Once you have found your file in the list, select it.

Choose the Open push button to display your file in an editing
window.

If you want to learn about the command for opening text or pro-
gram files, refer to MODIFY COMMAND/ILE in the FoxPro
Commands & Functions manual.

Naming, Saving and Closing a New File

It is important to save a new file in case you want to change it
later or use it again.

To save an UNTITLED file, choose Save as... from the File menu
popup. A dialog appears.

Use the Drive and Directory popups if you need to change the
drive and directory where your file will be saved.

Select the text box at the bottom of the dialog. Type a meaningful
name for your file and include the appropriate extension (.TXT or
.PRG). For example, a text file containing a letter could be named
LETTER.TXT.

After you've named your file, choose the Save push button.

Once your file is saved, you can close it and move on to other work.
Choose Close from the File menu popup or click the close box with
the mouse. Now you are ready to create another file or edit an
existing file.

Saving and Closing an Existing File

While editing text, it is important to save your changes frequently.
It is also important to save your changes when you have finished
editing and are ready to close a file.
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To save an existing file, choose Save from the File menu popup.

If you wish to save another copy of an existing file under a new
name, choose Save as... from the File menu popup, replace the
current name of the file in the text box, and choose the Save push
button.

Once the changes are saved, you can close the file. Choose Close
from the File menu popup or click the close box with the mouse.

Cursor Movement
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When editing text, you can move through it and see any portion of
the data being edited. You move through text by positioning the
cursor. The cursor looks like a flashing underscore when in insert
mode and a flashing box when in overwrite mode. Press the Insert
key to switch between insert and overwrite mode.

It is simple to move the cursor through text using eight basic keys.
Four of these keys can also be used in combination with a modifier
key, Ctrl, to move the cursor a greater distance. The cursor move-
ment keys used in FoxPro are listed on the following page.
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Cursor Movement Keys
Key Action

Right Arrow Moves cursor one character to the right.
Left Arrow Moves cursor one character to the left.
Up Arrow Moves cursor up one line.
Down Arrow Moves cursor down one line.
PgUp Moves cursor up one window of text.
PgDn Moves cursor down one window of text.
Home Moves cursor to beginning of current line.
End Moves cursor to end of current line.
Ctrl+Right Arrow | Moves cursor one word to the right.
Ctrl+Left Arrow Moves cursor one word to the left.
Ctrl+Home Moves cursor to beginning of text.
Ctrl+End Moves cursor to end of text.

If your system is equipped with a mouse, you can also move
through text using the scroll bars at the right and bottom edges of
the windows. Click on the arrow at either end of the scroll bar,
depending on the direction you want to move. Drag the diamond-
shaped thumb to move through a window more quickly. To posi-
tion the cursor in the text, use the mouse to point and click.

Entering Text

Before you type text in FoxPro, you must position the cursor in the
appropriate location. Any text you type appears wherever the cur-
sor is located.
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A computer keyboard resembles a typewriter and works similarly.
When typing in FoxPro, however, you don’t have to press Enter
every time the cursor reaches the right edge of the window. You
can make FoxPro wrap words, which means that if a word is too
long to fit at the end of a line, it is automatically moved to the
next line. You only need to press Enter to start a new paragraph.

To make FoxPro wrap words in an open window, choose Preferen-
ces... from the Edit menu popup. Check the Wrap words check
box and choose OK.

Selecting Text

You can use the keyboard or the mouse to select text for editing.
Selecting text highlights it and prepares it to be moved, copied,
deleted or replaced. Text can be selected and deselected as many
times as you like without making any changes.

The cursor marks the location where actions will occur. To select
text, you must position the cursor in the text where you want to
begin editing. For more information about moving the cursor,
refer to Cursor Movement in this chapter.

Selecting and Deselecting with the Keyboard
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Before you select text using the keyboard, position the cursor in
the text where you want the selection to begin. For more informa-
tion about the cursor movement keys, refer to Cursor Movement in
this chapter.

To select text for editing, use the keystroke combinations listed in
the following table. Notice that the key combinations used to
select text are simply the cursor movement combinations with
Shift added to them. Shift, together with a cursor movement com-
bination, selects from the cursor location to the point to which the
cursor has moved.

When you use the keystroke combinations below, hold down the
appropriate modifier key(s) before pressing the final key in the se-
quence. For example, to select text from the cursor to the end of
the text, hold down Shift and Ctrl, then press End.

Interface Basics



Text Editor

Key Combinations for Selecting Text

Key Action

Shift+Arrow (Left/Right) | Selects one character at a time.

Shift+Arrow (Up/Down) Selects one line at a time.

Shift+Ctrl+Arrow Selects from cursor to

(Left/Right) beginning/end of word.

Shift+Ctrl+End Selects from cursor to end of text.

Shift+Ctrl+Home Selects from cursor to beginning
of text.

Ctrl+A Selects all text.

To deselect text that has been selected for editing, press any cursor
movement key.

Selecting and Deselecting with the Mouse

To select text with the mouse, position the pointer on the character
where you want the selection to begin.

Drag to the right by holding down the mouse button and moving
the mouse, then releasing the mouse button. As you drag the
mouse, each letter you pass over becomes highlighted. Dragging
down highlights entire lines of text. The text continues to be
selected until you release the mouse button.

Shortcuts for selecting text follow:

e Select a word by positioning the pointer on the word and
double-clicking. To double-click, press and release the mouse
button two times in succession.

e Select a line by positioning the pointer on a line and
triple-clicking. To triple-click, press and release the mouse
button three times in succession.
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® Select text word-by-word by double-clicking and dragging.
This is the same action as a double-click except on the second
click you don’t release the mouse button. Instead, you
continue to hold the mouse button down and drag.

¢ Select text line-by-line by triple-clicking and dragging. This is
the same action as a triple-click except on the third click you
don’t release the mouse button. Instead, you continue to hold
the mouse button down and drag.

® Select a segment of text by positioning the cursor then
Shift-clicking at another location to select everything from the
original cursor location to the Shift-click location. To
Shift-click, hold down the Shift key and press the mouse
button.

® Select all text by pressing Ctrl+A.
Text can be deselected in a variety of ways:

® Deselect a segment of text before you release the mouse button
by dragging the pointer back over the selected area.

® Deselect a segment of text after you release the mouse button by
Shift-clicking in the selected text at the point where you want
the selection to end.

® Deselect an entire selection by placing the pointer in the
window anywhere outside the selected area and clicking.

Deleting Text
The keys used for deleting text are described below.

Backspace If nothing is selected, pressing the Backspace key
erases the character to the immediate left of the
cursor. If text is selected, pressing Backspace
erases the selection.

Ctrl+ Erases the word in which the cursor is positioned.

Backspace If the cursor is positioned on a blank space follow-
ing a word, the space and the previous word are
erased.

Delete If nothing is selected, pressing the Delete key

erases the character that the cursor is on. If text
is selected, pressing Delete erases the selection.
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To delete part of a command in the Command window when
the command extends out of sight, position the cursor at the
beginning of the text to be deleted and select down to the
following command, stopping before you select the following
command. Now press Enter to replace the selected portion
of the command with a carriage return.

Pressing Enter instead of Backspace separates the two com-
mands immediately, without executing them. If you had
pressed Backspace then Enter, the command would execute
because no text was selected for the carriage return to
replace.

Inserting Text

When you begin a FoxPro session, the cursor is in insert mode.
Pressing the Insert key allows you to switch between insert and
overwrite mode.

The cursor looks like a flashing underscore when you are in insert
mode. When you type a character in insert mode, it appears at the
cursor location and the original text is moved one position to the
right.

The cursor is a flashing, solid box when you are in overwrite mode.
In overwrite mode, each character you type replaces the character
that the cursor is on.

In general, when text is selected, typing any characters (except
editor control characters) replaces the selected text with the typed
text.

Inserting Special Characters

Because many control characters are used to control the editor it-
self, FoxPro has a special method to let you insert control charac-
ters into editor files. This is particularly useful if you wish to in-
sert the graphic associated with a particular control character.

To insert a control character, press the ¢ key (left single quote)
followed by the letter that would normally follow Ctrl. For ex-
ample, Ctrl+Q is inserted into a file by typing ‘Q. To enter ° itself,
you must type ‘ twice.

High-bit characters used to create boxes and other graphics may
be entered directly in editor files by holding down the Alt key and
typing the (decimal) key code of the desired character.
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Any of these characters can be modified once they are entered.

Cutting, Copying, Pasting

G1-40

Text can be reorganized within and moved among windows, dialog
text editing regions and dialog text boxes using Cut, Copy and
Paste. When text is cut or copied, it is placed in a temporary
storage location called the clipboard. To use text from the clip-
board, you must paste it.

Cut Removes a piece of selected text for placement in a
different location. After you select the appropriate
text, choose Cut from the Edit menu popup (or press
Ctrl+X) to remove the text from your window, dialog
text editing region or dialog text box and place it on
the clipboard.

Copy Duplicates an existing portion of text for use in
another location. After you select the appropriate
text, choose Copy from the Edit menu popup (or press
Ctrl+C) to make a copy of the text and place it on the
clipboard. You can use this option in text files and
memo fields when you want to see if a piece of text
will look better in one place than in another, or in
programs when you are repeating the same segment
of code in many places.

Paste Places cut or copied text into a file at the cursor loca-
tion. Before pasting, position the cursor in the file
where you want the text to be placed, or select the
text in the file that you want the cut/copied text to
replace. Choose Paste from the Edit menu popup (or
press Ctrl+V) to place the text in the file. You can
continue to paste the same text over and over
throughout the document by moving the cursor and
choosing the Paste option.

To Paste from one window to another, Cut or Copy the text using
the methods described. Then, using the mouse or the keyboard,
select the window and location where you want the text to appear
and position the cursor at that location. Choose Paste from the
Edit menu popup and the text appears in the new window.

You can also Cut, Copy and Paste from dialog text editing regions
and dialog text boxes to windows and vice versa, using the same
methods.
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Undo and Redo

FoxPro keeps track of all the editing actions you make in text edit-
ing windows, program editing windows, memo editing windows,
the Command window, dialog text editing regions and dialog text
boxes starting at the beginning of each editing session. Undo is
used when you’ve changed your mind about a text editing action
and you would like to reverse it.

To reverse the most recent text editing action, choose Undo from
the Edit menu popup (or press Ctrl+U). You can continue to Undo
(in reverse order) all text editing actions that you’ve made since
you opened the file or saved it during the editing session, one at a
time, by choosing Undo from the Edit menu popup.

Redo allows you to reverse the most recently undone command.
Choose Redo from the Edit menu popup (or press Ctrl+R) to
reverse the most recent Undo.

For a complete description of Undo and Redo, refer to Edit Menu
chapter.

Find and Replace

When you want to find and/or replace a word or phrase that ap-
pears throughout a text file, program file, memo field or the Com-
mand window, choose the appropriate find and replace command
from the Edit menu popup. Below are descriptions of the find and
replace commands available in the FoxPro text editor.

Find... Begins to search for text at the cursor location. To
locate text, choose Find... from the Edit menu popup
(or press Ctrl+F). The Find dialog appears. Type a
segment of text that you want to Look For in the text
box. If you also want to replace the text segment,
type the new text in the Replace With text box.

When searching for text segments, you can tell
FoxPro to search forward or backward, ignore upper
and lower case, to match whole words only (not por-
tions of words as well), and/or to continue (wrap) to
search from the beginning of the file when the end is
reached.

Once you have entered the necessary information in
the dialog, choose the Find push button.
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Find Again

Replace
And
Find Again

Replace
All

Continues to search the remaining text after a match-
ing text string is found. Choose Find Again from the
Edit menu popup (or press Ctrl+G) to continue your
text search from the current cursor position. This
menu option is only enabled once a Find... has oc-
curred.

Replaces a matching string of Look For text with the
Replace With text that you specified in the Find
dialog. Then, it continues to search for the next oc-
currence of matching text. To perform this operation,
choose Replace And Find Again from the Edit menu
popup (or press Ctrl+E). This menu option is only
enabled once a Find... has occurred.

Replaces every occurrence of a matching string of
Look For text in the current file with the Replace
With text that you specified in the Find dialog. This
menu option is only enabled once a Find... has oc-
curred.

Setting Editor Preferences

The Preferences... option on the Edit menu popup allows you to
change certain settings that are in effect during editing sessions.
You can make the preferences apply to only the current file you
are editing, or to all files of that type created in the future.
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Choose Preferences... from the Edit menu popup to display the
Preferences dialog. The options in this dialog are described below.

Wrap words

Auto indent

Automatically moves text displayed in the editing
window to the next line when it reaches the right
margin, instead of continuing the text, unseen,
beyond the right margin. When Wrap words is
not checked, text that extends beyond the right
margin can be accessed by scrolling. If you are
editing a program file, it is best to make sure that
Wrap words is not checked. Also, be sure to press
Enter after each program command.

Allows you to easily construct indented programs.
Pressing the Enter key when Auto indent is on
moves the cursor to the next line and automat-
ically indents that line by the same amount as the
previous line.
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To stop indenting, press Shift+Return and the in-
sertion point moves to the left margin on the next

line.
N When Wrap words and Auto indent are both checked,
= /— FoxPro automatically indents wrapped text in each para-
v graph by the same amount as the first line of the paragraph.

For example:

e When a paragraph begins with a Tab, any wrapped
lines are aligned with the Tab.

¢ When a paragraph begins with a number (or other text)
followed by a Tab and text, any wrapped lines are
aligned with the Tab.

® When the first line of a paragraph is indented using the
Spacebar, any wrapped lines are indented by the same
amount as the first line.

Make backup Automatically stores the previous version of an
edited text or program file in a backup file (with a

.BAK extension).
Add line Saves files using a carriage return and line feed
feeds at the end of all lines. When this check box is

deselected, files are saved without line feeds and
carriage returns so that they can be exported to
other computers.

Status line Adds a status line at the top of the editing area.
When this check box is chosen, a bullet appears in
the upper left corner of the editing area if the text
has been modified since it was last saved. The
cursor’s line and column positions are displayed.
(Line position of the cursor is displayed only when
Wrap words is off.) The active edit modes are in-
dicated: Insert mode (Ins), Overwrite mode
(Over), Numlock mode (Num) and Capslock mode
(Caps).

Compile This preference is only available for program files

when saved and instructs FoxPro to compile the file after it is
saved. If this is not checked, the program is not
automatically compiled until it is executed.
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Add Ctrl-Z

Left justify
Right justify
Center justify

Tab size

Use these
preferences...

Save
preference

Memo Editing

Before you can edit the contents of a memo field in a database, you
must open it in a memo editing window. Memo editing windows
can be opened through the Browse window in Browse, Append, In-
sert and Change mode. To open a memo editing window, select
the desired memo field and do one of the following:

® Press Ctrl+PgDn.
* Double-click.

A memo editing window appears. Use standard FoxPro editing
techniques to update the contents of the memo editing window.
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When this is chosen, a Ctrl+Z is placed at the end
of a file when the file is saved.

When this box is not checked, files are read and
written in their entirety even if they contain
Ctrl+Z. The Ctrl+Z character will be read or writ-
ten right into the file.

Aligns all text at the left edge of the window.
Aligns all text at the right edge of the window.
Centers each line of text in the window.

Sets the distance (in number of spaces) that the
cursor will advance when the Tab key is pressed.
The default is 4. When you change the Tab size,
all tabs in the file will be updated to reflect the
change.

Designates that all preference settings should be
used as defaults with new text, program or memo
editing windows.

Stores the preference settings in the resource file
so that each time you open the file, it appears as
you left it at the end of the last editing session.
This option also stores the window size and posi-
tion, as well as the cursor location.
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When you close a memo editing window, your changes are auto-
matically saved. To close a memo editing window, click the close
box, choose Close from the File menu popup or press Ctrl+W.

For more information about editing memo fields, refer to MODIFY
MEMO in the FoxPro Commands & Functions manual.
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System menu options inform you about FoxPro, allow you to cre-
ate macros, or access built-in FoxPro desk accessories.

About FoxPro...
Help... F1
Macros...

Filer

Calculator
Calendar/Diary
Special Characters
ASCII Chart
Capture

Puzzle

System Menu
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About FoxPro...

About FoxPro...

Product revision

About FoxPro... displays revision information and the serial num-
ber of your copy of FoxPro. You will need to provide this informa-
tion if you call Fox Software for technical assistance. Click the
mouse button or press Enter to remove this information from your
screen.

Help...
On-line help
Help displays the topics level of the FoxPro Help window. You can
also display the Help window by pressing F1 or by typing HELP in
the Command window.
» (c> Fox Holdings, Inc.
> Hou to use Help
» Uhat’s Neu...
> Interface
> Programming
> Compatibility...
> FoxBASE+
» DB3 & DB4
» Configuring FoxPro
« Help »
Topics Level of the Help Window
The topics level of the Help window lists general topics, com-
mands, functions, system memory variables and interface items.
The window is arranged in this order:
® General topics, preceded by triangular bullets ( » )
¢ Commands and functions, intermixed alphabetically
®* System memory variables
¢ Interface items, preceded by square bullets (M )
The Help window is a standard FoxPro window that can be
scrolled, moved, sized and closed.
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To find the topic you want, you can scroll through the list. Or,
while you are in the Help window, type a letter or series of letters
to select the first list item beginning with the specified letter(s).
To select the first item at the top of the memory variables list, type
an underscore because all system memory variables begin with an
underscore. To select the first item at the top of the list of inter-
face items, hold down the Alt key and press 254 on the key pad.
(The Alt+254 key combination forms the square bullet.)

To see help details for a topic, select the topic and choose Help,
select the topic and press Enter or double-click on the topic with
the mouse or the Spacebar. The details level of the Help window
displays information for that topic.

« Topics » “ Expression Builder “

< Next > | The Expression Builder is a dialog
that appears in FoxPro uheneuver you
< Previous > | need an expression to complete a
comMand.
< Look Up >
An expression is an item (or items)
that, uhen evaluated, generates a
See Also " new value of Character, Numeric,
Logical or Date type. An expression
can be as simple as a single

Details Level of the Help Window

If more information is available on a topic than fits in the window,
use the scroll bar, Up/Down Arrow keys or PgUp/PgDn to see the
rest.

To return to the topics level of the Help window and select another
topic, choose Topics. To see information about the next topic in
the topics list, choose Next. To see information about the previous
topic, choose Previous.
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Look Up and See Also
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The details level of the Help window has a Look Up push button
and a See Also popup. These controls provide you with links
among related help topics. For example, if you need more informa-
tion about a key word in the help details, select the word and
choose the Look Up push button. (For Look Up to be enabled, a
word or portion of the help text must be selected.) If the selected
word is a help topic, help information appears for the word.

When you highlight text in the details of an interface topic
and choose Look Up, FoxPro only looks for help information
about the highlighted text in the interface topics list.

If a word is selected and a corresponding help topic cannot be
found, a dialog is displayed. At the top of the dialog, the message
“No help found for <topic>” appears. The topic highlighted in the
dialog’s list is the one that most closely matches your selected
topic. You may choose this topic or another topic from this list.

When the current help topic is related to at least one other topic in
the help file, the See Also popup is enabled. When you choose an
option from the list of related topics on this popup, help informa-
tion for the option appears, and when the See Also popup is dis-
played again, it is divided into two sections.

« Topics » “ Brouse “

< Next > | Brouse allous you to examine and
make changes to a database. You can
< Previous > | open a Brouse uwindou in any of the
follouing ways:

< Look Up >

» Choose Brouse from the Database
up.

Expression Builder

the Brouse text button in
uindou uvhen a database is

Append

| Change

Goto
Structure
Text Editing
Vieuw

See Also Popup Displayed in Help Window
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Topics previously selected from the See Also popup appear on the
upper portion of the popup, and you can choose from this portion
to retrace your path. Choose from the lower portion of the popup
to see information about additional topics related to the current
topic.

Context-Sensitive Help

FoxPro provides context-sensitive help. To receive help on a sys-
tem window or dialog using the keyboard, press F1 when the win-
dow or dialog is frontmost. Help information on that feature ap-
pears. To receive help on a menu option, select the menu option
and press F1.

To receive help on a system window, dialog or menu option using
the mouse, hold down the Alt key, point to the window, dialog or
menu option and click the left mouse button. Help information on
that feature appears.

When you select text in any editor session or in the Command win-
dow, you can display help for the selected topic by holding down
Alt and clicking the left mouse button on the window that contains
the selected text, or pressing F1 when the window is frontmost. If
a corresponding help topic cannot be found for the selected text,
the topic that most closely matches your selected text will appear.

When an editing window or the Command window is frontmost
and no text is selected, holding down Alt and clicking the mouse
button or pressing F1 displays the first item in the topics level of
the Help window.

Copy and Paste from Help

N Text in the details level of the Help window can be copied
- — and pasted into program windows, text windows, memo win-
. dows and the Command window. This is quite useful when

you can’t remember the exact syntax of a command. You
can copy and paste the syntax from the Help window, then
insert the file names and expressions necessary to complete
the command. You may want to paste commonly used infor-
mation, such as a complex date expression you create for use
in reports, in the help database so you can access it through
the Help window.
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Help Database

Macros...

Help is a complete mini-reference on FoxPro. In fact, the help in-
formation is stored in a standard FoxPro database (FOXHELP.DBF
and FOXHELP.FPT). If you SET HELP OFF you can open
FOXHELP.DBF and manipulate it like any other FoxPro database —
you can display the information, edit it, delete it and copy it.

Define custom keyboard shortcuts

G2-6

Macros... displays the Keyboard Macros dialog. Using this dialog,
you can define Ctrl key, Alt key or function key combinations to
perform a desired series of keystrokes. These key combinations
you define are called macros.

Keyboard Macros

»F2
< Save > F3 < Record >
F4
< Restore > F5 < Neu
Fb
<Set Default> F? < Edit
F8
< Clear All > F9 < Clear
SHIFT_1

v

v Vv

« OK »

Keyboard Macros Dialog

Macros can greatly simplify your interactions with FoxPro and
save you time during data entry. When you press a macro key
combination, FoxPro executes the series of defined keystrokes just
as if you had typed them. Individual macros can be combined in
macro sets and stored in files.

Macros are handy to use when editing text. For example, you
could define a macro to:

® Delete the line of text preceding the cursor

¢ Delete everything from the cursor position to the end of the
text

® TInsert a line of text at the top of a file, position the cursor at
the bottom of the file and insert another line of text

System Menu
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N You can make your work environment more comfortable by
using macros to imitate the keystroke assignments of
familiar products. For instance, if you are accustomed to
using the word processor WordStar, you might want to
define macros to make the FoxPro text editor operate in a
similar manner (that is, define Ctrl+F to move ahead one
word).

I/
un@
I\

The Keyboard Macros dialog contains a central list that displays
the macros available for use. The four push buttons on the left
side of the dialog, Save, Restore, Set Default and Clear All, per-
form actions on macro sets (groups of macros). The four push but-
tons on the right, Record, New, Edit and Clear, perform actions on
individual macros.

When the Keyboard Macros dialog is displayed, a Macros menu
pad is added to the menu bar. The Macros menu popup contains
options and Control key shortcuts that correspond to each push
button in the Keyboard Macros dialog.

Macros

Record Macro M

Neu Macro “N
Edit Macro “E
Clear ~C
Save Macros S

Restore Macros "R
Set Default “D
Clear All “A

Macros Menu

FoxPro’s Default Macros

When you first load FoxPro, some macros already exist. FoxPro
has its own default macros for the function keys F2 through F9
and the shift keys SHIFT 1 through SHIFT_9.

The values FoxPro assigns to F2 through F9 are listed in the
Function Key Default Definitions table that follows. SHIFT_1
through SHIFT_9 highlight text when you press the Shift key and
any cursor movement key on the numeric keypad. (If you use the
numeric keypad to enter numbers, these macros can be cleared).

System Menu G2-7



Macros...

Function Key Default Definitions
Key Function

F2 Set

F3 List

F4 Dir(ectory)

F5 Display Structure

F6 Display Status

F7 Display Memory

F8 Display

F9 Append

Creating Macros
Macros can be created in two ways: automatically and manually.

When you create a macro automatically, you enter the key
combinations that you want the macro to execute, and FoxPro
automatically records your keystrokes much as a tape recorder
records your voice.

When you create a macro manually, you type the keystrokes that
you want the macro to execute into a text editing area.

Creating Macros Automatically

To automatically create a macro, choose the Record push button in
the Keyboard Macros dialog or choose Record Macro from the
Macros menu popup. The Macro Definition dialog appears. You
can also press Shift+F10 at any time in FoxPro to display this
Macro Definition dialog so you can create a macro. (By default,
Shift+F10 displays the Macro Definition dialog, but you may
redefine this key combination.)
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Macro Key Definition

Defined Key:
Macro Name: [V W]

« OK » < Cancel >

Macro Definition Dialog

Press the key combination that will be used to activate the macro.
FoxPro allows you to use any of the Ctrl key, Alt key or function
key combinations in the following list:

F1-F10, Ins, Del, Home, End, Pg Up, Pg Dn or the arrow keys

Shift plus F1-F9, Ins, Del, Home, End, Pg Up, Pg Dn or the
arrow keys

Ctrl plus A-I, K-Z, F1-F10, Home, End, Pg Up, Pg Dn or the
Left and Right arrow keys. Ctrl+Q and Ctrl+S are not
recommended.

Alt plus A-Z, F1-F10

Shift+Ctrl plus A-Z, F1-F10, Home, End, Pg Up, Pg Dn or the
Left and Right arrow keys. Shift+Ctrl+Q and Shift+Ctrl+S
are not recommended.

Shift+Alt, Ctrl+Alt or Shift+Ctrl+Alt plus A-Z or F1-F10.
Shift+Alt, Ctrl+Alt or Shift+Ctrl+Alt plus A-Z or F1-F10.
Alt+F10 plus A-Z.

O

Ctrl+Alt+Del and Shift+Ctrl+Alt+Del will reboot your
computer!

When entering a key combination that contains the Shift, Ctrl
and/or Alt keys, always press the keys in the order shown in the
list above.

If you enter an invalid key combination, you’ll hear a beep.

System Menu
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If you choose Alt+F10 as your key combination, a dialog appears
and tells you to press a letter, a-z, to be part of the key combina-
tion. The letter you press is added to the entry in the Defined Key
text box of the Macro Definition dialog.

The key combination you press appears in the Defined Key text
box and the default macro name appears beneath it. If you want
to rename the macro, type the new name in the Macro Name text
box. Macro names are typical FoxPro names except that they may
be up to 20 characters long.

Choose OK when you are ready to define the macro. If you would
rather not define the macro, press Escape or choose Cancel.

If you try to define an existing key combination, the Overwrite
Macro dialog appears. Choose Overwrite to replace the existing
macro definition with your new definition. Append keystrokes al-
lows you to add commands to the end of the existing macro. Can-
cel exits the Overwrite Macro dialog without taking any action.

Key Ctrl+A is already assigned
as Macro CTRL_A.

« Querurite » < Append keystrokes > < Cancel >

Overwrite Macro Dialog

After you choose OK in the Macro Definition dialog (or choose
Overwrite or Append Keystrokes in the Overwrite Macro dialog), a
system message appears, displays the name of the macro you are
defining and tells you that FoxPro is recording. Enter the
keystrokes that you want the macro to execute.

If you want the macro to choose menu options, you must
access the menu system using the keyboard while recording
your macro. The macro will not record all of your actions if
you use the mouse.

The maximum number of keystrokes for any single macro is 1,024.
While you are recording, any keystroke you make is stored to the
macro.
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Macros...

To define a macro that opens a specified text file, positions the
cursor at the top of the file and adds a line of text, enter the fol-

lowing keystrokes:

Macro Keystroke

Result

Ctrl+F2

Display the Command window

MODI FILE TEST.TXT

Edit a text file titled TEST.TXT

Ctrl+Home

Position cursor at beginning of TEST.TXT file

To be or not to be?

Enter text

System Menu

Every time you use this macro, FoxPro executes this series of com-
mands.

When you finish creating the macro, press Shift+F10 to stop
recording. A Stop Recording Macro dialog appears.

Stop recording ALT_D7?

< Insert Literal > « OK »
< Insert Pause > < Continue >
(+) Key to Resume

C ) Seconds < Discard >

Stop Recording Macro Dialog

Although you will not always need to, at this point you may want
to insert a literal or a pause in your macro.

Insert Literal records the literal meaning of the next keystroke.
You would use this to record the literal meaning of a key instead
of a meaning currently assigned to it with a macro. This is espe-
cially handy when you want to circularly define two keys. To do
so, choose Insert Literal, and then press the key.
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Insert Pause records a pause in the macro. Before you choose In-
sert Pause, make sure that the appropriate radio button is chosen.
If Key to Resume is chosen, you'll be prompted to press a key to
resume execution of the macro after a pause has occurred. The
key you press to resume the macro may be specified with the SET
MACKEY command. Seconds allows you to specify how long the
pause will last before execution of the macro resumes automat-
ically. The default length for a pause is one second.

Discard erases the macro that you were creating. Continue
returns you to the point you were at before the Stop Recording
Macro dialog appeared so you can continue adding commands to
the macro you are recording. OK confirms that you have com-
pleted the macro and makes it available for use.

Creating Macros Manually
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To manually create a macro, choose the New push button in the
Keyboard Macros dialog or choose New Macro from the Macros
menu popup. The Macro Edit dialog appears.

Macro Edit

Defined Key:
Macro Nawe:

Macro Contents:

SET{ENTER}

« OK » < Cancel >

Macro Edit Dialog

You must type in a defined key combination in the Defined Key
text box. You can use any of the key combinations in the following
list:

* F1-F10, Ins, Del, Home, End, Pg Up, Pg Dn or the arrow keys

® Shift plus F1-F9, Ins, Del, Home, End, Pg Up, Pg Dn or the
arrow keys
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¢ (Ctrl plus A-I, K-Z, F1-F10, Home, End, Pg Up, Pg Dn, Left
Arrow or Right Arrow. Ctrl+Q and Ctrl+S are not
recommended.

® Alt plus A-Z, F1-F10

® Shift+Ctrl plus A-Z, F1-F10, Home, End, Pg Up, Pg Dn, Left
Arrow or Right Arrow. Shift+Ctrl+Q and Shift+Ctrl+S are
not recommended.

® Shift+Alt, Ctrl+Alt or Shift+Ctrl+Alt plus A-Z or F1-F10.
® Shift+Alt, Ctrl+Alt or Shift+Ctrl+Alt plus A-Z or F1-F10.
® Alt+F10 plus A-Z.

Ctrl+Alt+Del and Shift+Ctrl+Alt+Del will reboot your
computer!
|

When typing in a key combination that contains the Shift, Ctrl
and/or Alt keys, always type the keys in the order shown in the
list above.

Refer to the <key label> assignments listed under ON KEY
LABEL in the FoxPro Commands & Functions manual for
proper key name spellings.

You must use a plus sign (+) between key names. Do not type
spaces between the key names and the plus sign. If you put a
space before or after the plus sign, FoxPro will ignore anything
following the space.

You do not need to be concerned with capitalization.

If you type invalid key names in the Defined Key text box, an error
message appears when you choose OK.

Type a name for your macro in the Macro Name text box.

In the Macro Contents text area, type the keystrokes that you
want the macro to execute. Use the <key label> assignments
listed in ON KEY LABEL in the FoxPro Commands & Functions
manual and enclose them in curly braces ({ }) to represent the
desired keystrokes. (The <key label> is the letter or digit on the
key itself or a special name assigned to the key.) Any key com-
bination, such as Ctrl+F2, is also placed in curly braces.
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For example, if you want to define the Shift+Ctrl+J key combina-
tion to bring the Command window forward and display the names
of all the files in the current directory, you would:

1. Type Shift+Ctrl+J in the Defined Key text box.
2. Type a macro name in the Macro Name text box.

3. Type {Ctrl+F2}DIR{ENTER} in the Macro Contents area.
Ctrl+F2, the key combination that brings the Command win-
dow forward, is placed in a single set of curly braces. Ctrl and
F2 are the <key label> assignments. DIR is the command that
displays the names of all the files in the current directory and
{Enter} is the <key label> assignment in curly braces.

When you are satisfied with your macro, choose OK to confirm that
you have completed the macro and to make it available for use. To
exit the dialog without creating the macro, choose Cancel.

Inserting Pauses Manually

You can manually enter pauses in your macro. If you want your
macro to pause until any key is pressed, type {Pause Key} at the
appropriate place in the Macro Contents area. You can also
specify the number of seconds you want your macro to pause. For
example, if you want your macro to pause for three seconds, type
{Pause 3.0} at the appropriate place in the Macro Contents area.

Because the Macro Contents area is an editing area, the
Undo/Redo, Cut/Copy/Paste, Clear and Select All options are
available to you if you want to make changes in your macro.

Inserting Carriage Returns Manually

You may press Enter to break lines in the Macro Contents area for
ease of reading or editing and this will not be recorded in your
macro. If you do want your macro to execute a carriage return,
you must type {ENTER}.

Inserting Spaces Manually

If you press the Spacebar in the Macro Contents area, your macro
will record the spaces you enter and will execute that spacing in
your macro.

Inserting Semicolons Manually

To enter a semicolon in your macro, type {Semicolon}. Typing
just ; alone is equivalent to {Enter}.
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Editing Existing Macros

Existing macros can be edited in much the same way as new
macros are created manually. To edit an existing macro, select the
macro from the list in the Keyboard Macros dialog and choose the
Edit push button. You can also choose Edit Macro from the Macros
menu popup or double-click on the macro in the list. The Macro
Edit dialog appears.

Use standard text editing techniques to make any desired adjust-
ments to your macro in the Defined Key and Macro Name text
boxes and the Macro Contents text area.

When your changes are made, choose OK to confirm your modifica-
tions. To exit the dialog without making changes, choose Cancel.

You can assign new values to F1 through F10 by choosing
Macros... from the System menu popup or with the SET FUNCTION
command. Function keys beyond F10 are not supported in FoxPro.

Erasing Macros

Two push buttons in the Keyboard Macros dialog can be used to
erase current macros: Clear and Clear All. Clear erases the macro
that is selected in the list. Clear All erases all macros in the list.
Both of these push buttons have corresponding options on the
Macros menu popup. The difference between current and saved
macros is discussed next.

If you don’t want any macros to be loaded when you start FoxPro,
choose Clear All in the Keyboard Macros dialog to erase all the
macros from the list. Once the list is empty, choose Set Default to
save an empty file as your DEFAULT.FKY file.

Saving Macros

Current vs. Saved Macros

It is important to understand the difference between current and
saved macro sets. The current macro set exists temporarily in
memory and appears in the list in the Keyboard Macros dialog.

Saved macro sets are stored on disk in files with the extension
.FKY and don’t appear in the Keyboard Macros dialog. When you
restore a saved macro set, it is copied to memory and added to the
current set. Modifications to the new current set do not affect its
.FKY file.
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For example, you could add a series of editing macros to the cur-
rent macro set. These new macros vanish when you exit FoxPro
unless you save the macro set by choosing Save, or overwrite the
default macro set by choosing Set Default.

The Clear and Clear All push buttons and menu options only affect
the current macros. Clear All is especially useful when you want
to create an entirely new macro set. You can erase all the macros
in the list and start from scratch without deleting the contents of
any .FKY file.

Saving and Restoring Macro Sets
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A macro set is a group of macros that have been created for the
same application. When you define a set of macros you want to
keep, choose Save in the Keyboard Macros dialog or choose Save
Macros from the Macros menu popup. A Save As dialog appears.

This dialog contains a list of subdirectories and macro sets (desig-
nated with an .FKY extension) that exist in the current directory.
You can type a new name for the macro set in the text box, or
overwrite an existing file by choosing the file name from the list.
When the desired name is in the text box, choose Save. The file is
stored in the directory that is displayed on the Directory popup.

When the Keyboard Macros dialog is displayed, you can add a
saved macro set to the current macros (those in the list). To add
to the current macros, choose the Restore push button or choose
Restore Macros from the Macros menu popup. A Restore Macros
dialog appears.

Restore Macros from File:

Drive C “
[SAMPLE]
[TUTORIAL1]
DEFAULT. FKY
MACROS1. FKY Directory | FOXPRO ﬂ
MACROSZ2. FKY
MACROS3. FKY
MACROS4. FKY « QOpen »
MACROSS. FKY

< Cancel >

[ 1 All Files

Restore Macros Dialog

System Menu



Macros...

Select the file that contains the macro set you want to restore and
choose Open.

RN The process of restoring macro sets is additive. When you
—— Restore a file, its contents are added to the current macros
& list.

If your default macro file defines keys F2-F5 and you restore
a file that defines keys F5-F7, you would end up with a list
that contained macros for keys F2-F7. The second definition
of F5 would replace the first. The original files are not al-
tered in the process.

Default Macro File

A default macro set automatically loads whenever you start
FoxPro. Each time you run FoxPro, it looks for a default macro
file named DEFAULT.FKY. If a DEFAULT.FKY file is found, it is
loaded. If no DEFAULT.FKY is found, FoxPro uses its own default
macros (F2 through F9 and SHIFT_1 through SHIFT_9).

Creating a Default Macro File

You can create your own default file by saving a macro set in a file
named DEFAULT.FKY or by choosing Set Default in the Keyboard
Macros dialog with the desired macros loaded. FoxPro stores the
DEFAULT.FKY file in the current directory.

Modifying Default Macro Sets

To change which macros are stored in the DEFAULT.FKY file, make
sure DEFAULT.FKY is loaded and create or erase the desired macros
(as described later in this section). When you are satisfied with
the changes, choose Set Defaulit.

A confirmation box appears. If you want to store the current
macros as the startup default, choose Yes. The new macros will
replace those that are stored in DEFAULT.FKY and will appear in
the Keyboard Macros list at the start of each FoxPro session. You
may change your startup defaults at any time. Choose No to
return to the Keyboard Macros dialog without changing the default
file.
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Combining Macros

If you have a custom DEFAULT.FKY macro set and you want to com-
bine it with FoxPro’s default macros, follow these steps:

4.

At the DOS prompt in the directory where DEFAULT.FKY is lo-
cated, type: RENAME DEFAULT.FKY TEMP .FKY

. Start FoxPro.

Choose Macros... from the System menu popup. (FoxPro’s
default macros appear in the Keyboard Macros list.)

Choose the Restore push button to display the Restore Macros
dialog.

. Choose TEMP.FKY from the list and choose Open. Now choose

Set Default to save your custom macros and the new macros in
a file named DEFAULT.FKY.

For more information about macros, see PLAY MACRO in the
FoxPro Commands & Functions manual.

Filer
Copy files, create directories, move files and delete files

When you choose Filer from the System menu popup, the Filer
window appears with the Files panel displayed. A Filer menu pad
is added to the right end of the menu bar.
For information about the Filer, see the Filer Menu chapter in this
manual.
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Calculator

Perform calculations

When you choose Calculator from the System menu popup, a cal-
culator appears on the screen. The FoxPro Calculator is used like

a standard pocket calculator.

Calculator

Calculations can be performed using the keyboard or the mouse.

With the keyboard, you can type the equation as it would be writ-
ten. Most Calculator keys have the same keyboard equivalents,
with the following exceptions:

Keystroke | Equivalent
Q v
R MR
N *
A M+
Z MC
S M-

To calculate 8 x 16 + 2 and take the square root of the result using
the keyboard:

Type 8%16/2=Q
The result is 8.
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To perform the same calculation with the mouse, simply click on
the appropriate numbers and symbols on the Calculator.

Display Panel

The display panel of the Calculator is a text editing area. Num-
bers can be edited, cut, copied and pasted into other documents.
You can also paste portions of other documents into the display
panel, but only numerical values are displayed.

When numbers in the display panel are highlighted, they will be
replaced by the next entry you make.

Keypad

The keypad is comprised of number, operator and memory keys.
The number keys, 0-9, and the decimal key (.) control the majority
of the data you enter. The + key toggles the displayed value be-
tween positive and negative.

While you perform calculations, the current operator appears to
the right of the display panel. The operators +, -, * and / should
be entered between the numbers you are calculating:

2+2-1*5/2

The square root (V) sign should be placed immediately after the
number for which you want to find the square root:

64V

The percent operator (%) is used with the + and - operators. It
allows you to add or subtract a percentage of a number:

100 + 10%

Press = to display a result. Press the C key once to erase the
current value in the display panel. When you press C twice, the
current calculated value and the operator that appears to the right
of the display panel are erased.

Memory allows you to store one number indefinitely. To store a
number in memory, simply enter the number and click M+. The
letter M will appear to the left of the display panel. Once a num-
ber has been stored, you can clear the screen and/or perform other
calculations. When you want to recall the number, click MR and it
will appear in the display panel (overwriting the current display).
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It is possible to modify the number in memory without repeating
the initial process. The M+ and M- keys can be used to add or
subtract from the current number. If, for example, you have the
number 56 stored in memory and you want to decrease it by 12:
enter the number 12, click M- and then click MR.

The number 44 will appear in the display panel and replace 56 in
memory. Click MC when you want to clear the number from
memory.

Calculator Preferences

If you choose Preferences... from the Edit menu popup while the
Calculator is active, the Calculator Preferences dialog appears so
you can specify settings that affect the Calculator each time you
use it.

Calculator Preferences
NumLock State

> Don’t alter NumLock

> Remember NumLock State

> Force NumLock ON

C
C
C

Decimal Places
> Automatic
> Floating
> Fixed

C
C
C

« OK »

Calculator Preferences

The first group of radio buttons in the Calculator Preferences
dialog allows you to change the status of NumLock for the Cal-
culator. In all cases, when you exit the Calculator, NumLock
returns to its original state.

Don’t alter Invokes the Calculator without affecting the state
NumLock of NumLock.

Remember Causes the Calculator to remember and revert to
NumLock the setting of NumLock the last time the Cal-
State culator was used.
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Other

Force Turns NumLock on when you activate the Cal-
NumLock culator.
ON

The second group of radio buttons in the Calculator Preferences
dialog allows you to adjust the decimal display of numbers:

Automatic Displays calculated results based on the number
of decimal places in the numbers you enter and
the operation performed. Automatic is chosen by
default.

Floating Displays numbers to the highest degree of
precision. Numbers are shown with as many
decimal places as necessary to display the entire
number, with trailing zeros removed.

Fixed Displays a text box in the Calculator Preferences
dialog. Type the number of decimal places you
want to appear in all values, both entered and cal-
culated. If a number has fewer decimal places
than you specified, trailing zeros are added.

Features

If you attempt to execute an invalid calculation, an error message
appears on the screen. For example, if you attempt to use a num-
ber that is too large for the display panel, the “Numeric Overflow”
message appears and the display panel is cleared.

When you close the Calculator or exit FoxPro, the contents of
memory, the numbers in the display panel and the preference set-
tings for the Calculator are stored in the FOXUSER file. The next
time you use the Calculator your data and settings will be intact.

You can keep the Calculator on the screen with any of the other
FoxPro desk accessories.
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Calendar/Diary

Check dates/keep track of appointments

When you choose Calendar/Diary from the System menu popup, a
monthly calendar appears with the current day selected.

Calendar/Diary

March 1991

Su Mo Tu We Th Fr Sa|Today is Garfield’'s
birthday!

CeEMI>CM+D>Ce ¥ DY+ ) KToday>

The FoxPro Calendar/Diary is used just like any other calendar —
to check dates and keep track of appointments. The Calen-
dar/Diary is a standard FoxPro window that can be scrolled,
moved, sized and closed.

The first time you open the Calendar/Diary during a FoxPro ses-
sion, the current day is selected. If you select a different day, close
the Calendar/Diary and reopen it, the last selected day is still
selected.

To the right of the Calendar panel is the Diary panel. You use the
Diary panel to input text associated with any date on the Calendar
panel. To activate the Diary panel, press the Tab key or choose
Diary from the Diary menu popup. To activate the Calendar panel,
press Shift+Tab or choose Calendar from the Diary menu popup.

At the bottom of the Calendar/Diary window are push buttons
used to change the calendar. These buttons correspond to the first
five options on the Diary menu popup.
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The Diary menu popup has options that change the calendar,
change the active panel and delete diary entries.

ool

Back Month Pglp
Ahead Month PgDn
Back Year Shift+Pglp
Ahead Year Shift+PgDn

Today T
Diary Tab
Calendar Shift+Tab
Delete...

Diary Menu

Calendar Panel

The Calendar panel appears with the current month displayed and
today’s date selected. The month and year at the top of the calen-
dar are highlighted when the Calendar panel is active.

To change the selected day, use the arrow keys or click on the
desired day. To change the month backward or forward, use the
PgUp and PgDn keys or the two month push buttons, «M and
M-, at the bottom of the window. To change the calendar back-
ward and forward by year, use Shift+PgUp and Shift+PgDn or the
year push buttons, «Y and Y-, at the bottom of the window.

You can select today’s date by pressing T on the keyboard or by
choosing the Today push button. This is a quick way to get back
to the current day.

The Diary menu popup contains options that correspond to all of
these actions.

Diary Panel

You can have a diary entry for each day. To make a diary entry,
select the day in the Calendar panel. Activate the Diary panel by
pressing Tab or clicking on the panel with the mouse. The cursor
flashes in the Diary panel, indicating that it is active.

The Diary panel is a text region so you can use standard text edit-
ing techniques. There is no limit to the amount of text you can
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enter. You can zoom and size the Calendar/Diary to see more of
the text in the Diary panel.

All dates that have a diary entry are displayed as enhanced text.

Delete Entries

Each diary entry is stored in the FOXUSER resource file until you
delete it. This means that every time you use the Calendar/Diary,
you can refer to these entries by selecting the day. Clear these
entries out from time to time to keep from wasting disk space.

You delete diary entries from a selected date backward. When you
select a day on the calendar and choose Delete... from the Diary
menu popup, all text entries prior to but not including that day
will be erased. An alert appears so you can confirm the action.

Delete all diary entries prior to 81/81/91 7

< Yes > « No »

Choose Yes to delete the entries. NO returns you to the Calen-
dar/Diary without deleting any entries.

When you finish using the Calendar/Diary, close it by choosing
Close from the File menu popup, pressing Escape or clicking the
close box.
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Special Characters

Access foreign punctuation, line drawing characters and symbols
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When you choose Special Characters from the System menu
popup, the Special Characters window appears.

Characters
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Special Characters Window

You can select characters such as foreign punctuation marks, line
drawing characters and symbols from the Special Characters win-
dow and paste them into any editing window. For special charac-
ters to appear in a window, the window must be open and be a
window in which you can normally use the Paste option.

To place a special character in a window, position the cursor in the
window where you want the special character to appear.

If you are using the keyboard, press Ctrl+F1 to bring the Special
Characters window frontmost. Use the arrow keys to select the
special character you want and press Enter or the Spacebar. The
character appears in the editing window.

If you are using a mouse, click on the Special Characters window
to bring it frontmost. Point to the special character you want and
double-click. The character appears in the editing window.
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N I you have trouble getting the desired character to appear
= — in the window, try holding down the Shift key when you
X choose the special character.

To close the Special Characters desk accessory, choose Close from
the File menu popup, click the close box or press the Escape key.

ASCII Chart

List ASCII characters

When you choose ASCII Chart from the System menu popup, a
window appears with a list containing an ASCII chart.

ASCII Chart

OWONOUTLWNE,®

[

ASCII Chart
From left to right, the columns show the ASCII characters in:

Decimal representation
Hexadecimal representation
Graphic representation

Control key representation

AR I A o

Abbreviated meaning
Scroll to the entry you wish to reference. If you know the decimal

equivalent of the ASCII character, you can type the number to go
directly to the specific entry.
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Capture

When you choose an ASCII character, its graphic representation is
pasted at the cursor position in the last window that was active.
For the ASCII character to appear, the window must be open and
be a window in which you can normally use the Paste option.

If you have trouble getting the desired character to appear,
try holding down the Shift key when you choose the ASCII
character.

To close the ASCII Chart, choose Close from the File menu popup,
click the close box or press the Escape key.

Make copies of screen text

The Capture desk accessory copies selected text to the clipboard so
that it is available to paste into any window. You can copy any
text displayed on the screen, even if it isn’t in a window. You can
even capture output from a program. Graphic characters, such as
the borders of windows, cannot be captured.

With text on the screen, choose Capture from the System menu
popup. A message appears to tell you to select the top left corner.

System File Edit Database Record Program Windou

Select top-left corner

< Vieu >
<On/0f£>
<Files >
< Misc >
<{Setup >

<Brouse>

< Open >

<Close >

<Relations> <1-To-Many>
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Capturing the View Window
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As soon as you start to select the corner, the message disappears
so you can see the entire screen. Select the text area from the
upper left corner to the lower right corner.

To select text with the keyboard, use the cursor movement keys to
place the cursor at the starting point of the selection. Press Enter
to begin the selection. A message appears to tell you to select the
bottom right corner.

Move the cursor to the end of the selection. Press Enter to capture
the selected text.

To select text with the mouse, move the pointer to the starting
point of the selection. Press the mouse button to start selecting. A
message appears to tell you to select the bottom right corner.

Drag the cursor to the end of the selection. The selected text is
captured when you release the mouse button.

“Captured and placed on clipboard” appears when the capture is
completed. Press Escape during the capture if you decide not to
capture text.
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3 File Menu

The File menu contains options that allow you to create, open, save
and otherwise manipulate the files on your disks. You can also
enter printer information and exit FoxPro through this menu.

e

New. ..
Open...
Close

Save
Save as...
Revert

Printer Setup..
Print...

Quit

File Menu
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New...

Create a new file

New... lets you create and open a new file. When you choose this

option, the New File dialog appears.

=z
m
=

W W W W W W W W

Database
Program
File
Index
Report
Label
Screen
Menu
Query
Pro ject

AAAAANANAAAAN

« OK »

< Cancel >

New File Dialog

If no database is open in the selected work area, you can create
any type of file except an index file. If a database is open in the
current work area, you can create any one of the file types:
database, program, text, index, report, label, screen, menu, query
or project. Choose the radio button for the type of file you want to

create, then choose OK.

You can cancel the creation of any file by choosing Cancel or press-

ing Escape.
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Creating a Database File

To create a database, choose the Database radio button in the New
File dialog and choose OK. An empty Structure dialog appears.
The illustration below shows an example of how the Structure
dialog appears after you add field information.

Structure: C:\FOXPROX\TUTORIAL\CUSTOMER.DBF
Name Type Width Dec

Field

{Insert>

{Delete>

« QOK »

OO

{Cancel>

Fields: 18 Length: 218 Available: 3782

Structure Dialog

When the Structure dialog is displayed, a Structure menu pad is
added to the menu bar. The Structure menu popup is provided
specifically for keyboard users. Keyboard users will need to use
options or Control key shortcuts from this popup instead of the
Insert and Delete push buttons in the dialog.

Insert Field "I
Delete Field "D

Structure Menu

File Menu G3-3



New...

G3-4

Defining Database Fields

In the Structure dialog, you define the fields that will be in your
database. For each field:

1. Enter a field name (up to 10 characters) in the text box below
the Name heading.

2. Press Tab or Enter to move to the Type field, then press the
Spacebar and choose a type from the Type popup. With the
mouse, click on the Type field and choose a type. Finally, enter
Width and Decimal values for the new field.

Every database has one extra byte that FoxPro uses to keep
track of deleted records. This means that the total field
width for a database is always one greater than you define.
For example, in the Structure dialog a new database with no
fields has a width of one.

Specify a data type by choosing an option from the Type popup:

Character

Numeric

Date
Logical

Memo

Float

Picture

Enter a field width (up to a maximum of 254). The
default width is 10.

Enter a field width up to 20, including an optional
plus/minus sign and decimal place. The default width
for numeric data is 8.

A width of 8 is automatically assigned.
A width of 1 is automatically assigned.

A width of 10 characters is automatically assigned.
This corresponds to the amount of space used in the
database. The actual size of memo fields, however,
depends on the amount of data entered into them.
Memo field sizes are limited only by the amount of
memory available.

Enter a field width up to 20 including an optional
plus/minus sign and decimal place. The default width
for float data is 8. This field is specifically designed
for scientific data.

Picture entries cannot be made in FoxPro. Databases

that contain pictures are created in FoxBASE+/Mac
and imported to the PC.
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Inserting and Deleting Database Fields

In the Structure dialog, you can insert and delete fields in your
database as described below:

Insert To insert a new field, position the cursor in an exist-
ing field and choose the Insert push button or Insert
Field from the Structure menu popup. A field named
NEWFIELD with a Character type and a default width
of 10 is added before the selected field. To insert
more fields, choose Insert again. Fields will be added
and named NEWFIELD1, NEWFIELD2, and so on.

To change the attributes of the new field, select its
default name and type the desired name. Press Tab
or Enter to move to the Type field, then press the
Spacebar and choose a type from the Type popup.
With the mouse, click on the Type field and choose a
type. Finally, enter Width and Decimal values for the
new field.

Delete Removes the selected field from your database struc-
ture. To delete a field, select it and choose the Delete
push button or choose Delete Field from the Structure
menu popup. The selected field is removed and all
remaining fields shift up one position in the structure.

Moving Database Fields

File Menu

If you finish defining fields and decide that they’re in the wrong
order, it is easy to move them in the Structure dialog.

To change the order of fields in the database using the keyboard,
press Tab until the double-headed arrow preceding the desired
field is selected, then press the Spacebar to select the entire field
definition. Press the Up/Down Arrow keys to drag the field to its
new location then press the Spacebar to confirm the action.

To change the order of fields in the database using the mouse,
point to the double-headed arrow that precedes the field you want
to move and drag the field to a new location.

When you finish creating the new database structure, choose OK
to save it. A Save As dialog appears so you can specify the direc-
tory where the new file will be stored and name the file. Type a
name in the text box and choose Save.
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FoxPro asks:

Input data records nou?

No returns you to the interactive command mode. Yes adds a new
record to the database so you can begin to input data.

Adding and Removing Structural Compound Index Tags

In the Structure dialog, you can add and remove index entries or
tags for structural compound indexes. (Compound indexes are
described later in this chapter.)

After you add field information to the Structure dialog, a shaded
area appears to the left of each field name.

Adding a Structural Compound Index Tag
To add a tag to a structural compound index:

1. Position the cursor in the shaded area directly preceding the
field. The field will be your index expression. The field name
will be your tag name.

2. Depending on the type of tag you want, do one of the following:

® For an index in ascending order, press the Spacebar once or
double-click with the mouse. An up arrow appears.

® For an index in descending order, press the Spacebar twice or
triple-click with the mouse. A down arrow appears.
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Removing a Structural Compound Index Tag
To remove a tag from a structural compound index:

1. Position the cursor on the up or down arrow in the shaded area
directly preceding the field.

2. Depending on the type of tag you’re removing, do one of the
following:

® To remove an index in ascending order, press the Spacebar
twice or triple-click with the mouse.

® To remove an index in descending order, press the Spacebar
once or double-click with the mouse.

Choose OK to confirm your changes or Cancel to exit the dialog
without making changes.

Creating a Program File

In the New File dialog, choose the Program radio button and
choose OK to display an empty program editing window.

UNTITLED. PRG

Program Editing Window

Enter your program in this window using FoxPro text editing tech-
niques. The text editor is described in the chapter titled Interface
Basics.

When you finish, save the file and close the window. An extension
of .PRG is automatically assigned by FoxPro unless you specify a
different extension.
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Creating a Text File

In the New File dialog, choose the File radio button and choose OK
to display an empty text editing window. You can create any kind
of text file in this window. Just type the text.

UNTITLED

Text Editing Window

When you’re finished, save the file and close the window. The text
file will not have an extension unless you specify one.
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Creating Compound and Single Entry Index Files

In the New File dialog, the Index radio button is disabled unless a
database is open. To create an index file, choose the Index radio
button and choose OK. An Index dialog appears so you can create
compound or single entry index files.

Database Fields: Index On:
Options

INUOICE N (+)> Ascending

INV_DATE D C > Descending

CUST_ID c [ 1 Unique

CONTACT c <For...>

COMPANY c Tag Name

ADDRESS1 c

CITY C

STATE c < Move + >

zIP c

S_CONTACT c < Remouve >

- Index Expression Output

<Expr...> (> IDX [ 1 Compact
C > CDX [ 1 Structural « OK »
<{Save fs...>
| ] < Cancel >

Index Dialog

Compound Index Files

A compound index file is an index file that contains any number of
separate index entries or fags. Because the number of tags in a
compound index file is limited only by disk space, you can have as
many tags in the file as disk space permits. All indexes in a com-
pound index file are available when the file is opened.

Two types of compound index files may be created: structural and
independent.

Creating a Structural Compound Index

A structural compound index file is automatically opened and up-
dated with the database and assigned the same name as the
database. Any index entries that need to be kept current should
be included in the structural compound index.
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To create a structural compound index:

1. Choose the CDX radio button in the Output box at the bottom

of the Index dialog.

Ascending and Descending are now enabled so you can specify
whether the fields in your database will be indexed in ascend-
ing or descending order.

. Check the Structural check box in the Output box.

When you check the Structural check box, the name of the open
database is automatically entered in the text box below the
Save As... push button.

. Then, do one of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list. The index will be given a
tag name that corresponds to the field you've chosen.
The tag name appears in the Tag Name text box.

¢ Type the index expression in the text box below the
Expr... push button. Type a tag name for the index
entry in the Tag Name text box. Choose the Move
push button to copy the expression into the Index On
list.

® Choose the Expr... push button and use the Expression
Builder to create an index expression. Type a tag name
in the Tag Name text box. Choose the Move push
button to copy the expression into the Index On list.

. If you want to include a For clause in your index expression, do

one of the following:

® Type the clause in the text box next to the For... push
button.

® Choose the For... push button and create the For clause
in the Expression Builder.

. If you don’t want records with duplicate index expression

values to be included in the index file, choose the Unique check
box when the index expression is tagged (selected so a triangle
appears next to it) in the Index On list. A ! appears next to the
index expression. Only the first record encountered with the
specified value will be included in the index file.

. When you're satisfied with the expression in the Index On list,

choose OK.
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Creating an Independent Compound Index

An independent compound index file never has the same name as
the database and will not automatically open with a database. It
must be explicitly opened for a database.

File Menu

To create an independent compound index:

1.

Choose the CDX radio button in the Output box at the bottom
of the Index dialog.

Uncheck the Structural check box.

Then, do ore of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list. Or,

® Type the index expression in the text box below the
Expr... push button. Type a tag name for the index
entry in the Tag Name text box. Choose the Move
push button to copy the expression into the Index On
list.

® Choose the Expr... push button and use the Expression
Builder to create an index expression. Type a tag name
for the index entry in the Tag Name text box. Choose
the Move push button to copy the expression into the
Index On list.

If you want to include a For clause in your index expression, do
one of the following:

® Type the clause in the text box next to the For... push
button.

® Choose the For... push button and create the For clause
in the Expression Builder.

If you don’t want records with duplicate index expression
values to be included in the index file, check the Unique check
box when the index expression is tagged in the Index On list.
A ! appears next to the index expression. Only the first record
encountered with the specified value will be included in the
index file.

When you're satisfied with the expression in the Index On list,
type a name for your new file in the text box below the Save
As... push button or choose the Save As... push button to dis-
play the Save As dialog. In the Save As dialog, you can specify
the directory where the new file will be stored and name the
file. Type a name in the text box and choose OK.
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7. Choose the OK push button in the Index dialog.

Compact Single Entry Index Files

The single entry index file is limited to one index entry. This
index file must be explicitly opened and active to be updated with
a database. The number of single entry index files you can have
open per database file is limited by file handles.

You can make a single entry index file compact so that it is
smaller, faster and requires less disk space. Compact single entry
index files are useful if you're using the index for only a limited
time and you're going to delete the file when you're finished using
it.

To create a compact single entry index:

1. Choose the IDX radio button in the Output box at the bottom of
the Index dialog.

2. Check the Compact check box.

3. Then, do one of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list.

¢ Type the index expression in the text box below the
Expr... push button and choose the Move push button
to copy the expression into the Index On list.

¢ Choose the Expr... push button and use the Expression
Builder to create an index expression. Then choose the
Move push button to copy the expression into the Index
On list.

4. If you want to include a For clause in your index expression, do
one of the following:

¢ Type the clause in the text box next to the For... push
button.

® Choose the For... push button and create the For clause
in the Expression Builder.

5. If you don’t want records with duplicate index expression
values to be included in the index file, check the Unique check
box when the index expression is tagged in the Index On list.
A ! appears next to the index expression. Only the first record
encountered with the specified value will be included in the
index file.
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6. When you're satisfied with the expression in the Index On list,
type a name for your new file in the text box below the Save
As... push button or choose the Save As... push button to dis-
play the Save As dialog. In the Save As dialog, you can specify
the directory where the new file will be stored and name the
file. Type a name in the text box and choose OK.

7. Choose the OK push button in the Index dialog.

N s

:/_

Expression Builder

Non-compact single entry index files should be created only
if you need to maintain compatibility with older versions of
FoxPro (prior to FoxPro 2.0) or if you're sharing data with
FoxBASE+ and FoxBASE+/Mac.

The Expression Builder is a dialog that appears in FoxPro when-
ever you need an expression to complete a command.

Math “ String ﬂ Logical n Date “
Field Names: Database: Variables:
»CUST_ID c CUSTOMER “ »X c
COMPANY c _ALIGNMENT | C
CONTACT c _BOX L
ADDRESS1 C < Uerify > _INDENT N
ADDRESS2 c _LMARGIN N
CITY c « OK » _PADUANCE c
STATE c _PAGENO N
ZIP c < Cancel > _PBPAGE N
Expression Builder Dialog
File Menu G3-13
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An expression is an item (or items) that, when evaluated,
generates a new value of Character, Numeric, Logical or Date
type. An expression can be as simple as a single variable or num-
ber, or it can be very complex. In general, you form expressions
with an appropriate combination of the following elements:

® Database field names

® Memory variables

® Constants (or literals)

¢ Functions and operators

Expressions are often used to create indexes, relate databases or
specify a For or While clause.

Creating an Expression

To create an expression in the expression box, type in or choose
the field names, variables, operators and functions you need to
build the expression. The Expression Builder contains several con-
trols to help you create the expression. These controls are
described in the following sections.

Once your expression is complete, choose Verify to make sure that
the expression is valid. If all is well, an “Expression is valid” mes-
sage appears on the screen. Move the mouse or press Shift or Ctrl
to erase the message.

If there are any problems with the expression, an error message
appears. To erase the error message, click the mouse button or
press any key except for function keys, Ctrl, Shift and Alt.

When you've finished building the expression, choose OK to con-
firm it.
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Expression Menu Popup

When the Expression Builder dialog appears, an Expression menu
pad is added to the menu bar. The Expression menu popup is
available for users who want or need to choose menu options or
use control key shortcuts to maneuver in the dialog.

Expression

Math Functions “M
String Functions ”S
Logical Functions "L
Date Functions “D
Fields List “F
Variables List “R
Database “B
Uerify “E

Expression Menu
The Expression menu popup contains the following options:

* The Math Functions, String Functions, Logical Functions
and Date Functions options display the associated popup in
the Expression Builder dialog.

e The Fields List, Variables List and Database options select
the appropriate list or popup in the Expression Builder dialog.

® The Verify option displays a message telling whether or not
your expression is valid. Move the mouse or press Shift or
Ctrl to erase the message.

Function/Operator Popups

File Menu

At the top of the Expression Builder are four popups: Math, String,
Logical and Date. These popups contain the functions and
operators that you can use to build expressions with each type of
data. Each popup is scrollable.

When you choose a function or an operator from a popup, it ap-
pears in the expression box.
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Functions and operators can be edited in the expression box as
necessary. Be sure to select the expression box before you try to
edit in it.

Expression Line and Expression Box

Below the four function/operator popups is the expression line and
below that is the expression box. The expression line reminds you
what your expression will be used for, and the expression box dis-
plays your expression as you build it.

When you want to type or edit directly in the expression box, make
sure you select the box first by clicking in it with the mouse or
Tabbing to it.

Any time that you wish to erase the contents of the expression box,
use FoxPro text editing techniques.

Field Names and Variables

The Field Names list displays the fields in the active database.
You can tell which database is active because its name appears on
the Database popup control.

Similarly, the Variables list displays the available memory vari-
ables that you can choose and add to your expression.

Field names and variables can be moved into the expression box by
double-clicking on the field name or variable with the mouse.
With the keyboard, press Tab until an item in the appropriate list
is highlighted. Press the Up and Down Arrow keys to select the
desired field name or variable, then press Enter. The field name
or variable appears in the expression box.

Database Popup

The name of the active database appears on the Database popup
control. The Database popup lists all database files open in work
areas.

To use fields from a different database in your expression, choose
another database from the Database popup. The Field Names list
displays the fields in the newly selected database.

When only one database is open, the Database popup is disabled.
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Expression Builder Preferences Dialog

File Menu

Choosing Preferences... from the Edit menu popup when the Ex-
pression Builder dialog is displayed brings forward the Expression
Builder Preferences dialog.

Expression Builder Preferences

Function Popups

(<> Math oA
( ) String o3
C ) Logical o/
C ) Date o+
< All > < Clear >
Field Aliases
C ) Aluays add alias
( ) Add non-selected alias only
(<> Never add alias

[X] Shou System Memory Uariables

« OK »

Expression Builder Preferences Dialog

With this dialog you can:

® Change the options that will appear on the Math, String,
Logical and Date popups

® Specify whether field aliases will be displayed in your
expressions and how you want them displayed

® Specify whether or not to display system memory variables in
the Expression Builder

Four radio buttons and a list of popup options are located in the
Function Popups area at the top of the dialog.

To adjust the options that will appear on the Math, String, Logical
and Date popups, choose the radio button for the popup that you
wish to change. The list on the right contains the options that can
appear on the popup. A bullet next to an option indicates that it
will appear on the popup.
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Choosing the All push button places a bullet next to every option
so that all the options will appear on the popup.

Choosing the Clear push button removes the bullets next to all the
options in the list and removes them from the popup.

To add or remove individual options from the popup:
1. Select the option in the list.
2. Then, do one of the following:

® Press the Enter key.
® Press the Spacebar twice.
® Point to the option with the mouse and double-click.

The radio buttons in the Field Aliases portion of the dialog deter-
mine how field aliases are displayed.

Always add The database name is included with fields used in
alias the expression.

Add When more than one database is open, FoxPro in-
non-selected cludes the name of the database that is not
alias only selected in the work area of the View window with

any of its fields in the expression.

Never add Database names are not included with any field
alias when creating the expression.

Unchecking the Show System Memory Variables check box
removes system memory variables from the Expression Builder.

The preferences you specify are saved in your FOXUSER file.

Creating a Report Form File
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When you choose the Report radio button in the New File dialog,
you invoke the FoxPro Report Writer. With the Report Writer, you
can design custom report forms to meet your needs.

The Report Writer is described in the Report Writer chapter of this
manual. For information on printing a report, see Report in the
Database Menu chapter.
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Creating a Label File

When you choose the Label radio button in the New File dialog, a
Label Layout window appears. For information about labels, refer
to the Label Designer chapter in this manual.

Creating a Screen File

Choose the Screen radio button in the New File dialog to display a
Screen Design window. For information about screens, refer to
the Screen Builder chapter in this manual.

Creating a Menu File

When you choose the Menu radio button in the New File dialog, a
Menu Design window appears. For information about menus, refer
to the Menu Builder chapter in this manual.

Creating a Query

Choose the Query radio button in the New File dialog to display
the RQBE (Relational Query By Example) window. For information
about RQBE, refer to the chapter titled Relational Query By Ex-
ample (RQBE) in this manual.

Creating a Project File

Choose the Project radio button in the New File dialog to display a
Project window. For more information, see the chapter titled
Project Manager in this manual.
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Open...

Open an existing file
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Open... allows you to open existing files. When you choose this
option, the Open File dialog appears.

Open:

[..1 Drive C “

CUSTOMER. DBF

CUS_COM. DBF

INUOICE. DBF

ITEMS. DBF Directory | TUTORIAL ﬂ

LINEITMS.DBF

PAYMENTS. DBF

SALES. DBF « Open »

[ 1 All Files < Neu >
Database H Type < Cancel >

Open File Dialog

The Open File dialog displays all the files of a particular type.
File types are categorized by their extensions.

If you want to display all files in a directory, regardless of type
(extension), check the All Files check box. Now you can open any
file that contains valid data for the file type displayed on the Type
popup, even if it doesn’t have the default extension.

The first time that this dialog appears during a session, it displays
the items from the default directory. If you change drives and/or
directories, any time the dialog appears again it will display the
same items as when you last closed it. To return to the default
directory, you must choose that directory from the popup.

The list in the Open File dialog displays the symbol for parent
directory ([..]), followed by the names of subdirectories of the cur-
rent directory (contained in brackets). Below these are the names
of all files that correspond to the specified type (extension), dis-
played in alphabetical order. If a file is already open, that file
name is disabled in the list.
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Changing Drive and Directory

You can change directories one at a time by choosing the parent
directory ([..]) from the list. Each time you choose the parent
directory you move one directory closer to the root directory. The
Directory popup displays the name of the current directory and the
list changes to reflect the subdirectories and files in the new direc-
tory.

The Directory popup contains the names of all the parent direc-
tories up to the root directory. You can move up the directory
structure quickly by choosing the desired directory from this
popup.

You can change drives using the Drive popup. This popup displays
all the available drives. When you change drives, the associated
root directory appears on the Directory popup control and the list
displays the subdirectories and files in the new root. When the
current directory is the root, no symbol for parent directory ([..])
appears in the list.

Specifying File Type

File Menu

The Type popup at the bottom of the dialog displays all the file
types you can open. This popup scrolls so you can see all the file
types. File types that cannot be opened are disabled.

If the current work area does not contain an open database, you
can open any file type except an index file. If a database is open
in the current work area, you can open every file type.

Before you open a file, make sure that the appropriate file type
appears on the Type popup control.

When you display Report, Label or Screen on the Type popup in
the Open File dialog, a Restore Environment check box appears at
the bottom of the dialog.

The Restore Environment check box is checked by default. This
means that when a report, label or screen file is opened, all en-
vironment settings saved with the file, including databases and in-
dexes in use, relations and set skip to settings, are restored.

If you wish to open a report, label or screen without opening an
associated environment, uncheck the check box.
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Specifying a File To Open

To open a file, select it from the list and choose Open. To leave
the dialog without opening a file, choose Cancel.
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When you open different types of files, different actions occur. The
action associated with each file is described next.

Database

Program

View

File

Index

Opens a database in the current work area and
generates USE <filename> in the Command window.
If a database is already open in the selected work
area, it is closed before the newly selected file is
opened.

Displays a program file in a text editing window and
generates MODIFY COMMAND <filename> in the Com-
mand window. Text editing is described in the
Interface Basics chapter.

Restores any environment settings, including
database, index, alternate and format files, alias
names and established relations from the View win-
dow and generates SET VIEW TO <filename> in the
Command window.

Displays a text file in a text editing window and
generates MODIFY FILE <filename> in the Command
window. Text editing is described in the Interface
Basics chapter.

Opens a single entry index file in the current work
area and generates SET INDEX TO <filename> in the
Command window. An open single entry index is rep-
resented in the View window by a bullet that precedes
the work area alias. If another single entry index file
is open in the current work area, it is closed before
the new index is opened.

To open an independent compound index file or more
than one single entry index file for the chosen
database, choose Setup... from the Database menu
popup or choose the Setup push button in the View
window. Setup is described in the Database Menu
chapter.
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Label

Screen

Menu

Query

File Menu

Open...

All index tags in a structural compound index file are
available when the database is opened.

Index is enabled only if a database is open in the cur-
rent work area.

Invokes the FoxPro Report Writer. Your report file
appears in a Report Layout window. In addition to
FoxPro .FRX files, reports from other applications are
available to you in the Open File dialog. These files
have an .FRM extension. If you try to open a file that
has an .FRM and an .FRX version, the .FRX file will be
opened unless you adjust your configuration file.
Refer to the Report Writer chapter of this manual for
more information.

Displays a label file in the Label Layout window. In
addition to FoxPro .LBX files, labels from other ap-
plications are available to you in the Open File dialog.
These files have an .LBL extension. If you try to open
a file that has an .LBL and an .LBX version, the .LBX
file will be opened unless you adjust your configura-
tion file. Refer to the Label Designer for more infor-
mation.

Displays a screen file in the Screen Design window
and generates MODIFY SCREEN <filename> in the
Command window. You can open many screen files
at the same time. Refer to the Screen Builder chapter
in this manual for more information.

Displays a menu file in the Menu Design window and
generates MODIFY MENU <filename> in the Command
window. Refer to the Menu Builder chapter in this
manual for more information.

Displays the RQBE window for an existing query and
generates MODIFY QUERY <query_name> in the Com-
mand window. You can open more than one RQBE
window at a time. Refer to the chapter titled
Relational Query By Example (RQBE) for more infor-
mation.
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Close

Project Opens an existing Project window. Maultiple Project
windows can be opened at the same time. Refer to
the Project Manager chapter in this manual for more
information.

Close the active window

Save

Close closes the active window. Mouse users can also close a win-
dow by clicking on the close box in the upper left corner of the the
window.

Save the active file
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Save stores any changes you've made to the active text, program,
report, label, screen, menu, query or project file without closing the
file. If more than one editing window is active, only changes to the
frontmost editing window are saved to disk.

If you choose Save when a file has not yet been saved or named,
the Save As dialog appears.

Save is disabled when no changes have been made since you last
saved, or when a window other that an editing window is
frontmost (for example, Browse, Command).
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Save as...

Save the active file under a different name

Save as... allows you to name and save a newly created file, or
save a copy of an existing file under a different name. Choose
Save as... to display the Save As dialog.

Save Current Document fAs:

»[..] Drive C “
CLABEL. LBL
CONFIG.FP
CREDITS. PRG |
CSTLEDGR. PRG Directory | SAMPLE “
CUSTLABE. PRG
CUSTLIST. PRG
CUSTMENU. PRG « Save »
[X]1 All Files < Cancel >

S

Save As Dialog

If the file has already been named, the current name of the file
appears in the text box. Otherwise, the text box is empty.

Select the text box, then type a name for the file and choose Save.

¢ If this is the first time you have saved the file, it is stored on
disk and the file name appears as the window title.

¢ If you are saving a copy of an existing file, a new text editing
window appears with the new file name as the window title.
The old file is closed. If recent changes to the old file were
not saved before you created the new file, the changes do not
appear in the old file but do appear in the new file.

When you name and save files, text files are not automatically as-
signed a .TXT extension. If you want a text file to have an exten-
sion, you must type the extension in the text box when you name
the file. Program files are automatically assigned a .PRG exten-
sion.

You can save the current environment settings to a view file. If
you choose Save as... when the View window is frontmost, a Save
As dialog appears so you can enter a name for the new .VUE file.
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Revert

This .VUE file contains all the environment settings including
names of files in use, alias names, relations that have been estab-
lished, and so on.

When in the Save As dialog, you may decide not to create a new
file. Choose Cancel to resume editing the current file.

Return to the last saved version of a file

Revert is enabled when you've made changes to a text file, pro-
gram file, report file, label file, screen file, menu file, query file,
project file or memo field since the file was last saved.

Choose Revert to replace the currently displayed file or memo field
with the previous version. Before replacing the current version,
FoxPro asks if you want to discard the changes.

Choose No to return to the current version or Yes to discard your
changes and replace your current document with the previous ver-
sion.

Printer Setup...

Specify printer settings
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Printer Setup... displays the Printer Setup dialog.

Printer Setup:

Print to: PRN [I
<File... >
C ) Print On Left margin:
(<> Print Off Right margin: i’
« OK » < Cancel >

Printer Setup Dialog
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Print...

In this dialog, you can choose a print device from the Print to
popup. If you choose File from the popup, you should specify a file
to which output will be sent. To do this, type a file name in the
text box or choose the File... push button and enter a file name in
the Print To dialog.

Adjust the settings for left margin and right margin, if necessary.
These values are assigned to the _'LMARGIN and _RMARGIN system
memory variables and affect all output from the Print dialog. If
Wrap words is checked in the Preferences dialog, output from 2,7
and the TYPE command is also affected.

Choose the Print On or Print Off radio button to enable or disable
output to the printer.

When your settings are correct, choose OK to activate them or
choose Cancel to exit the dialog without changing the current
print settings.

Print the active file

File Menu

Print... displays the Print dialog.

Print:

Windous: File ||
« OK »

<{File... >
I ] < Cancel >

[ 1 Line Numbers
[X]1 Page eject before
[ 1 Page eject after

Print Dialog
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Quit

In this dialog, you can specify one of the following print sources:
¢ The contents of the clipboard
¢ The contents of the Command window
¢ The contents of any open editing window
¢ The contents of a file that is not currently open

Choose the source from the Windows popup. To print the contents
of a file that is not currently open, choose the File option from the
Windows popup. Then, in the text box, type the name of the file
you want to print (including a full path if the file is in a different
directory), or choose File... and choose the file you want to print
from the list in the Open File dialog.

If you choose to print the contents of an open editing window, the
settings of the following options in the Preferences dialog will af-
fect the output: Left justify, Right justify, Center justify and Tab
size.

When Line Numbers is checked, FoxPro automatically adds line
numbers to the output.

When the Page eject before check box is checked, FoxPro sends a
form feed to the printer before printing. - When the Page eject
after check box is checked, FoxPro sends a form feed to the printer
after printing.

Once the settings in the Print dialog are correct, choose OK to
confirm your choices or Cancel to exit the dialog without taking
action.

Exit FoxPro and return to system prompt
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Quit ends your FoxPro session and returns you to the system
prompt. The same actions occur when you type QUIT in the Com-
mand window.
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Edit menu options are useful when editing text in FoxPro.

Undo “u
Redo “R
Cut X
Copy ~C
Paste “V
Clear

Select All “A
Goto Line...

Find... “F
Find Again ~G

Replace fAind Find Again “E
Replace All

Preferences...

Edit Menu
In addition to using Edit menu options in windows, some Edit

menu options are available for use in text editing regions and text
boxes of dialogs.
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Undo

Reverse your last text editing command
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Undo reverses the last action that was performed on any text
within a field, record or file, and in text editing regions and text
boxes of dialogs. If you choose Undo repeatedly, actions will be
reversed all the way back to the start of the current editing ses-
sion.

In the context of Undo and Redo, an action is defined as:
® Pressing Delete or Backspace
¢ Selecting then pressing Delete or Backspace
¢ Selecting then starting to type replacement text
¢ Moving the cursor and typing

¢ Any sequence of keystrokes besides those listed above that
you make before pressing the Spacebar and typing

¢ Choosing one of the following Edit menu options: Cut, Paste,
Clear or Replace All

Undo reverses actions in order from the most recent action per-
formed back to the least recent (the first action performed in the
editing session). If you Undo an action and then change your
mind, you cannot restore the text to its previous form by choosing
Undo again. To reverse an Undo, choose Redo from the Edit
menu popup.

In a Browse window, Undo is available on a field-by-field basis. If
you are editing a field in Browse and change your mind, choose
Undo to display the field’s original contents. Once you move the
cursor to a new field using the mouse or the keyboard, Undo is
disabled until you make changes in the new field.

If you choose Undo to reverse the action of the Replace All option,
all the changes made during the replace are removed. Replace All
is treated as one action.

When Undo has reversed all the actions performed in the current
session, it is disabled. This means that when you save a file or
close a file and reopen it, the Undo option is disabled until you
make additional changes.
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Redo

Redo the action previously reversed using Undo

Redo is the opposite of Undo. If you change your mind after you
Undo an action, choose Redo to restore the text to its previous
condition.

If you Undo several actions in a row, choosing Redo repeatedly
will redo the actions in the reverse order that they were undone.
The definition of an action for Redo is identical to the definition ™
for Undo.

Cut

Place selected text on the clipboard

Cut removes selected text from any field, record, file, or from text
editing regions and text boxes of dialogs. The text is placed on the
clipboard.

Use Cut when you want to remove a piece of text from one location
and place it in a different location using Paste. For more informa-
tion on Cut, refer to the Text Editor section of the chapter titled
Interface Basics.

Copy

Copy selected text to the clipboard

Copy duplicates the selected text (without removing it) and places
the copy on the clipboard.

For more information on Copy, refer to the Text Editor section of
the chapter titled Interface Basics.

Paste

Place text from clipboard

Paste inserts a copy of the clipboard contents into the current file
or field at the cursor location. If text is selected and you choose
Paste from the Edit menu popup, the contents of the clipboard
replace the selected text. For more information on Paste, refer to
the Text Editor section of the chapter titled Interface Basics.
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Clear
Delete selected text

Clear permanently removes selected text or data without placing it
on the clipboard. If you choose this option when text is selected, it
is the same as pressing Delete or Backspace.
Clear also erases the active FoxPro output window. If you use
Clear this way, text or data does not have to be selected.

Select All

Select all lines of text

Select All selects all lines of text in the current editing window,
design window, layout window, dialog text editing region or dialog
text box. If you choose Select All when you are in a Browse win-
dow, all the text in the current field is selected for editing.

Goto Line...

Move cursor to designated line number

Goto Line... displays the Goto Line dialog so you can move the
cursor to a designated line in a text, program or memo editing
window, or in the Command window. For text, program and memo
editing windows, this option is available only when Wrap words is
not checked in the Preferences dialog.

Line Number: :

« Goto » < Cancel >

Goto Line Dialog

In the Line Number text box, type the number of the line where
you want the cursor to appear.

When you choose Goto, the cursor moves to the beginning of the
line you specify, and the text of that line is displayed in the win-
dow. If the line number you specify is greater than the number of
lines in the window, the cursor is positioned on the last line.
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Find...

Entering a negative number also positions the cursor on the last
line in the window.

The number you enter last in the Line Number text box is
“remembered” until you exit FoxPro.

Search for text

Edit Menu

Find... displays the Find dialog.

Look For: [ |
Replace With: [ ]
[X]1 Ignore case () Search foruard
[ 1 Match uords C > Search backuard

[ 1 Urap around
« Find » < Cancel >
Find Dialog

The Find dialog lets you specify a word or phrase that you want to
Look For and optionally lets you specify Replace With text. You
don’t have to specify Replace With text if you just want to locate
text. If you do specify Replace With text, you don’t have to use it
for every occurrence you find.

Type the text you wish to locate in the Look For text box and type
the text (if any) that will replace the located text in the Replace
With text box.
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In the Find dialog you can specify the following options:

Search
forward

Search
backward

Ignore case

Match words

Wrap around

Searches the file from the current file position to
the end of the file. This is the default setting.

Searches the file from the current file position
backwards, toward the beginning of the file.

Locates the word with any combination of upper-
and lower-case letters. If you use Ignore case
with the phrase “Find the Text”, FoxPro locates
all case combinations, including: “find the text”,
“Find the Text” and “FIND THE TEXT”. If you don’t
check this check box, FoxPro only locates occur-
rences of “Find the Text”.

Locates occurrences of the exact letter combina-
tion as specified in the text box. For example, if
you told FoxPro to search for “can” and did not
check Match words, it would find any phrases
that contain “can”, such as “candle”, “decanter”
and “incandescent”. If you choose Match words,
only exact occurrences of the word “can” are
found.

Searches the file from the cursor location to the
end of the file, then wraps around to the begin-
ning of the file and searches to the original cursor
position. Wrap around allows you to search the
entire file without first positioning the cursor at
the beginning of the file.

When you have entered the appropriate information in the Find
dialog, choose Find to begin the search or Cancel to exit the dialog
without taking action.

To search for Enter, Tab, Backslash and new line (line feed)
characters, use the following C language representations
when you type them in the text boxes in the Find dialog:

\r — to search for an Enter.
\t — to search for a Tab.

\\ — to search for a backslash. |
\n — to search for a new line (line feed).
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When FoxPro finds a match, it highlights the matching text for
you to see. You can edit the text using FoxPro editing techniques.

Find... can also be used to search for text in the Browse window.
No Replace With text box appears in the Find dialog when you use
it in the Browse window. To find and replace text in Browse,
choose Replace from the Record menu popup. Refer to Replace in
the Record Menu chapter for more information.

The Filer can be used to tag all files that contain specified text
strings. For more information about the Filer, refer to the Filer
Menu chapter of this manual.

Find Again

Repeat the last text search

After FoxPro locates the text string you specified in the Find
dialog, you can choose Find Again to locate the next occurrence of
the string.

When FoxPro finds the last match in the text, a “Not found” mes-
sage appears to let you know that the search is complete.

Find Again is enabled only after you enter text in the Look For
text box of the Find dialog and choose Find.

Replace and Find Again

Replace text and continue search

Edit Menu

Replace and Find Again replaces a matching string of Look For
text with the Replace With text that you specified in the Find
dialog, then continues to search for the next occurrence of match-
ing text. Replace and Find Again is enabled only after the first
Find is executed. When FoxPro finds the next match, it pauses
again to await instructions. If you don’t want to replace this
specific match, choose Find Again instead of Replace and Find
Again.
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Replace All

Replace all occurrences of the specified text

Replace All replaces every occurrence of a matching string of Look
For text with the Replace With text that you specified in the Find
dialog. It does not pause and ask about replacing the text each
time it encounters a match. This option is enabled only after you
choose Find... from the Edit menu popup.

When FoxPro has found the last match in the text, a “Not found”
message appears to let you know that the search is complete.

Preferences...

Establish edit settings

When a text, program or memo editing window is active, you can
choose Preferences... to display the Preferences dialog so you can
adjust the preferences that are in effect during editing sessions.
Preferences is also enabled when the Expression Builder or the
Calculator is frontmost.

Editing Preferences

G4-8

Different preferences are used for text, program and memo editing
windows. The active editing window determines the file type to
which your preferences will apply. For example, if a program edit-
ing window is active and you choose Preferences... from the Edit
menu popup, any adjustments you make apply to program files.

[X] Wrap uords Tab size: HE

[X] Auto indent

[X] Make backup [ 1 Use these preferences
[X] Add line feeds as default for files
[ 1 Status line uith no extension

[ 1 Add Ctrl-Z [ 1 Save preference

(+> Left justify

C > Right justify « OK » <Cancel>

C ) Center Jjustify

Preferences Dialog
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Wrap Automatically wraps text in the current window to

words the next line when it reaches the right margin, in-
stead of letting it continue, beyond the right margin.
Text that extends beyond the right margin can be ac-
cessed by scrolling the window.

Auto Automatically indents a line by the same amount as
indent the previous line. This allows you to easily construct
indented program structures.

N When Wrap words and Auto indent are both checked,
= — FoxPro automatically indents wrapped text in each para-
graph by the same amount as the first line of the paragraph.

For example:

® When a paragraph begins with a Tab, any wrapped
lines are aligned with the Tab.

® When a paragraph begins with a number (or other text)
followed by a Tab and text, any wrapped lines are
aligned with the Tab.

® When the first line of a paragraph is indented using the
Spacebar, any wrapped lines are indented by the same
amount as the first line.

Make Stores the previous version of an edited file or pro-

backup gram as a backup. Every time you save a file, the
previous version is stored as the backup (in a .BAK
file).

Add line Saves files using a carriage return and line feed at

feeds the end of all lines. When this option is not checked,
files are saved without line feeds and carriage returns
so that they can also be exported to other computers.

Status line Adds a status line at the top of the editing area.
When this check box is checked, a bullet appears in
the upper left corner of the editing area if the text has
been modified since it was last saved. The cursor’s
line and column positions are displayed. (Line posi-
tion of the cursor is displayed only when Wrap words
is not checked.) The active edit modes are also dis-
played: Insert mode (Ins), Overwrite mode (Over),
Numlock mode (Num) and Capslock mode (Caps).

Edit Menu G4-9
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Compile
when
saved

Add Ctrl-Z

Left justify

Right
justify

Center
justify

Tab size

Use these

This preference is available only for program files and
instructs FoxPro to compile the file after it is saved.
If this is not checked, the program will not be com-
piled until it is executed.

When this check box is checked, FoxPro places a Ctrl-
Z at the end of the file when the file is saved to mark
the logical end of the file. FoxPro stops reading or
writing a file when it encounters a Ctrl-Z, even if the
Ctrl-Z has a meaning other than end-of-file.

If you don’t check the Add Ctrl-Z check box, files will
be read and written in their entirety even if they con-
tain a Ctrl-Z character. The Ctrl-Z character will be
read or written into the file.

Aligns all text at the left edge of the editing window.

Aligns all text at the right edge of the editing window.

Centers each line of text in the window. When you
check this check box, pressing Enter positions the cur-
sor in the center of the next line of the editing win-
dow.

Sets the distance (in number of spaces) that the cur-
sor will advance when you press the Tab key. The
default is four, but it can be set to any value between
zero and 50.

Designates that all settings should be used as

preferences defaults for new text, program or memo files.

Save
preference

Stores the preference settings in the resource file so
that each time you open the file, it appears as you left
it at the end of the last editing session. This option
also stores the window size, position and the cursor
location.
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Expression Builder Preferences

Choosing Preferences... when the Expression Builder dialog is dis-
played will bring forward the Expression Builder Preferences
dialog. Refer to the Expression Builder section in the File Menu
chapter for a description of this dialog.

Calculator Preferences

If you choose Preferences... when the Calculator is active, the
Calculator Preferences dialog appears. Refer to Calculator in the
System Menu chapter for more information.
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Database menu options act on entire databases.

Setup...
Brouse

Append From...
Copy To...
Sort...
Total...

Average...
Count...
Sum. ..
Calculate...
Report...
Label...

Pack
Reindex

Database Menu
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Setup...
Set up the current work area
Setup... allows you to set up the current work area. This option
acts the same as the Setup push button in the View window.
Choose the Setup... option or the Setup push button to display the
Setup dialog. If no database is open in the current work area, you
are prompted to open one. Once a database is open, the Setup
dialog appears.
Database: C:\FOXPROX\TUTORIAL\INUOICE.DBF
Structure: <Modifyd> Indexes: Index
»INUOICE N 5 %) tINUOICE: INUOICE
INU_DATE D 8 0 tINUOICE: INU_DATE < Add... >
CUST_ID C 6 (%) 1+INUCICE: CUST_ID
CONTACT C 30 8 1INUOICE: CONTACT {Modify...>
COMPANY c 30 (<) 1+ INUOICE: COMPANY
ADDRESS1 > 38 e tINUOICE: CITY < Remove >
CITY C 20 (5] 1INUOICE: STATE
STATE c 2 e tINUOICE: ZIP <{Set Order>
zIP c 18 ] 1 INVOICE: SOLDBY
Fields: 19 Length: 288 Index expr: INUOICE
Index filter:
[ 1 Set Fields...
C ) On (<> Off « OK »
[ 1 Filter...
[ 1 Format...

Setup Dialog

In the Setup dialog, you can decide which index file(s) to use with
a database, select a list of fields to display in the Browse window,
define a filter, and specify a format file to use for data input.
When you finish setting up a work area, choose OK.

Using Indexes

G5-2

Four push buttons are located at the right side of the Setup dialog:
Add..., Modify..., Remove and Set Order/No Order. These push
buttons allow you to open indexes, create indexes, modify index
expressions, set the order of database records and close index files.
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Opening an Existing Index

To open an existing index in the Setup dialog, choose Add.... The
Open File dialog appears so you can select the desired index file.
The Setup dialog reappears with the index name in the Indexes
list.

Structural compound index files do not have to be explicitly opened
in this manner. These index files are automatically opened when
the associated database is opened. For more information about
these indexes, see the Compound Index Files section in this chap-
ter.

All open index files appear in the Indexes list. The index with a
bullet next to it determines the database order.

To see the expression and filter for an index, select the index name
in the Indexes list. The index expression and filter appear below
the Indexes list.

Closing an Index

Those indexes that appear in the Indexes list of the Setup dialog
are open. To close an index, select its name from the Indexes list,
and then choose the Remove push button. The index is removed
from the Indexes list.

Database Menu G5-3



Setup...

Creating a New Index

An appropriate index may not exist for you to use with a database.
To create a new index in the Setup dialog, choose Add.... The
Open File dialog appears. Choose New. The Index dialog appears.

Database Fields: Index On:
Options

INUOICE N (+) Ascending

INU_DATE D € > Descending

CUST_ID c [ 1 Unique

CONTACT c CFor...> ]

COMPANY c Tag Name

ADDRESS1 c

CITY c

STATE c < Move + >

ZIP c

S_CONTACT c < Remove >

<Expr...> (> IDX [ 1 Compact
(> CDX [ 1 Structural « OK »
<Save fs...>
I ] < Cancel >

Index Expression ‘ [ Output

Index Dialog

FoxPro lets you create two categories of index files:
¢ Compound index files (CDX default extension)

¢ Single entry index files (.IDX default extension)

Compound Index Files

A compound index file is an index file that contains any number of
separate index entries or tags. Because the number of tags in a
compound index file is limited only by disk space, you can have as
many tags in the file as disk space permits. All indexes in a com-
pound index file are available when the file is opened.

Two types of compound index files may be created: structural and
independent.

Creating a Structural Compound Index

A structural compound index file is automatically opened and up-
dated with the database and assigned the same name as the
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database. Any index entries that need to be kept current should
be included in the structural compound index.

To
1.

Database Menu

create a structural compound index:

Choose the CDX radio button in the Output box at the bottom
of the Index dialog.

Ascending and Descending radio buttons allow you to select
whether the fields in your database will be indexed in ascend-
ing or descending order.

Check the Structural check box in the OQutput box.

When you check the Structural check box, the name of the open
database is automatically entered in the text box below the
Save As... push button.

Then, do one of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list. The index will be given a
tag name that corresponds to the field you've chosen.
The tag name appears in the Tag Name text box in the
Options portion of the dialog.

® Type the index expression in the text box below the
Expr... push button. Type a tag name for the index
entry in the Tag Name text box. Choose the Move
push button to copy the expression to the Index On list.

® Choose the Expr... push button and use the Expression
Builder to create an index expression. Type a tag name
in the Tag Name text box. Choose the Move push
button to copy the expression to the Index On list.

If you want a For clause in your index expression, do one of the
following:

® Type the clause in the text box next to the For... push
button.

® Choose the For... push button and create the For clause
in the Expression Builder.

If you don’t want records with duplicate index expression
values to be included in the index file, choose the Unique check
box when the index expression is tagged in the Index On list.
A ! appears next to the index expression. Only the first record
encountered with the specified value will be included in the
index file.
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6. When you're satisfied with the expression in the Index On list,
choose OK. The Setup dialog reappears with the new index in
the Indexes list.

Creating an Independent Compound Index

An independent compound index file never has the same name as
the database and will not automatically open with a database. It
must be explicitly opened for a database.

To create an independent compound index:

1. Choose the CDX radio button in the Output box at the bottom
of the Index dialog.

2. Uncheck the Structural check box.

3. Then, do one of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list.

¢ Type the index expression in the text box below the
Expr... push button. Type a tag name for the index
entry in the Tag Name text box. Choose the Move
push button to copy the expression to the Index On list.

® Choose the Expr... push button and use the Expression
Builder to create an index expression. Type a tag name
for the index entry in the Tag Name text box. Choose
the Move push button to copy the expression to the
Index On list.

4. If you want a For clause in your index expression, do one of the
following:

® Type the clause in the text box next to the For... push
button. '

® Choose the For... push button and create the For clause
in the Expression Builder.

5. If you don’t want records with duplicate index expression
values to be included in the index file, choose the Unique check
box when the index expression is tagged in the Index On list.
A ! appears next to the index expression. Only the first record
encountered with the specified value will be included in the
index file.

6. When you're satisfied with the expression in the Index On list,
type a name for your new file in the text box below the Save
As... push button or choose the Save As... push button to dis-
play the Save As dialog. In the Save As dialog, you can specify
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the directory where the new file will be stored and name the
file. Type a name in the text box and choose OK.

7. Choose the OK push button in the Index dialog. The Setup
dialog appears with the new index in the Indexes list.

Compact Single Entry Index Files

The single entry index file is limited to one index entry. This
index file must be explicitly opened and active to be updated with
a database. The number of single entry index files that you can
have open per database file is limited by file handles. This is also
true for the extended version of FoxPro 2.0.

You can now make a single entry index file compact so that it is
smaller, faster and requires less disk space. Compact single entry
index files are useful if you're using the index only for a limited
time and you're going to delete it when you're finished using it.

Creating a Compact Single Entry Index
To create a compact single entry index:

1. Choose the IDX radio button in the Output box at the bottom of
the Index dialog.

2. Check the Compact check box.

3. Then, do ore of the following:

® Choose a field from the Database Fields list so that it
appears in the Index On list.

® Type the index expression in the text box below the
Expr... push button and choose the Move push button
to copy the expression into the Index On list.

® Choose the Expr... push button and use the Expression
Builder to create an index expression. Then choose the
Move push button to copy the expression into the Index
On list.

4. If you want a For clause in your index expression, do one of the
following:

¢ Type the clause in the text box next to the For... push
button.

® Choose the For... push button and create the For clause
in the Expression Builder.

5. If you don’t want records with duplicate index expression
values to be included in the index file, choose the Unique check
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box when the index expression is tagged in the Index On list.
A ! appears next to the index expression. Only the first record
encountered with the specified value will be included in the
index file.

6. When you're satisfied with the expression in the Index On list,
type a name for your new file in the text box below the Save
As... push button or choose the Save As... push button to dis-
play the Save As dialog. In the Save As dialog, you can specify
the directory where the new file will be stored and name the
file. Type a name in the text box and choose OK.

7. Choose the OK push button in the Index dialog. The Setup
dialog appears with the new index in the Indexes list.

Non-compact single entry index files should be created only
if you need to maintain compatibility with older versions of
FoxPro (prior to FoxPro 2.0) or if you’re sharing data with
FoxBASE+ and FoxBASE+/Mac.

Modifying an Index Expression

It is possible to change an existing index expression. First, select
the index name from the Indexes list. To modify the index expres-
sion, choose the Modify... push button on the right side of the
Setup dialog.

The Index dialog appears with the index expression in the Index
on list. Make changes to the index expression and For clause
using the same methods you used to create a new index.

Setting Record Order

Only one compound index tag or one single entry index file con-
trols the order of records in a database at any one time.

A leading bullet (+) appears in the Indexes list next to the index
entry or tag that controls the logical order of your database
records.

To change the logical order of your database, choose the desired
index from the list, and then choose Set Order.

If the index you chose already controls the order of the database,
the Set Order push button appears as No Order. If you chose No
Order, none of the open indexes controls the order of the database.
Instead, the database records are accessed, processed and dis-
played according to record number.
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Modifying Database Structure

The Structure list in the Setup dialog displays all fields for the
selected database along with their type, width and number of
decimal places.

To change the structure of your database, choose the Modify...
push button located in the upper left corner of the dialog. The
Structure dialog appears.

Structure: C:\FOXPROX\TUTORIAL\CUSTOMER.DBF
Name Type Width Dec
Field

{Insert>

{Delete>

« QOK »

<Cancel>

Fields: 18 Length: 218 Available: 3782

Structure Dialog
In this dialog you can:

® Assign and change the field names and attributes for your
database

® Insert and delete fields in your database
¢ Change field sizes and types
¢ Add and remove compound index tags

The Structure dialog is described in New in the File Menu chapter
of this manual.

When you are finished making modifications, choose OK. A dialog
appears to ask if you want to make the structure changes per-
manent. Choose Yes to make the changes permanent or No to
return to the Structure dialog without taking action.
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Setting Fields

The Set Fields... check box lets you specify which fields in the
selected database file will be active. Fields that are not active can-
not be accessed, examined or modified — it’s as if they don’t exist.
Data in the database itself is not affected by your use of the Set
Fields... check box.

To specify active fields, choose the Set Fields... check box. The
Field Picker dialog appears.

Database Fields: Selected Fields:
INUVOICE N 5 0 < Move » >
INV_DATE D 8 (%]
CUST_ID C 6 (*] < All + >
CONTACT C 30 2]
COMPANY [» 30 (%]
ADDRESS1 c 30 0 < Remove >
CITY C 208 [*)
STATE C 2 [’ {Remove All>
Database:

« 0K »
INUOICE “
< Cancel >
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Field Picker Dialog

The current database name is displayed on the popup at the bot-
tom of the dialog. All field names in the current database are
listed in the Database Fields list. The Selected Fields list is
empty now but will display any field names that you specify as
active.

Six push buttons are located in the Field Picker dialog:

Move Copies the selected database field in the Database
Fields list to the Selected Fields list. This text but-
ton is disabled unless a field is selected in the
Database Fields list.

All Copies all of the database fields in the Database
Fields list to the Selected Fields list.

Remove Removes the selected database field from the Selected

Fields list. This push button is disabled unless a field
is selected in the Selected Fields list.
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Remove All Deletes all fields from the Selected Fields list.

Cancel Cancels the Field Picker dialog without taking any ac-
tion and returns to the Setup dialog.

OK Takes any actions that you specified in the Field Pick-
er dialog and returns to the Setup dialog.

Two radio buttons are located under the Set Fields... check box in
the Structure dialog. These radio buttons determine whether or
not you can access all of your database fields.

On Allows you to access fields that you specified as active
with the Set Fields... check box.

Off Allows you to access all fields in all open databases,
no matter what you specified with the Set Fields...
check box.

Setting a Filter

To specify which records in the active database will be available
for processing, choose the Filter... check box. The Expression
Builder dialog appears. Create a condition that records must meet
before they will be made available for processing. For more infor-
mation about the Expression Builder, refer to the File Menu chap-
ter.

Only records that match your filter expression are displayed or are
available for processing — it’s as if the database contains only
those records.

Selecting a Screen Format File

To assign a user-defined format file to a database for data input,
choose the Format... check box in the Setup dialog. The Open File
dialog appears. Select the desired form from the list and choose
Open.

When Format... is checked in the Setup dialog, choosing Change
or Append displays your custom input window for use instead of
the default window.
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Browse

Examine and/or edit the active database

Browse allows you to examine and make changes to a database.
In a Browse window, the name of the database appears as the
window title. The contents of the database appear in the window.

CUSTOMER
Cust_id|Company Contact Addressi

pBEReo |[Datalech Inc. 480 Uillage St.

000881 |L.H.H.F. of America|Shelby T. Chapman, Pres|3222 Dodds Auvenue
8000082 |Traditional Craft |Helen Smith 18B Seuing Circle
008883 |Film Co. Mark Davidson, Ouner 13 King Circle
000606084 |Stylistic Inc. D. UWilson 36 Park Avenue
008805 |Pirate Softuare Rick D. Bruther 3 High-Ho Blud.

Browse Window

The Browse window is unique because you can split it into two
partitions and examine different parts of your database at the
same time. In addition, you can edit field data, delete and append
records, move and resize fields, and more.

You can open a Browse window in many ways:
® Choose Browse from the Database menu popup.

® Choose the Browse push button in the View window when a
database is open in the current work area.

® Double-click on a work area that has an open database.

When you use any of these methods, FoxPro performs a BROWSE
LAST. The data will be displayed in the Browse window as it ap-
peared before you last closed it. The fields are in the same posi-
tions and are the same sizes as the last time the window was open.
Any modifications you make through dialogs or commands will not
be reflected in the display.

When you open a Browse window using the BROWSE command in
the Command window or a program file, the Browse window ap-
pears in its original form (as specified in the Structure dialog).

Whenever a Browse window is frontmost, a Browse menu pad is
added to the menu bar.
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Browse Menu Popup

The Browse menu contains options for use in the Browse window.
Some options are available only when the window is split.

Change

Grid Off

Database Menu

Brouse

Change

Grid Off

Unlink Partitions
Change Partition "H

Size Field
Move Field
Resize Partitions

Goto...
Seek...
Toggle Delete )
Append Record “N

Browse Menu

Displays the database in the Browse window in
Change mode. The current record in the Browse win-
dow appears selected. Change mode for the Browse
window is described in the Record Menu chapter.

In Change mode, the fields in each record are listed
one below the other instead of stretching across the
window horizontally. If the window is split, only the
active partition appears in Change mode when you
choose Change.

Change toggles between Change and Browse depend-
ing on the mode of the Browse window.

Removes the vertical lines between field data in the
Browse window. If the window is split, only the ac-
tive partition is affected.

The Grid Off option toggles between Grid Off and Grid
On depending on the current grid setting.
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Unlink
Partitions

Change
Partition

Size Field

Move Field

Resize
Partitions

Displays a vertical scroll bar in both partitions so that
you can scroll each partition independently of the
other. This option is enabled only when the window
is split. When only one scroll bar is displayed, the
partitions are linked and will scroll together.

This option toggles between Link Partitions and Un-
link Partitions, depending on the current state of the
window.

Makes the inactive partition of the split window ac-
tive, and the active partition inactive. This option is
enabled only when the window is split.

Selects a field so that you can change its size using
the keyboard. If the selected field isn’t the one you
want to size, Tab to select the appropriate field. Once
the desired field is selected, use the Left/Right Arrows
to shorten or lengthen the field. When the field is the
desired size, press Enter.

When the window is split, field sizing affects both par-
titions.

Selects a field so you can move it to a new location
using the keyboard. If the selected field isn’t the one
you want to move, Tab to the appropriate field. Once
the desired field is selected, use the Left/Right Arrows
to relocate the field. When it is relocated, press
Enter.

When you move a field in one partition of a split win-
dow, the same field moves to the same location in the
other partition.

Activates the window splitter so that you can parti-
tion the window or change the size of the existing par-
titions using the keyboard. You can tell that the win-
dow splitter is activated because it flashes. Use the
Left/Right Arrows to resize the partitions, then press
Enter. The window splitter stops flashing.
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Seek...

Toggle
Delete

Append
Record

Browse

Displays a dialog so you can position the record
pointer on a specific record in the Browse window.
FoxPro allows you to position the record pointer at
the Top or Bottom record in the database, position on
a certain Record number or Skip a certain number of
records before positioning the record pointer.

Displays the Expression Builder so you can search the
active database through an index. Create an expres-
sion based on the index key (the field on which your
database is indexed), enclosing character strings in
single quotes, double quotes or square brackets. If
FoxPro finds a matching value in the current index
file, the database record appears selected. For Seek...
to be enabled, the database you are browsing must be
indexed and the index must be open.

Places (or removes) a bullet at the beginning of the
selected record to mark (or unmark) it for deletion.

Adds a blank record to the end of the database.

Window Manipulation

The Browse window can be manipulated in many ways to make it
visually appealing to you. The window can be split, and the fields
can be resized and rearranged. These changes apply only to the
Browse window and do not affect the actual database file.

Splitting the Window

The Browse window is unique because you can divide it into two
partitions. You divide the Browse window with a window splitter
located in the lower left corner of the window. When Browse is
divided, the database appears in both partitions.

To split the window using the keyboard, choose Resize Partitions
from the Browse menu popup. This activates the window splitter.

To split the window into two partitions using the mouse, position
the pointer on the window splitter. Drag the splitter to the right
to make the left partition larger; drag the splitter to the left to
make the left partition smaller (or to close it altogether).

Database Menu
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Cust_id| Company Cust_id|Company

When the Browse window is split, each partition has a horizontal
scroll bar so you can scroll it independently of the other. There is
only one vertical scroll bar for scrolling both partitions unless you
choose Unlink Partitions from the Browse menu popup.

CUSTOMER

0000008 |DataTech Inc. 808000 (|DataTech Inc.

000081 |L.H.H.F. of Americall 8608881 |L.H.H.F. of America|Shelby T. Chal

000082 |Traditional Craft 8088062 |Traditional Craft |Helen Smith
0000083 |Film Co. 860003 |Film Co. Mark Davidson|

000004 |Stylistic Inc. 808804 |Stylistic Inc.
0000085 |Pirate Softuare 8088005 |Pirate Softuare

Split Browse Window

In a split window, the active partition is the one in which the cur-
sor is flashing. Any actions that you perform take place in the
active partition. To activate the inactive partition, choose Change
Partition from the Browse menu popup or click in the desired par-
tition with the mouse. All Browse actions can be performed in
either partition of the window.

Changing Field Size
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You can change the size of fields in the Browse window. This
sizing does not change the actual width of the fields in the
database, only the display width. If some of your data appears to
get cut off when sizing, don’t worry. The actual underlying data is
still there.

To size a field using the keyboard, choose Size Field from the
Browse menu popup. This selects a field so that you can change
its size.
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Using the mouse, position the pointer on the grid line to the right

of the appropriate field name.

decrease the size of the field.

Cust_id|Conpany

CUSTOMER

Drag left or right to enlarge or

000880 |fDataTech Inc.

000681 |L.H.H.F. of AmMerica

000082 |Traditional Craft Helen Smith

000083 |Film Co.

000084 |Stylistic Inc. D. Wilson

000085 |Pirate Softuare Rick D. Bruther

Mark Davidson,

Shelby T. Chapman, President

Ouner

Browse Window with Sized Fields

Changing Field Order

You can change the order of fields in the Browse window. This
does not change the actual order of the fields in the database, only
the display order.

To move a field using the keyboard, choose Move Field from the
Browse menu popup. This selects a field so that you can move it.

Using the mouse, position the pointer on the field name that you

want to move. Drag left or right until the column is relocated.

Company

CUSTOMER
Contact

Addressi

DataTech Inc.

L.H.H.F. of America|Shelby T. Chapman, Pres|08000801

Traditional Craft
Film Co.
Stylistic Inc.
Pirate Softuare

N. Baker

Helen Smith

Mark Davidson, Ouner
D. Uilson

Rick D. Bruther

488 Uillage St.

3222 Dodds Avenue
18B Seuing Circle
13 King Circle
36 Park Avenue
3 High-Ho Blud.

Browse Window with Re-ordered Fields

Editing in Browse

In the Browse window, you can add and delete database records
and change existing field data. These types of changes are
reflected in the Browse window and in the actual database file.

Database Menu
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Moving in Browse

To edit in a Browse window, you must know how to move around.
Information in the window can be scrolled with the mouse by click-
ing the arrows at either end of the scroll bar. If you wish to edit
field information, position the cursor in the appropriate location
and edit as described below in Changing Field Data.

With the keyboard, you can move through windows of information
using the PgUp and PgDn keys. When you Tab to a field that is
not displayed in the window, the window scrolls horizontally.
Once in a field, you can move the cursor using the Left/Right
Arrow keys.

Changing Field Data
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Different methods exist to change field data using the keyboard.
The Tab key or Shift+Tab combination selects the next or previous
field. The Up/Down Arrows move to the field above or below the
current field. Once in a field, the Left/Right Arrows move the cur-
sor in the specified direction. You can cut, copy, paste, backspace,
delete, insert and overwrite as described in the Text Editor section
of the previous chapter.

To select a portion of a field, position the cursor, hold down the
Shift key and press the Left or Right Arrow until the portion is
selected. To select the contents of an entire field, position the cur-
sor at the beginning of the field, hold down Shift and press the
End key.

To change field data using the mouse, position the pointer on a
letter in a field. Now, you can backspace, delete, insert and over-
write as if in the text editor. Double-click on a word in a field to
select it. Anything you type replaces the selected text. Triple-click
on a field to select it entirely (necessary in cases where more than
one word is present in a field). Anything you type will replace the
selected text.

If you decide that you want to reverse a change, you can choose
Undo from the Edit menu popup if the cursor is still in the field
you want to reverse. Once you move the cursor to another field
using the mouse or the keyboard, the change is saved. If you are
in a field where no changes have been made, Undo is disabled.

Field information can also be changed by selecting the field, then
choosing Cut, Copy or Paste from the Edit menu popup. For more
information about these options, refer to the Text Editor section of
the last chapter.
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Adding New Records

Records can be added between existing records or at the end of a
database file. To add a new record to the end of a database file,
choose Append Record from the Browse menu popup (or press
Ctrl+N). An empty record is added to the end of your records in
the Browse window. The cursor is positioned in the first field of
the empty record. You can type the necessary information.

You can also add a record to the end of a database by choosing
Append from the Record menu popup. The Browse window ap-
pears in Append mode with an empty record at the end of the
database. The fields in the new record are listed one below the
other. Type in the information. You can return to Browse mode
by choosing Browse from the Browse menu popup.

To add a new record below the selected record, type INSERT in the
Command window. The database appears in Insert mode and dis-
plays the records previous to the insertion point and an empty
record. Fields in each record are listed one below the other instead
of side-by-side. Type the information in the appropriate spaces.
To insert another record, press Enter when positioned in the last
field of the new record.

When in Insert mode, you can display records in Browse mode by
choosing Browse from the Browse menu popup. When in insert
mode, only inserted records and the records previous to the inser-
tion point will appear.

Deleting Records

When you mark a record for deletion in the Browse window, it
remains in your database file. To permanently remove marked
records from the actual database file, choose Pack from the
Database menu popup. You may recall a record that has been
marked for deletion in the Browse window as long as the database
file has not been packed.
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To delete a record using the mouse, position the pointer to the
immediate left of the record that you want to delete, then click. A
bullet appears next to the record, indicating that it is marked for
deletion.

CUSTOMER
Cust_id|Company Contact Address1

600888 |[DataTech Inc. 488 Uillage St.

0000881 |L.H.H.F. of AmMerica|Shelby T. Chapman, Pres|3222 Dodds Auenue
808882 |Traditional Craft |Helen Smith 18B Seuing Circle
8808003 |Film Co. Mark Davidson, Ouner 13 King Circle
088884 |Stylistic Inc. D. Wilson 36 Park Avenue

Pirate Software Rick D. Bruther 3 High—-Ho Blud.

|N!g!é

1\

Record Marked for Deletion

You can continue to mark any other records that you want to
delete in this manner. If you decide (before you pack the database
file) that you want to keep a record that’s been marked for
deletion, click on the bullet in front of the record and the bullet
disappears.

To delete a record using the keyboard, make sure that the ap-
propriate record is selected and choose Toggle Delete from the
Browse menu popup (or press Ctrl+T). A bullet appears to the left
of the record, marking it for deletion. If you decide that you don’t
want to delete a record, select it and choose Toggle Delete from
the Browse menu popup again to remove the bullet.

It is a good idea to make a copy of your database file before
you pack. To permanently remove marked records from the
database, choose Pack from the Database menu popup.

A pack may be interrupted by pressing the Escape key. Pressing
Escape stops the pack and the database file remains unchanged.
If you run out of disk space during a pack, FoxPro automatically
recovers the database.

Calculated Fields
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Through the Command window or a program file, you can create
calculated fields for display in the Browse window. With calcu-
lated fields, you can determine what value will appear in an exist-
ing field by defining a field expression. For example, if you had
several test grades in a database and a total points field, you could
make the total points field a calculated field by creating an expres-
sion to add the test grades together.
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Once you define a calculated field, the field can’t be edited in the
Browse window. However, if you change the contents of any fields
that are part of the calculated expression, these changes are auto-
matically reflected in the calculated field.

To create calculated fields, use the BROWSE FIELDS command in
the Command window. In this command, you must list any field
names from the current database that you want to be displayed in
the Browse window, as well as field names and expressions for the
calculated fields. Your command will appear similar to the follow-
ing:

BROWSE FIEIDS <fieldl>, <field2>, <field3>, < .. >, <field\®>

Each <«field> is the name of a field from the current database, and
may be part of an expression for a calculated field. The following
example opens a Browse window that contains fields for NAME,
DAILY_PAY, DAYS and TOTAL_PAY (which is calculated field).

BROWSE FIEIDS NAME, DATLY PAY, DAYS, TOTAL PAY=DATLY PAY*DAYS

Returning to an Open Window

It is not necessary to close a Browse window in order to open
another Browse window for a different database.

The names of all the open Browse windows are added to the bot-
tom of the Window menu popup. To return to an open Browse
window, choose its name from the Window menu popup. It ap-
pears as the frontmost (active) window on your screen. You can
return to any Browse window in this manner as long as the as-
sociated database has not been closed.

You can also move different open windows to the front, including
Browse windows, by choosing Cycle from the Window menu popup
(or pressing Ctrl+F1).

Closing the Browse Window

To close a Browse window, click the close box or choose Close from
the File menu popup. If the View window was open when you
opened Browse, it remains open so you can continue to work with
database files and set FoxPro options.
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Append From...

Add records from another database

Append From... adds records to the active database from another
database. Choose Append From... to display the Append From
dialog.

Append From:

< Fronm... > [ 1 Scope...
[ |
[ 1 For...
TYPE: Database ]
[ 1 While...
« OK » < Cancel > [ 1 Fields...

Append From Dialog

If you know the name of the database you want to copy records
from, type its name in the text box. Otherwise, choose the From...
push button to display a Directory dialog. Select the desired file
from the list, then choose OK.

The From... data file does not have to be a .DBF file. You can
specify other file types to copy records from using the Type popup
in the Append From dialog.

Database A standard FoxPro database file.

Delimited A text file in which each field is separated by one
with Tabs Tab.

Delimited A text file in which each field is separated by one

with Commas comma.

Delimited A text file in which each field is separated by one
with Spaces space.

System Data A text file in which the records have a fixed

Format (SDF) length and end with a carriage return and line
feed.
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Symbolic
Link Format
(SYLK)

Data
Interchange
Format (DIF)

Microsoft
Excel (2.0)
(XLS)

Microsoft

Append From...

A Symbolic Link interchange format in which
columns become fields and rows become records.
SYLK files have no extension by default.

A Data Interchange Format in which vectors
(columns) become fields and tuples (rows) become
records in the FoxPro database. DIF files have a
default extension of .DIF.

A Microsoft Excel (version 2) spreadsheet format
in which column cells become fields and rows be-
come records. These files have an .XLS extension.

A Microsoft Multiplan (version 4.x) BIFF (Binary

Multiplan (4.01) File Format) document in which spreadsheet rows

(MOD)

become records and spreadsheet cells become
fields. These files have an .MOD extension.

Symphony (1.0) A Symphony (versions 1.0 and 1.01) spreadsheet.

(WRK)

Symphony
(1.1/1.2)(WR1)

Lotus 1-2-3
(1A)(WKS)

Lotus 1-2-3
(2.x)(WK1)

Lotus 1-2-3
(3.0)(WKS3)

Paradox (3.5)
(PDOX)

Database Menu

These files have a .WRK extension.

A Symphony (versions 1.1 and 1.2) spreadsheet.
These files have a .WR1 extension.

A Lotus 1-2-3 (release 1-A) spreadsheet format in
which column cells become fields and rows become

records. A .WKS extension is assigned to these
files.

A Lotus 1-2-3 (release 2.xx) spreadsheet format in
which column cells become fields and rows become
records. A .WK1 extension is assigned to these
files.

A Lotus 1-2-3 (release 3.0) spreadsheet format in
which column cells become fields and rows become
records. These files have a .WK3 extension.

A Paradox (version 3.5) database file.
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RapidFile (1.2) A RapidFile database file.
(RPD)

Framework Il A Framework II spreadsheet.
(FW2)

Scope, For and While

G5-24

The check boxes at the right of the Append From dialog allow you
to establish Scope, For and While clauses. Whenever FoxPro
operates on records in a database, you usually need to specify
which records will be affected by specifying Scope, For and/or
While.

Scope

Scope tells FoxPro to act on certain records in the current
database. You can choose one of the following as the scope:

All The action affects all records in the database.

Next The action affects a range of records beginning with
the current record and continuing for the number of
records you specify in the text box by Next. Next 1
acts on the current record.

Record The action affects only the database record number
that you specify in the text.

Rest The action affects a range of records beginning with
the current record and ending with the last record in
the file.

For and While Expressions

The range of an action can also be specified using a For and/or
While expression.

To specify a For expression, check For... and create the logical ex-
pression that every record must meet to be affected by the com-
mand. Every record in the database is tested using the For ex-
pression.

The While expression specifies that the action affects database
records only as long as the logical expression evaluates to true.
The first time the expression evaluates to false, the action ceases
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without considering any remaining database records. To create a
While expression, check While... and use the Expression Builder.

Scope, For expressions and While expressions can be used
together. When For and While are both specified, the While ex-
pression takes precedence.

Specifying Fields

You can also specify fields to append. Choose the Fields... check
box and the Field Picker dialog appears. For more information
about the Field Picker, refer to Setup in this chapter.

When you are ready to append records, choose OK. To exit the
dialog without taking action, choose Cancel or press Escape.

Copy To...

Copy the contents of a database

Copy To... displays the Copy To dialog.

Copy To:
< Save As... > [ 1 Scope...
I |
[ 1 For...
TYPE: Database “
[ 1 Uhile...
« OK » < Cancel > [ 1 Fields...

Copy To Dialog

In this dialog, you can set the conditions that records must meet to
be copied from the open data file to a new file. Type a name for
the new file in the text box, or choose the Save As... push button
to display a Save As dialog. In the Save As dialog, you can specify
the directory where the new file will be stored and name the file.

If you Copy To... an existing file its contents will be replaced.
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You can also choose a type for the new file. The following file
types are available on the Type popup in the Copy To dialog:

Database A standard FoxPro database file.

Delimited A text file in which each field is separated by one
with Tabs Tab.

Delimited A text file in which each field is separated by one
with Commas comma.

Delimited A text file in which each field is separated by one
with Spaces space.

System Data A text file in which the records have a fixed
Format (SDF) length and end with a carriage return and line

feed.
Symbolic A Symbolic Link interchange format in which
Link Format columns become fields and rows become records.
(SYLK) SYLK files have no extension by default.
Data A Data Interchange Format in which vectors

Interchange  (columns) become fields and tuples (rows) become
Format (DIF)  records in the FoxPro database. DIF files have a
default extension of .DIF.

Microsoft A Microsoft Excel (version 2) spreadsheet format
Excel (2.0) in which column cells become fields and rows be-
(XLS) come records. These files have an .XLS extension.

Microsoft A Microsoft Multiplan (version 4.x) BIFF (Binary
Multiplan (4.01) File Format) document in which spreadsheet rows
(MOD) become records and spreadsheet cells become

fields. These files have an .MOD extension.

Symphony (1.0) A Symphony (versions 1.0 and 1.01) spreadsheet.
(WRK) These files have a .WRK extension.

Symphony A Symphony (versions 1.1 and 1.2) spreadsheet.
(1.1/1.2)(WR1) These files have a .WR1 extension.
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Lotus 1-2-3 A Lotus 1-2-3 (release 1-A) spreadsheet format in
(1A)(WKS) which column cells become fields and rows become
records. A .WKS extension is assigned to these

files.
Lotus 1-2-3 A Lotus 1-2-3 (release 2.xx) spreadsheet format in
(2.x)(WK1) which column cells become fields and rows become
records. A .WK1 extension is assigned to these
files.

The check boxes on the right of the Copy To dialog allow you to
establish Scope, For and While clauses. For a discussion of Scope,
For and While, refer to Append From in this chapter.

Choose the Fields... check box to display the Field Picker dialog.
In the Field Picker, you can specify fields to be copied from any
open database to the new file. For more information about the
Field Picker, refer to Setup in this chapter. For information about
establishing relations, refer to View in the Window Menu chapter
of this manual.

When you are ready to copy records, choose OK. To exit the dialog
without taking action, choose Cancel.
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Sort...
Sort a database
Sort... creates a new sorted database from an existing database.
Choose this option to display the Sort dialog.
Database Fields: Sort Order:
INVOICE N 5 3] < Move =+ > 3
INU_DATE D 8 e k3
CUST_ID C 6 (3] < Remove > $
CONTACT C 30 (3] 3
COMPANY Cc 38 2] Field Options k
ADDRESS1 c 38 8 Bl (> Ascending k4
CITY C 208 8 Bl C > Descending : 2
STATE c 2 @ BIL 1 Ignore Case ||$
ZIP Cc 18 8 Mt k2
Database: Input Output
[ 1 Scope... < Save fAs... > [ 1 Fields... « OK »
INUOICE " [ 1 For...
| [ 1 While... | ] | < Cancel >
Sort Dialog

The upper portion of the Sort dialog resembles the Field Picker
dialog. This integrated Field Picker, when used with the Field Op-
tions box in the center, allows you to select which fields you will
sort on and whether the fields will be sorted in ascending or des-
cending order.

The Database Fields list displays the fields in the current
database. To the right of each field name is a letter designating
the type of field (Character, Numeric, Date, Logical, Float or
Memo), followed by the size of the field and the number of decimal
places. Memo fields are disabled because you cannot sort on this
type of field.
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Numeric vs. Character Sorts

Numeric and character fields are treated differently when data is
entered into them and this difference affects the way a database
sorts:

® Numeric fields fill from right to left, with empty spaces to the
left.

® Character fields fill from left to right, with empty spaces to
the right.

Character type fields that contain all numbers and spaces do not
sort the way you might expect. For example, the number 1724
would precede the number 18 in a sort in ascending order unless
the lower number is preceded with leading zeros (0018). Because
the computer reads the ASCII codes in character fields from left to
right, and because 17 (in 1724) is less than 18 (in 18), it puts 1724
first. To avoid this problem, always precede lower numbers with
leading zeros or make the field a numeric type.

Specifying Sort Fields

Choose the fields you will sort on from the Database Fields list. If
you want records beginning with upper- and lower-case letters to
be sorted together, check the Ignore Case check box. If Ignore
Case is not checked, all records beginning with upper-case letters
will sort first, followed by records beginning with lower-case let-
ters. Choose ASCII Chart from the System menu popup to see the
sort order of all characters.

Your fields should appear in decreasing order of importance — the
most important field should be first. You can easily change the
order of your fields by dragging the double-headed arrow next to a
field to the desired location in the list.

Below the Database Fields list is the Database popup. This popup
displays the names of all active databases. If only one database is
open, the popup is disabled. You can create a new, sorted
database with fields from many databases. For the new database
to have any meaning, you must first relate all the databases that
you plan to use. For information about setting relations, refer to
View in the Window Menu chapter.

You can also specify Scope, For and While clauses to determine
which records will be included in the new database. For a discus-
sion of Scope, For and While, refer to Append From in this chap-
ter.
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Total...

After you choose the appropriate Sort Order fields, you may want
to specify certain fields to appear in the sorted output file. To do
this, choose the Fields... check box and select the fields that will
appear in the output file.

When you are satisfied with the fields in the Sort Order list,
choose OK. Now, type a name for the output file in the text box
below the Save As... push button, or choose Save As... and type a
name for the output file, and then choose Save.

When you are ready to sort the database according to your
specifications, choose OK.

Compute totals for numeric fields
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Total... computes numeric field totals for records in the active
database. These totals are placed into corresponding fields in a
new database. When you choose this option, the Total dialog ap-
pears.

TOTAL ON:
»CUST_ID C [ 1 Scope...
COMPANY c
CONTACT C [ 1 For...
ADDRESS1 c
ADDRESS2 c [ 1 While...
CITY C
STATE c [ ] Fields...
<Expr... > | ]
« OK »
<{Save fs...>
[ | < cancel >
|

Total Dialog

The list contains the fields in the active database. In order to
total, you must enter a field or an expression on which to total in
the text box next to Expr.... Choose one of the fields from the list,
type a field or an expression in the text box, or choose Expr... and
create the expression to total. The database should either be
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sorted on the field you use in the expression or controlled by an
index based on the field or expression you specify.

You can also define Scope, For and While clauses to specify condi-
tions that records must meet to be totaled. If you check the
Fields... check box, the Field Picker dialog appears so you can
specify fields on which to total. All records will be totaled unless
you define a Scope, For or While clause. All numeric fields are
totaled unless you specify certain Fields.... For a discussion of
Scope, For and While, refer to Append From in this chapter. The
Field Picker is described in Setup in this chapter.

Type a name for the destination database file in the text box, or
choose Save As... to display the Save As dialog so you can type a
file name. The new database will include a record for each unique
expression value encountered in the active database that meets
conditions set by your Scope, For and While clauses.

Choose OK to compute the totals. To exit the dialog without
taking action, choose Cancel.

Average...

Compute the average for numeric expressions

Average... displays the Average dialog so you can compute the
average for a numeric expression.

Average: Memory Uariables:

L 1 Expr...

[ 1 Scope... « OK »
L 1 For... < Cancel >
[ 1 UWhile...

To Uariable:l |

Average Dialog
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In the Average dialog, you can specify an expression to average
selected numeric fields in the current database, or you can average
all numeric fields in the database separately. To average fields
separately, specify any necessary Scope, For and While conditions
by checking the appropriate check boxes. When you're ready to
average, choose OK.

To create an expression on which to average, check the Expr...
check box and enter an appropriate expression in the Expression
Builder. In the Expression Builder, you can build an expression
using fields from related databases. Choose a new database from
the Database popup when necessary. For information on relating
databases, refer to View in the Window Menu chapter.

All records in the database will be averaged unless you specify a
Scope, For and/or While condition. For a discussion of Scope, For
and While, refer to Append From in this chapter.

When you create an expression to average on, you can store the
results of the Average operation in an existing or new memory
variable. Just choose the existing variable from the Memory
Variables list or type a name for the new variable in the text box.
If you SET TALK ON, the results also appear in the current output
window.

Choose OK to compute the average. To exit the dialog without
taking action, choose Cancel.
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Count...

Count database records

Count... returns a count of the records in the active database that
fall within a specified scope. Choose this option to display the
Count dialog.

Count: Memory Variables:
[ 1 Scope...

« OK »
[ 1 For...

< Cancel >
[ 1 UWhile...

To Variable: [ I

Count Dialog

In this dialog, specify Scope, For and/or While clauses by checking
the appropriate check boxes. The Expression Builder appears so
you can create the clause. FoxPro counts the records that meet
the Scope, For and/or While condition. The default Scope is All. If
you don’t specify For or While, all records in the Scope are
counted. For a discussion of Scope, For and While, refer to Append
From in this chapter.

Records marked for deletion are counted if you SET DELETED OFF.
If you SET TALK ON, the message:

nnnnnNn records

appears on the current output screen to tell you the number of
records in the active database that meet the specified conditions.

You can also place the count results in a new or existing memory
variable. To place the results in an existing memory variable,
choose the desired variable from the Memory Variables list so that
it appears in the text box. To place the results in a new memory
variable, type a new variable name in the text box.

Choose OK to count the records. To exit the dialog without taking
action, choose Cancel.
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Sum...

Calculate the sum of numeric fields
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Sum... displays the Sum dialog so you can add the contents of
numeric field variables in the active database.

Sum: Memory Variables:

[ 1 Expr...

[ 1 Scope... « OK »
L 1 For... < Cancel >
L 1 UWhile...

To Variable: r ]

Sum Dialog

In the Sum dialog, you can specify an expression to add selected
numeric fields in the current database, or you can add all numeric
fields in the database separately. To add fields separately, specify
any necessary Scope, For and While conditions by checking the
desired check boxes. When you'’re ready to sum, choose OK.

To create an expression on which to sum, check the Expr... check
box and enter an appropriate expression in the Expression Builder.
For more information on the Expression Builder, refer to New in
the File Menu chapter.

All records in the database will be summed unless you specify a
Scope, For and/or While condition. For a discussion of Scope, For
and While, refer to Append From in this chapter.

When you create an expression to sum, you can store the results of
the Sum operation in an existing or new memory variable. Just
choose the existing variable from the Memory Variables list or
type a name for the new variable in the text box. If you SET TALK
ON, the results also appear in the current output window.

Choose OK to calculate the sum. To exit the dialog without taking
action, choose Cancel.
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Calculate...

Perform financial and statistical operations

Calculate... displays the Calculate dialog so you can perform finan-
cial and statistical operations on fields in a database or on expres-
sions involving fields.

Calculate: Memory Uariables:

[ 1 Expr...

[ 1 Scope... « OK »
[ 1 For... < Cancel >
[ 1 While...

To Variable: :]

Calculate Dialog

To create the expression to calculate, check the Expr... check box.
A special Expression Builder dialog appears. This Expression
Builder contains only one popup, Math, with a limited number of
options.

Build an expression using the desired databases, fields, memory
variables and the functions from the Math popup. You can string
several expressions together using commas. If you string expres-
sions, you must string together an equal number of memory vari-
ables to hold the calculated results, or refrain from using memory
variables in the dialog.

The Math popup contains the following options:

AVG() Computes the arithmetic mean of a database field or
field expression.

CNT() Returns the number of records in a database.

MAX() Returns the largest value of a database field.

MIN() Returns the smallest value of a database field.
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NPV(,,) Computes the net present value of a series of future
cash flows discounted at a constant periodic interest
rate.

STD() Computes the standard deviation of the values in a
field or field expression.

SUM() Totals the values in a field or field expression.

VAR() Computes the variation from the average of a field or

legitimate field expression.

For more details about these menu options and about concatenat-
ing, refer to CALCULATE in the FoxPro Commands & Functions
manual.

You can also specify Scope, For and While conditions to indicate
which records will be involved in the calculation. Check the ap-
propriate check boxes. For a discussion of Scope, For and While,
refer to Append From in this chapter.

If you want to store the results of the calculation in an existing or
new memory variable, choose the existing variable from the
Memory Variables list or type the new variable name in the text
box. If you decide to use memory variables and you concatenate
several expressions together, be sure to concatenate an equal num-
ber of memory variables together in the text box below the
Memory Variables list.

When you are ready to calculate, choose OK. To exit the dialog
without taking action, choose Cancel.
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Report...

Display and print reports

Report... brings forward the Report dialog so you can display or
print reports from the selected database using a predefined report

definition file.
Report:
<Form... > [X] Environment [ 1 Scope...
I 1 [ 1 For...
[ 1 While...
[ 1 Plain
[ 1 No Eject
[ 1 SummMary
[ 1 Heading | ]
L 1 To Print
L 1 To File « OK »
[ 1 Previeu
(+) Console On C > Console Off < Cancel >

Report Dialog

Report files are created using the FoxPro Report Writer and are
saved to disk with the default extension of .FRX.

Type the name of the desired report file in the text box, or choose
Form... and select the appropriate file from the Open File dialog
that appears. :

All records in the active database are included in the report unless
you specify a Scope, For and/or While condition. For a discussion
of Scope, For and While, refer to Append From in this chapter.

When you create a new report, you can save environment settings
in an .FRX database. Saving the report environment is explained
in the Report Writer chapter of this manual. All information
about the report is stored in fields in this .FRX database. The .FRX
file contains work area information as well as all the settings in
the On/Off, Files and Misc panels of the View window.

To restore the saved environment before running the report, check
the Environment check box in the Report dialog. If you don’t want
to restore the settings, make sure Environment is not checked.
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Report...
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In addition to Scope, For and While, the Report dialog contains the
following check boxes:

Plain

No Eject

Summary

Heading

To Print
To File

Preview

Prints the report without page headers on each page.
A page header appears only on the first page of the
report.

Suppresses the initial form feed to the printer prior to
printing the report.

Prints only data in the Summary band of the report.
Allows you to specify an additional heading line to
print on each page of the report. Type the additional
line in the text box.

Sends the report to the designated printer.

Sends the report to an ASCII file.

Allows you to view your report before you print it.

Two radio buttons are located at the bottom of the Report dialog:

Console On

Console Off

Displays the report on your screen while it runs.
When you are printing a report, it is a good idea
to choose the Console Off radio button because
your report will run faster.

Stops the report from displaying on your screen
while it runs. This makes your report run faster.

When your conditions and settings are correct, choose OK to begin

running the

report. If you change your mind and want to leave

the dialog without taking any action, choose Cancel.
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Label...

Label...

Print labels

Label... displays the Label dialog so you can produce labels using
predefined label formats. Labels created in FoxPro have an .LBX
extension.

Label:

<Form... > [X1 Environment [ 1 Scope...
| ] 1 For...
[ 1 UWhile...

Lo}

] Sample

] To Print « OK »
1 To File| ]

) Console On ( ) Console Off < Cancel >

[
L
[
C

Label Dialog

As in the Report dialog, type into the text box the name of the
label file that you want to use, or choose Form... and select the
appropriate file from the Open File dialog that appears.

If you don’t specify Scope, For and/or While conditions, all records
in the active database file are used. For a discussion of Scope, For
and While, refer to Append From in this chapter.

When you create a label, you can save environment settings in an
.LBX database. Saving the label environment is explained in New
in the File Menu chapter of this manual. The .LBX file contains
work area information as well as all the settings in the On/Off,
Files and Misc panels of the View window.

To restore the saved environment before running the labels, check
the Environment check box in the Label dialog. If you don’t want
to restore the settings, make sure Environment is not checked.
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Label...

In addition to Scope, For and While, the Label dialog contains the
following check boxes:

Sample Prints a sample label to test the alignment of your
printer. The sample label contains asterisks to show
the size and placement of fields on the label.

After the sample is printed, a dialog appears and asks
“Do you want more samples?” Choose Yes to print
another sample. This dialog will keep appearing after
it prints the sample, allowing you to make adjust-
ments. When the labels are aligned, choose Do
Labels to run the labels. Choosing Cancel exits the
dialog without taking action.

To Print Sends the labels to the designated printer. If you
don’t check To Print, the labels are displayed on the
screen only.

To File Stores labels in an ASCII file.
Two radio buttons are located at the bottom of the Label dialog:

Console On Displays the labels on your screen while they run.
When you are printing labels, it is a good idea to
choose the Console Off radio button because your
labels will run faster.

Console Off Stops the labels from displaying on your screen
while they run. This makes your labels run
faster.

When your conditions and settings are correct, choose OK to run
the labels (or choose Do Labels as described above if you have
printed samples). To leave the dialog without taking any action,
choose Cancel.
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Pack

Pack

Erase records marked for deletion

O

Reindex

Pack permanently removes all records from the active database
that have been marked for deletion. Before you pack a database,
make a backup copy. All open index files associated with the
database are rebuilt automatically when the database is packed.

A pack may be interrupted by pressing the Escape key. Pressing
Escape stops the pack and the file remains unchanged. If you run
out of disk space during a pack, FoxPro automatically recovers the
database.

There is no way to retrieve deleted records after the PACK is
finished. The deleted records are gone forever.

Deleting individual records from a database is described in Browse
in the Database Menu chapter. For information about marking
records for deletion that meet a certain condition, refer to Delete in
the Record Menu chapter of this manual.

Rebuild active index files

Reindex rebuilds any open index files associated with the active
database. Occasionally, index files become corrupted. Choose
Reindex to reconstruct any index files that do not accurately
reflect the current status of the database.
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6 Record Menu

Record menu options are for use with the records in your
databases. The Record menu pad is disabled unless a database is
open in a selected work area.

Append
Change

Goto...
Locate...
Continue "K
Seek. ..

Replace...
Delete...
Recall...

Record Menu
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Append

Append

Add records

Append allows you to add blank records to the end of the active
database. Choose this option to display an input/editing window
that contains the current database with a blank record at the end.
You can enter data into the fields in this record. When you enter
data in the last field and press Enter, another blank record is
added to the end of the database. If a valid format file (.FMT) is
set for the current database, the input screen specified by that file
appears. If no format is set, the input window appears in default
layout — the fields for each record are displayed one below the
other in the window. The » symbol indicates you are in Append
mode.

CUSTOMER

>Cust_id
b>Company
b>Contact
b>Address1

G6-2

Browse Window in Append Mode

When in Append mode, a Browse menu pad is added to the menu
bar. Append mode is just the Browse window in a different form.
The first option on the Browse menu popup changes from Append
to Browse, depending on the mode you are in. When you are in
Append mode, Browse appears on the Browse menu. At any time
you can choose Browse and continue your changes in Browse
mode.

When you finish, choose Close from the File menu popup or click
the close box. For more information, refer to Browse in the
Database Menu chapter of this manual.
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Change

Change

Edit database records

Change allows you to edit data in the active database. Choose
this option to display an input/editing window that contains the
records in your database. If a valid format file ((FMT) is set for the
current database, the input screen specified by that file appears.
If no format is set, the input window appears in the default layout
— the fields for each record are displayed one below the other in
the window.

CUSTOMER
Cust_id
Company
Contact
Address1
Address2
City
State

Zip
Taxrate
Comments (0T

Browse Window in Change Mode

When in Change mode, a Browse menu pad is added to the menu
bar. Change mode is just the Browse window in a different form.
The first option on the Browse menu popup switches from Change
to Browse, depending on the mode you are in. At any time you
can choose Browse and continue your changes in Browse mode.

When you finish, choose Close from the File menu popup or click
the close box. For more information about this option or the
Browse menu popup, refer to Browse in the Database Menu chap-
ter of this manual.
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Goto...

Goto...

Position the record pointer

Goto... displays the record pointer on a specific record in the

selected database.
(> Top
C ) Bottom « Goto »
C ) Record < Cancel >
C ) Skip

Goto Dialog

In this dialog, specify one of the following locations in the database
where you want the pointer to be positioned.

Top Positions the pointer on the first record in the
database.

Bottom Positions the pointer on the last record in the
database.

Record Displays a text box so you can type the record number
you would like to position on.

Skip Displays a text box so you can type the number of
records you want to move forward from the current
record position before FoxPro positions the pointer.

When you are ready to position the pointer, choose Goto. To exit
the dialog without taking action, choose Cancel or press Escape.
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Locate...

Locate...

Look for a database record

Locate... displays the Locate dialog so you can look for a record in
the active database that matches the specified conditions. Refer to
Append From in the Database Menu chapter for a discussion of
Scope, For and While.

[ 1 Scope...
« Locate »
[ 1 For...
< Cancel >
[ 1 While...

Locate Dialog

Choose the appropriate check box(es). If you choose Scope..., you
must choose the desired radio button in the Scope dialog that ap-
pears. The radio buttons in this dialog act the same as those in
the Goto dialog. If you choose For... or While..., create the neces-
sary expression in the Expression Builder.

When you are ready to look for a match, choose Locate. FoxPro
searches for a matching record, starting at the beginning of the
active database. If a matching record is found, the record pointer
is positioned on that record.

If no match is found, FoxPro positions the record pointer at the
end of the file or at the end of the specified scope.

To exit the dialog without taking action, choose Cancel or press
Escape.
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Continue

Continue

Continue to locate records

Seek...

Continue causes FoxPro to resume the previously specified
Locate.... This Locate... begins at the current position in the
database. Continue is disabled until you perform a Locate....

Search an indexed database
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Seek... displays the Expression Builder so you can search the ac-
tive database through its index. For Seek... to be enabled, the
active database must have an open index and the index order must
be set.

The expression you create in the Expression Builder must be based
on the field that your database is indexed on. You must enclose
character strings in single quotes (* ’), double quotes (* ”) or
brackets ([ 1).

After you create an expression and choose OK, FoxPro evaluates
the expression and looks for a matching value in the current index
file. If you open a Browse window for the database after you
choose Seek..., the record containing the matching value is
selected. If no matching value is found, the last record in the file
is selected.
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Replace...

Replace...

Update fields in database records

Replace... displays the Replace dialog so you can change field
information in one record or in a range of records.

Replace:
[ 1 Scope..
COMPANY
CONTACT [ 1 For...
ADDRESS1
ADDRESS?2 [ 1 While..
CITY
Database:
«Replace »
CUSTOMER “
< Cancel >
< With... > | ]

Replace Dialog

In the Replace dialog, you can select a field to be replaced from the
list. If more than one database is open, you can replace fields
from different databases by choosing the appropriate database
from the Database menu popup. The fields in the Replace list
change to reflect the contents of the new database.

Type a replacement expression in the text box or choose With to
display the Expression Builder and create a replacement expres-
sion. Specify any necessary Scope, For and/or While conditions.
The default value for Scope in the Replace dialog is Next 1. Scope,
For and While are described in Append From in the Database
Menu chapter of this manual.

When the replace information is correct, choose Replace to make
the replacement or Cancel to exit the dialog without taking action.
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Delete...

Delete...

Mark database records for deletion

G6-8

Delete... displays the Delete Record dialog so you can mark
records for deletion.

[ 1 Scope...
« Delete »
[ 1 For...
< Cancel >
[ 1 UWhile...

Delete Record Dialog

This option does not physically delete the records. Rather, it
marks the specified records for deletion in the future. To
permanently remove marked records, you must choose Pack from
the Database menu popup. It is a good idea to make a backup
copy of a database before you Pack it.

In the Delete Record dialog, you can specify Scope, For and/or
While conditions. All records that meet the specified condition(s)
are marked for deletion. The default value of Scope in the Delete
dialog is Next 1. For a discussion of Scope, For and While, refer to
Append From in the Database Menu chapter of this manual.

When you are ready to have FoxPro mark records for deletion,
choose Delete. If you want to exit the dialog without taking action,
choose Cancel or press Escape.
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Recall...

Recall...

Unmark records that are marked for deletion

Recall... displays the Recall dialog so you can unmark records that
are marked for deletion. This is possible because FoxPro does not
physically delete records until you choose Pack from the Database
menu popup.

L 1 Scope...
« Recall »
L 1 For...
< Cancel >
[ 1 UWhile...

Recall Dialog

In the Recall dialog, you can specify any Scope, For and/or While
conditions for the records you wish to recall. In the Recall dialog,
the default for Scope is Next 1. Scope, For and While are
described in the Append From section of the Database Menu chap-
ter.

When you are ready for FoxPro to recall the specified records that
are marked for deletion, choose Recall. If you want to exit the
dialog without taking action, choose Cancel or press Escape.
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7 Program Menu

Program menu options are used with FoxPro program files.

Do... “D

Cancel
Resume "M

Compile...
Generate...
FoxDoc

FoxGraph. ..

Program Menu
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Do...

Execute a program file

Do... displays a Do dialog so you can specify a program file to
execute.

Do Program File:

[..] Drive C ]
CREDITS. PRG

CSTLEDGR. PRG
CUSTLABE. PRG
CUSTLIST. PRG Directory | SAMPLE
CUSTMENU. PRG
CUSTOMER. PRG
CUSTSALE. PRG « Do »
INDEXER. PRG

< Cancel >
[ 1 All Files

Do Dialog

Select the program file you want to run from the list, then choose
Do.

When a program is running, FoxPro is not in interactive mode so
the menu bar is not displayed. To interrupt a program that is
running, press Escape. An alert appears.

00¢ INTERRUPTED e

« Cancel » < Suspend > < Ignore >

Choose Cancel to end program execution and close the program
file.  To restart the program you must choose Do... from the
Program menu popup.

Choose Suspend to stop running the program and return to the
interactive menu system. The program file remains open and you
can continue running the program by choosing Resume from the
Program menu popup.

Choose Ignore to restart program execution at the point it stopped.
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Cancel

Cancel
End execution of a program file
Cancel prematurely ends execution of a suspended FoxPro pro-
gram file. This option is enabled only after you choose Suspend to
pause program execution.
Resume
Restart a suspended program
Resume restarts execution of a suspended program at the line
where execution paused when you chose Suspend.
Compile.../Compile
Compile the specified file(s)
Compile... displays the Compile dialog so you can compile program
(.PRG), format (.FMT), menu (.MPR), screen (.SPR) and project (.QPR)
files.
Compile: — Options
[ 1 Encrypted
[..1] | [X]1 Debugging Information
ADDCLI. PRG Drv. c “ [ 1 Neu and Updated files only
ADDCRE. PRG
ADDFAM. PRG — Output to
ADDRES. PRG Dir. DEMO “ < Directory... >
APPOINT. PRG [
BROUSER. PRG
CABINET. PRG — Log Errors
CLIENT. PRG < Tag All > C > None
CLIENTS. PRG (> To .ERRs
CONTROLS. PRG < Tag None > (> To File [ 1 Append
CONUERT. PRG < File... >

[ 1 All Files
« Compile » < Cancel >

Compile Dialog
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Compile.../Compile

Compile...
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Select or multi-select the desired file(s) from the list in the Com-
pile dialog.

If you want to select all the file names in the list, choose Tag All.

If you select several file names and decide that you don’t want to
compile some of them, Shift+click or Shift+Spacebar on a file name
again to deselect it. You can deselect all of the file names in the
list by choosing Tag None.

Once you've selected the desired files, you can designate a direc-
tory where your output will be stored, a file where your error mes-
sages will be stored and other miscellaneous options. Refer to the
next sections for more information.

When you are ready to compile your file(s), choose Compile. To
exit the dialog without taking action, choose Cancel or press Es-
cape.

Compile Options

Three check boxes are located in the Options area:

Encrypted If you want your compiled files to be scrambled
for security, check the Encrypted check box.

Debugging When this check box is checked, you'll be able to

Information see each line of your program highlighted in the
Trace window during execution. For this to hap-
pen, FoxPro must include approximately two extra
bytes per source program line. These two bytes
are a reference to the corresponding program line
in the source code. When you uncheck this check
box then compile a program, you will not be able
to see each line highlighted in the Trace window
during execution.

New and Check this check box to compile only the selected
Updated Files files that are new or have been updated since they
Only were last compiled.
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Compile.../Compile

Specifying an Output Directory

To specify a directory path where your compiled output files will
be stored, type the path in the text box under Directory... in the
Output To area, or choose Directory... to display a Directory dialog
so you can choose the desired drive, directory and/or subdirec-
tories. When the path at the top of the dialog is correct, choose
Select.

Log Errors

Three radio buttons appear in the Log Errors portion of the dialog.
Choose the None radio button if you don’t want FoxPro to keep
track of your errors when your program is compiled.

Unless the None radio button is chosen, FoxPro keeps track of any
syntax errors when your file(s) are compiled. You can store these
error messages in one of two types of error files: a log file or an
.ERR file. You must decide which type of error file you want to
create because only one of these file types can be created each time
in the Compile dialog.

To store the error messages for each selected file in a separate file
with the same base name as the original file, choose the To .ERRs
radio button. An .ERR file is created for each file selected in the
list, and is stored in the same directory as the source file. Each
.ERR file has the same name as the associated source file, but has
an .ERR extension.

To store the error messages for all the selected files together in a
log file, choose the To File radio button. Type a name for the log
file in the text box next to File... or choose File... so you can enter a
name in the Save As dialog.

To add the error messages to an existing log file, specify the file
and check the Append check box

Compile

When any type of program file is open in a window, the Compile...
option on the Program menu popup appears as Compile. Compile
automatically compiles the current program file.

When FoxPro finds an error in the program code during compila-
tion, the erroneous line is highlighted in the editing window. A
dialog appears on the screen to alert you to the error. Choose
Ignore to ignore the current error and continue compilation.
Ignore All ignores the current error and any subsequent errors en-
countered during compilation. Cancel stops compilation.
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Generate...

If you SET LOGERRORS ON before choosing Compile, the error mes-
sages generated during compilation will be stored in an .ERR file
with the same base name as the source file.

Generate...

Generate code for screens/menus

For information on the Generate... option, refer to the section on
code generation in the Screen Builder chapter or the section on
code generation in the Menu Builder chapter.

FoxDoc
Document a system
FoxDoc displays the Document dialog and invokes FoxDoc, the
automatic application system documenter for FoxPro programs.
For more information about documenting programs with FoxDoc,
refer to the FoxPro Developer’s Guide.
FoxGraph...

Generate two- and three-dimensional graphs

FoxGraph... is disabled until you install FoxGraph on your hard
disk. FoxGraph, a separate graphics package that you can pur-
chase for use with FoxPro, allows you to create 2-D and 3-D
graphs from database files.

When you choose FoxGraph..., a dialog appears. Unless you check
the All Files check box, only files with .GR3, .GRF and .GR4 exten-
sions will appear in the list. These files contain graph descrip-
tions.

If you want to load a file containing a graph description, select the
file from the list and choose Load. A Graph Setup dialog appears
containing information from the graph description.

To create a new graph description, choose New. A Graph Setup
dialog appears so you can specify details about the graph.

FoxGraph invokes FoxGraph without asking you to specify a graph
description. The Graph Setup dialog is bypassed. Choose this
push button when you want to work with graphs that already
exist.
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FoxGraph...

To exit the FoxGraph dialog without taking action, choose Cancel
or press Escape.

For more information about FoxGraph, refer to the FoxGraph
Reference Manual that accompanies your FoxGraph package.
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8 Window Menu

Window menu options are used to control windows.

Window Menu

i [

Hide

Clear

Move “F?
Size “F8
Zoom “F10
Cycle “F1
Color...

Command "“F2
Debug
Trace
Uiew

Window Menu
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Hide

Hide

Removes the active window from the screen

Clear

Hide removes the active system or user-defined window from sight.
Hidden windows aren’t closed — they’re just not visible to you.
Hidden windows remain active. Their names are displayed at the
bottom of the Window menu popup.

Hide can be used repeatedly to remove windows from sight. To
hide or display all open windows at once, hold down the Shift key
while choosing the Window menu pad. The Hide option on the
Window menu is replaced with options that allow you to Hide All
and Show All windows.

You can momentarily hide all windows in front of the current out-
put window (which may be the screen) by holding down Shift+Ctrl
and pressing Alt.

To display a hidden window, choose its name from the bottom of
the Window menu popup.

If the hidden window is a system window (for example, View or
Command), you can display it by choosing it from the Window
menu popup or using its Control key shortcut. Even though you
choose Close from the File menu popup or click the close box, sys-
tem windows remain active until you exit FoxPro. For example,
open files will still be reflected in the View window and commands
will still be recorded in the Command window even if these win-
dows are hidden.

When you close a window, you must reopen it through the File
menu popup, the View window or the Command window.

Clear the output window
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Clear clears the current output window. If an output window is
not active when you choose Clear, the background screen is
cleared. The command equivalent for the Clear option is to type
CLEAR in the Command window.

The Clear option on the Edit menu popup clears selected text

from the active system window.
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Move

Move

Move window to a new location

Move selects the active window so you can move it to a new loca-
tion on your screen. When you choose Move, the border of the
current window flashes.

Use the arrow keys to move the window by small increments in
the appropriate direction. Press PgUp and PgDn to move the win-
dow to the top or bottom of the screen. Press Home and End to
move the window to the left or right edge of the screen. When
you're finished, press Enter. The window border stops flashing.

If your system is equipped with a mouse, you don’t need to use this
menu option. You can click on the window title and drag the win-
dow to the desired location.

Size

Size the active window

Size selects the active window so you can change its size. When
you choose Size, the border of the active window flashes. Press
the arrow keys to adjust the right and bottom borders of the win-
dow. When the window is the desired size, press Enter and the
window border stops flashing.

If your system is equipped with a mouse, you don’t need to use this
menu option. Instead, you can click on the size control in the
lower right corner of the window and drag to adjust the frame size.

All windows with size controls can be sized. All user-defined win-
dows that were defined with a GROW clause can also be sized.

Zoom T

Enlarge the active window

The Zoom T option on the Window menu popup acts as a toggle
between the current window size and full screen size.

If you are using a mouse, you can also enlarge and shrink windows
by clicking on the zoom control in the upper right corner of the
window.
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Zoom |

Zoom |

Minimize the active window

Cycle

Choosing Zoom | on the Window menu popup minimizes the cur-
rent window. The window becomes one line tall by 16 characters
wide with only the title of the window displayed.

You can also minimize the active window by double-clicking with
the mouse on the top border of the window.

The zoom control in the upper right corner and the close box in the
upper left corner of a minimized window show and are active even
if the window is not frontmost. Using the zoom control on a mini-
mized window will not bring the window forward.

To minimize the window and dock it in the lower right corner of
the screen, do one of the following:

® Hold down the Shift key and choose Zoom | from the window
menu popup.

® Hold down the Shift key and double-click the mouse on the
top border of the window.

Reducing a window to a minimum size makes it easy to place
many windows on the screen or in a window simultaneously and
still have ample space for output. For example, you could reduce
FoxPro desk accessories (the Calculator, the Calendar/Diary, the
ASCII Chart, and so on) to their minimum size and place them
along the bottom row of the screen for easy access and use.

To return a minimized window to its original size, do one of the
following:

® Choose Zoom | from the Window menu popup.

® Double-click with the mouse on the top border of the window.

Rearrange open windows to bring successive ones forward
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Cycle rearranges open windows to bring successive ones to the
front. When you choose Cycle, the active window moves to the
back and the next window that was originally opened becomes the
active window. Continue to choose Cycle until the window of your
choice is frontmost.
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Color...

Color...

Adjust colors in windows and dialogs

Color... displays the Color Picker dialog. In this dialog, you can
fully control the colors in FoxPro menus, popups, windows, dialogs,
alerts and more. Users with monochrome monitors can adjust the
intensity and contrast of the screen display.

There is no need to modify colors unless you are unable to see all
of the details in a window or dialog. If the Report Layout window
and the Browse window display properly, you should not modify
your colors. If you have trouble seeing any details in the Report
Layout window or the Browse window, many predefined color sets
are available for you to load.

A color set consists of color assignments for all the options, or color
schemes, on the popup in the upper right corner of the Color
Picker.

12:23:45 pu <«—C ) 7 Clock
CUSTOMER NAME <——( ) 2 GET field User Winds I]
Command <+—( > 5 Title, idle
DO myprogy Trace E <+—( ) 4 Title, active « 0K »
1,16 GET custome “—(+) 1 7 & SAY field
READ 4—C( ) b Selected item < Cancel >
<{Cancel> <Resumed> 4—C( ) 9 Enabled ctrl. _—
< Load... >
<4—( > 8 Shadou
«Topics» <Next) <{Previous) <«—( )> 10 Dsabl’d ctrl. < Save... >
<+—(C > 3 Border
[ 1 Casts a shadou? < Help >
| Ex R x W xExExExExExExPExOExPxMxPx®«N
[ x N ExEXExExExExExEXEXEXEXE X QB xQX
[ xExN EXExEExXExExExXEXE B xE xR xQX
[ x WxExN ExExExExExExExExExExE Qx|
HEBHEHBBEBEBEBEBEBEBEBEBEEBEEIE [ Bight
HEEBEEPEAEEREEEEEEREEBEEEERER
[ xEx B xExXExExN ExExExExExE<ExExOx|
(R R PR PXPX) QXYPXPXEXPX QX P XQX]

Color Picker Dialog
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Color...

Loading Color Sets

Choose the Load... push button to see the list of available color
sets. There is probably one for your computer. If not, choose a
color set for a similar computer and choose Load. Choose OK to
exit the Color Picker and try the new color set. Choose Clear from
the Window menu popup. If the color set is not suitable, load
another color set. Continue to load and try out color sets until you
find the best colors for your computer.

Modifying Color Sets
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If none of the predefined color sets are suitable, you can modify the
color set in the Color Picker dialog that most closely corresponds to
your needs. Before making changes, you should understand that
changing colors is similar to defining a printer driver. Many sub-
tle relationships exist and you must keep these in mind when you
make color choices.

If you want to make major changes to a color set or define an
entirely new set, refer to the FoxPro Developer’s Guide. If you
modify a color set, you should save it under a new name to
preserve the original color set.

A color palette is located in the lower left portion of the Color Pick-
er. The color palette contains a wide range of color pairs from
which you can choose. A color pair is a foreground and back-
ground color combination. In the color palette, each X represents a
foreground color and the block behind it represents the associated
background color.

You may assign a color pair to each of the ten radio buttons in the
Color Picker dialog.

Only radio buttons with text labels have an effect on the
interface colors.

Before you assign color pairs, you must choose the appropriate op-
tion from the popup in the upper right corner of the Color Picker.
Each menu option represents an interface element like windows,
dialogs, popups, and so on. Use the radio buttons to assign color
pairs for each interface element.
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Color...

When you choose an option (scheme) from the popup in the Color
Picker, the names of the radio buttons change to reflect their func-
tion in the current scheme. If a radio button has no effect in a
scheme, the color pair number appears with no name next to it.
You should coordinate the color pairs of certain radio buttons to
achieve visual clarity. Refer to the FoxPro Developer’s Guide for
rules to follow when assigning color pairs.

All of the menu options, or color schemes, combine to make a com-
plete color set for use with FoxPro. You can use different color
sets for different purposes.

Assigning Colors
Choose an option from the popup so that you can determine its

colors.
Color Picker Menu Options
Option Description
User Winds User windows (SET colors)
User Menus User menus (SET colors)
Menu Bar Menu pads on the system menu bar
Menu Pops Menu popups
Dialogs Dialogs and system messages
Dialog Pops Popups and lists in dialogs
Alerts Alerts
Windows System windows
Window Pops Menu popups and lists in windows
Browse Browse window
Report Report Layout window
Alert Pops Lists in alerts created with the Screen
Builder
Scheme 13-16 Reserved
Scheme 17-24 Available for user applications

The option you choose appears on the popup. All color choices you
make apply to the option displayed on the popup.

Window Menu G8-7



Color...

G8-8

Once you've chosen an option from the popup, you can assign a
color pair to each radio button. To do this, choose a radio button
by clicking with the mouse, or Tabbing to the radio button and
pressing the Spacebar. The current color pair for that radio button
appears selected in the color palette.

If you need to modify the color pair, choose a new color pair from
the color palette. With the mouse, click on the desired color pair.
With the keyboard, use the arrow keys to move to the desired color
pair, then press the Spacebar.

Use the following check boxes as necessary to complete your color
scheme.

Casts a Displays FoxPro shadows for the interface element on

Shadow ? the popup in the upper right corner of the Color
Picker. Make sure the desired interface element ap-
pears on the popup before you check the Casts a
Shadow ? check box to indicate that you want
shadows.

Bright Intensifies the background color associated with the
current radio button. When you check Bright, 128
new color pairs become available if your monitor is
EGA/VGA. If you have a color monitor and don’t see
the Bright check box, type SET BLINK OFF in the
Command window and the check box appears in the
Color Picker. This check box is not available on
monochrome monitors.

Blink Causes objects associated with the chosen radio but-
ton to blink. Blink settings are saved with your color
sets. If you don’t see the Blink check box, type SET
BLINK ON in the Command window and the check
box appears in the Color Picker dialog.

Continue to choose radio buttons and assign color pairs until all of
the colors are properly adjusted for the current color scheme (dis-
played on the popup).

Repeat this entire process for each option on the popup until you
are satisfied with the color assignments. Together, all the menu
options (color schemes) make up a complete color set.
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Copying Color Schemes

When you want to use the same colors from one color scheme in
another color scheme, you can copy and paste the color pair assign-
ments. First, choose the color scheme with the desired colors from
the popup in the Color Picker. Choose Copy from the Edit menu
popup.

Now, choose the color scheme that you want to apply these colors
to from the popup in the Color Picker dialog. Choose Paste from
the Edit menu popup. The colors from the first color scheme are
applied to the second color scheme.

Saving Color Sets

Before you save a modified color set, check to see that it has the
desired effect on each type of window and dialog. If you want to
save the most recent color assignments for all the interface ele-
ments on the popup, choose the Save... push button. A dialog ap-
pears. Type a new name for the color set in the text box, then
choose Save.

Exiting the Color Picker

The color set in the Color Picker dialog can be applied to the cur-
rent FoxPro session by choosing OK. Cancel closes the Color Pick-
er without applying new colors in the current FoxPro session.
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Command

Bring forward the Command window

Command displays the Command window. The Command window
is a FoxPro system window. When you choose options from
popups, you're actually generating FoxPro commands in the Com-
mand window.

ComMand

Command Window

You can also type FoxPro commands directly into the Command
window. Just position the cursor in the Command window and
type. Press Esc to delete text you've typed in the Command win-
dow if you haven’t pressed Enter yet.

FoxPro stores all commands in a history list so that you can recall,
edit and re-execute them. Commands can be recalled by scrolling
through the Command window until you find the command. To
re-execute a command, position the cursor anywhere on the ap-
propriate command line and press the Enter key.

To edit a command, scroll through the Command window until you
find the appropriate command. Add, delete or change any informa-
tion in the command using FoxPro’s text editing capabilities then
press the Enter key to execute the modified command.

Command Continuation

G8-10

Lengthy commands, such as a SQL SELECT command or a BROWSE
with multiple options, frequently extend beyond the right margin
of the Command window. When this happens, you can split the
command onto multiple lines for easier editing and viewing. Lines
in programs can also be split in the same manner.
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To keep a long command from going beyond the right margin in
the Command window:

1. Type a semicolon (;) where you want to break the command.
The semicolon must follow a space in the command.

2. Press Enter to move the cursor to the next line in the Com-
mand window.

3. Type the remainder of the command.

Although your command is now on more than one line, FoxPro will
read the separate lines as a single command. To execute a com-
mand split onto multiple lines, place the cursor anywhere in the
command and press Enter.

Automatic Indentation

You can manually indent a command in the Command window by
pressing Tab.

Automatic indentation is also available when you enter program
code in the Command window. Auto indent allows you to easily
construct indented program code.

To indent a command in the Command window, press Tab. You
may press Tab repeatedly for additional indentation.

After a line is indented in the Command window, any continuation
lines are automatically indented the same amount when you press
Enter.

Indentation greatly improves the readability of commands split
onto multiple lines in the Command window. See the discussion
on command continuation above for information on splitting com-
mands onto multiple lines.
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Debug

Display the Debug window
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Debug displays and activates the Debug window. In the Debug
window, you can monitor the values of variables and expressions
and set break points in programs.

Debug Window

To monitor values in your programs, position the cursor in the left
partition of the Debug window by clicking with the mouse or press-
ing Tab until the cursor appears in the left partition. Now you can
type the variables and expressions that you want to monitor in the
left partition of the Debug window. Make sure you press Enter
after each variable or expression you type in the window. If you
enter an expression that contains incorrect syntax, youlll hear a
beep.

You cannot enter expressions that involve macro substitution in
the Debug window.

As your program executes, the values are displayed in the right
partition of the Debug window. The variables and expressions can
be related to more than one module or program. You can enter up
to 16 debugging items in the Debug window, then switch back and
forth between modules and programs to monitor every step of pro-
gram execution.

You can set a program breakpoint based on a variable or expres-
sion in the Debug window. To set a program break, you must
mark the break in the breakpoint column that separates the left
and right partition of the Debug window. With the mouse, click in
the breakpoint column to the right of the variable or expression
that sets the break condition. With the keyboard, Tab until a
highlighted block appears in the breakpoint column, then use the
Up and Down Arrows to position the block next to the desired vari-
able or expression and press the Spacebar. A diamond appears to
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indicate that a breakpoint is set. To remove a breakpoint, position
on it and click or press the Spacebar.

When the value of a variable or expression at a breakpoint chan-
ges, program execution is suspended. The message “Do
suspended” appears on the screen and the Trace window appears if
it is not already displayed. Now you can change the values of vari-
ables in the Trace window, make changes in the Debug window
and perform other FoxPro tasks. You can also choose to Cancel or
Resume program execution by choosing these options from the
Program menu popup.

You can scroll the Debug window at any time using conventional
scrolling techniques. To adjust the size of the Debug partitions,
drag the window splitter with the mouse. With the keyboard, Tab
until the window splitter is selected and press the Left and Right
Arrows to adjust the partition sizes.

N If the values of your variables and expressions don’t appear
= /— in the right partition of the Debug window when you Do...
. the program:

1. Check that you have pressed Enter after every entry in the left
partition. If you press Enter after an entry and hear a beep,
the entry contains incorrect syntax.

2. Check that the right partition is scrolled so that the left edge is
visible.

3. Check that you don’t have expressions involving macro sub-
stitution.

Window Menu G8-13



Trace

Trace

Display the Trace window

The Trace window displays your program code, highlighting each
line as it is executed.

To help you debug your program, you can set breakpoints in the
Trace window on any line(s) of code where you want program ex-
ecution to pause. Program execution suspends just before execut-
ing the line with the breakpoint.

The names of the currently running program and procedure are
displayed at the bottom of the Trace window.

Trace Menu Bar
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The Trace window has its own menu bar.

When you open the Trace window and no program is executing,
five menu pads appear on the Trace menu bar: Program, Do...,
Out, Over and Step. Out, Over and Step are disabled now but are
enabled whenever a program is open in the window.

L Trace
Program Do... Out Over Step

Open. .. “E
Cancel

Line Numbers “L
Clear Breakpoints "B
¢Trace Betueen Breaks
Throttle... “R

L

Trace Window with Program Menu Popup Displayed
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Trace

The following options are available on the Program menu popup in
the Trace window:

Open...

Cancel

Line Numbers

Clear
Breakpoints

Trace Between
Breaks

Throttle...

Displays an Open File dialog so you can open a
program in the Trace window.

Cancels execution of a suspended program file.

Displays line numbers in a program. A diamond
precedes this option on the menu when line num-
bers are displayed. You can toggle line numbers
on and off by choosing the Line Numbers option.

Removes breakpoints from all program files.

Displays and highlights every line of program
code as it is executed. You can tell that Trace
Between Breaks is chosen when a diamond
precedes it. When Trace Between Breaks is off,
highlighting will remain on the last line executed
until another line with a breakpoint is reached.

Displays an Execution Throttle dialog so you can
specify the execution speed of programs in the
Trace window. You can type in the number of
seconds you want each line of program code to
delay when it executes.

Execution Throttle

Delay (seconds): 0.00

<« OK

» < Clear > < Cancel >

Execution Throttle Dialog

Window Menu
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Do...

When program execution is suspended in the Trace window, pro-
gram names, listed in calling sequence, appear at the bottom of the
Program menu popup.

n Trace
Program Resume Out Ouver Step

Open... “E
Cancel

Line Numbers “L
Clear Breakpoints "B
¢Trace Betueen Breaks | BROUWSER, Record Number:
Throttle... “R | Valid Clause

qt

temp Text Button

brouser. prg

clear read

procedure temp

suspend

return
*BROUSER. PRG: temp

Program Menu Popup Showing Calling Sequence

The currently executing program is listed first, below Trace
Between Breaks. The program that called the currently executing
program is listed next. In the example above, TEMP is the current-
ly executing program. BROWSER.PRG called TEMP, so BROWSER.PRG
appears below TEMP on the popup.

When program execution is suspended, you can choose a program
from the bottom of the popup. For example, if you choose BROW-
SER.PRG, the line in BROWSER.PRG that called TEMP is displayed
and highlighted in the Trace window.

Pressing the Home key returns you to the current point of execu-
tion in the program.

To begin program execution in the Trace window, choose Do...
from the Trace menu bar to display a Do dialog. Select the pro-
gram file you want to execute, then choose the Do push button.
The program is displayed and suspended in the Trace window with
the first executable line highlighted.
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Alternately, you can open a program from the Program menu
popup, then choose Do to begin execution.

L] Trace
Program Resume Out Over Step
This program uas automatically generated by GENMENU.

Setup Code

RELEASE PAD _MSYSTEM OF _MSYSMENU

PUBLIC m.module

SET TALK OFF
+ORGANIZE. PRG

Trace Window with Program Execution Suspended

When program execution is suspended, a bullet appears next to
the program name at the bottom of the Trace window. Program,
Resume, Out, Over and Step are enabled on the menu bar in the
Trace window.

Resume

Choose the Resume menu pad to continue program execution at
the point where execution was suspended.

Out

Choose the Out menu pad to step out of a currently executing pro-
gram and suspend execution on the first line following the com-
mand that called the current program. Out resumes program ex-
ecution but overrides the Trace Between Breaks setting.
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Over

Step

Choose the Over menu pad to step over a called program that you
don’t want the Trace window to display. If you're on a line that
calls another program, Over continues program execution, without
displaying the executed lines of a called program, to the next state-
ment of the program currently displayed in the Trace window. If
you're not on a line that calls another program, Over acts like
Step.

Choose the Step menu pad to execute one line of a program. Step
allows you to step through each line of code in a program one line
at a time.

Setting and Removing Breakpoints

If you want to suspend program execution at specific points in a
program, you can set breakpoints. Breakpoints can be set when a
program is suspended in the Trace window or open in the Trace
window. Click with the mouse, press the Spacebar or press Enter
anywhere on the desired line to set a breakpoint. A diamond to
the left of a line indicates that a breakpoint is set.

If you click with the mouse on a line that cannot contain a break-
point (such as a comment line), a breakpoint is set on the next
executable line that can contain a breakpoint.

To remove a breakpoint, click with the mouse, press the Spacebar
or press Enter on the line.

Choosing Clear Breakpoints from the Program menu popup in the
Trace window clears breakpoints in all of your program files.

Pressing Escape
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You can press Escape to interrupt program execution at any time
unless you've SET ESCAPE OFF. If you are in a READ or other wait
state, Escape will terminate the READ or the wait state. If youre
not in a READ or a wait state, execution suspends and the Trace
window comes forward (if it is open) with the next executable line
highlighted.

When you press Escape with program execution suspended and the
Trace window frontmost, an alert appears. You can Cancel execu-
tion and close the Trace window or Ignore the Escape and return
to the Trace window.
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When the Trace window is frontmost with no program executing or
suspended, pressing Escape closes the Trace window.

Copying Text from the Trace Window

When program execution is suspended in the Trace window, you
can use Copy from the Edit menu popup to duplicate lines in your
program that are highlighted by FoxPro. Copy duplicates the
highlighted line and places the copy on the clipboard. You can use
Paste from the Edit menu popup to insert a copy of the clipboard
contents into any editing window or the Command window.

Locating Text in the Trace Window

When program execution is suspended in the Trace window, you
can use Find... from the Edit menu popup to search for text in your
program code.

For more information about Copy, Paste and Find, refer to the
Edit Menu chapter of the FoxPro Interface Guide.
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View

Display the View window

The View window provides you with an easy way to open database
files, establish relations and set many FoxPro switches. Whenever
you work interactively with FoxPro, think of View as the master
control for database operations.

< Vieu > Work Areas <Relations> <1-To-Many>

<On/0ff>
{Files >

< Misc >

<Setup >

<{Brouse>

< Open >

<Close >

View Window/View Panel

The View window has four panels: View, On/Off, Files and Misc.
Each panel can be accessed by choosing the appropriate push but-
ton in the View window.

Opening and Closing the View Window
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To open the View window, choose View from the Window menu
popup. The View window appears. Now you are ready to work
with database files and set FoxPro switches.

When you finish using the View window, do one of the following:
® Press the Esc key.
® Choose Hide from the Window menu popup.
® C(Click the close control on the View window.

The View window disappears from the screen.
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Using the View Window

The View window is divided into three sections: the push buttons
that display panels, the push buttons specific to a particular panel
and the panel itself. Four push buttons — View, On/Off, Files and
Misc — are always located along the upper left side of the window.
Choosing any of these push buttons displays the panel with the
same name. Even though the appearance of the View window
varies each time you choose a panel push button, you can tell that
you are still in the same window because the word View remains
as the window title.

View Panel

Choose the View push button to display the View panel. Four
push buttons — Setup, Browse, Open and Close — are located at
the lower left edge of the View panel. These push buttons control
database files in the manner described below.

Setup Displays the Setup dialog. In this dialog, you can
decide which index file(s) to use with a database,
modify the structure of your database, build a list of
available fields, define a filter and specify which for-
mat file to use for data input screens. For more infor-
mation, refer to Setup in the Database Menu chapter
of this manual.

Browse Displays the selected database in a Browse window.
Whenever a Browse window is frontmost, a Browse
menu pad is added to the menu bar. The Browse
menu popup contains options for use with the Browse
window. You can examine, edit and append data in a
Browse window. For more information, refer to
Browse in the Database Menu chapter of this manual.

Open Displays the Open File dialog so you can select the
database that will be opened in the work area. If
your database is in a different drive or directory,
choose the correct drive and directory from the
popups. Select the database file from the list and
choose Open. The View window reappears with the
database file name (excluding the .DBF extension) in
the Work Areas list.
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Close Removes the selected database and any associated
files from the current work area. The original work
area letter or number reappears.

The Work Areas list contains work areas in which databases can
be opened. Initially, the work areas are labeled A-J and 11-25. A
triangle marks the selected work area.

Once you open a database, its alias replaces the selected work area
letter. This alias is the file name of the database (excluding the
.DBF extension), unless otherwise specified. For more information
about aliases, refer to the chapter titled The FoxPro Language in
the FoxPro Commands & Functions manual.

Aliases other than the database name can be manually
assigned by opening a database through the Command
window or a program file. Refer to USE in the FoxPro
Commands & Functions manual.

The Relations area of the View window displays any relations, or
links, that exist between database files in the work areas. There
are two methods for setting a relation: (1) based on record number
or (2) based on a matching field. For more information about rela-
tions, refer to Relating Database Files in the View section of this
chapter.
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View

Choose the On/Off push button to display the On/Off panel of the

View window.

<Files >

< Misc >

ALTERNATE
AUTOSAVE
BELL
CARRY
CLEAR
COMPATIBLE
CONFIRM
DEBUG

DELETED
DEVELOPMENT
ECHO

ESCAPE
EXACT

FULLPATH
HEADINGS
HELP
INTENSITY
NEAR
PRINTER
RESOURCE
SAFETY
SHADOWS
SPACE
STICKY
TALK
UNIQUE

SET ... [

OFF 1

View Window with On/Off Panel

This panel contains 26 different setting controls for FoxPro.
Choose a check box to turn a setting on or off. A setting that is on
has an X in the check box. For more information about any of
these options, refer to SET commands in the FoxPro Commands &
Functions manual.

Window Menu
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Files Panel

Choose the Files push button to display the Files panel of the View
window. In this panel you can change the default drive and set
certain default files. Files panel options are described below.

< Vieuw >
<On/0fE>
{Files >

< Misc >

Default
Drive

Path...
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Default Drive: (o II

[ 1 Path... < Clear Path >

[ 1 Alternate... {Clear Alternate>

[ 1 Procedure... <Clear Procedure>

Help...

C: \FOXPRO\FOXHELP. DBF
Resource...
C:\FOXPRO\FOXUSER. DBF

FILE SELECTION

View Window/Files Panel

Displays the default drive for all file input and output
operations. If you wish to specify a different default
drive, choose the drive from this popup. The new
default drive is displayed on the popup.

Allows you to specify a directory path for FoxPro to
search when a file is not found in the default direc-
tory. When you choose the Path... check box, a Select
Directory dialog appears.

Choose the desired drive, directory and/or subdirec-
tories from the popups and the list. When the path at
the top of the dialog is correct, choose Select. The
path appears in the Files panel. To deactivate this
path, choose the Clear Path push button.
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Procedure...

Help...

Resource...

Window Menu

View

Allows you to specify the file in which screen output
will be saved. When you choose the Alternate... check
box, a Save As dialog appears. Choose a file from the
list for use as the alternate file, or type a new file
name in the text box. Choose Open.

The alternate file name appears in the Files panel.
To direct screen output to the alternate file, check the
Alternate check box in the On/Off panel of the View
window. When you are ready to deactivate and close
the alternate file, choose the Clear Alternate push
button.

Allows you to specify the procedure file to be searched
when executing a program. When you choose Proce-
dure..., an Open File dialog appears. Select the
desired procedure file from the list and choose Open.

The procedure file name appears in the Files panel.
To deactivate and close the procedure file, choose
Clear Procedure. For information on procedure files,
refer to the FoxPro Developer’s Guide.

Allows you to specify the file to display when you
choose Help... from the System menu popup or press
F1. By default, this file is FOXHELP.

When you choose the Help... check box, the Open File
dialog appears. Select the desired help file and
choose Open. The help file name appears in the Files
panel. To enable help, you must check the Help check
box in the On/Off panel of the View window.

Allows you to specify the resource file for use with
FoxPro. This file contains a collection of resource
items such as window size and location, text file
preference settings, color sets, etc. You may want to
create additional resource files to store different
FoxPro color schemes.

When you choose Resource..., the Open File dialog
appears. Select the desired resource file and choose
Open. The resource file name appears in the Files
panel. Unless you want to edit the resource file, you
should check the Resource check box in the On/Off
panel of the View window.
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Misc Panel
Choose the Misc push button to display the Misc panel of the View
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window.

In this panel, you can set miscellaneous values for

FoxPro. These values are explained below.

< Vieu >

Date: [ 1 Century
<On/0ff> Anericanl] [ 1 Date Delimiter

0820419491

<Files > | Currency: Decimals

Symbol FNNNEN [ X1 Left

< Misc > $94999899

Date

Currency

[ 1 Clock Rou [l Column [El

[X1 Bell Freq. Length El <®»
[X]1 Talk Reporting Interval 108
Typeahead Mouse Tracking

SET MISCELLANEOUS UALUES

View Window/Misc Panel

Allows you to set the format for date expressions.
You can choose from several format options on the
Date popup. When you choose a format option, its
name appears on the popup. The displayed date also
changes to the new format.

Two date check boxes are located to the right of the
Date popup. When Century is checked, the complete
four-digit year is displayed in all date output. When
Date Delimiter is checked, you can select the text area
in the displayed date and type the delimiter character
of your choice.

Allows you to specify the format for monetary data. A
value can be entered in Decimals to determine the
number of places that will follow the decimal point.
Symbol refers to a string of characters that will
precede or follow the currency value, as determined
by the Left check box.

A sample number is displayed below the currency set-
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Bell

Talk

Typeahead

Mouse
Tracking

Window Menu

View

tings to show how your currency data will appear. If
you want to change the commas that appear in cur-
rency values, select the text areas of the sample num-
ber and type a different character, then press Enter.

Allows you to adjust the system clock. When Clock is
checked, a 12 or 24 hour clock appears on the screen
in the row and column indicated. Use the popup to
switch between 12 and 24 hour time. Row and
Column coordinates can also be adjusted (from 0-999)
using FoxPro editing techniques.

Allows you to adjust the error tone that your com-
puter emits. Your computer will not emit a tone un-
less Bell is checked in the Misc or the On/Off panel of
the View window. Freq (19—10000) and Length (1-19)
of tone can be adjusted. Choose the musical notes to
hear the tone frequency and length that you have set.

Allows you to specify whether processing status infor-
mation is displayed on the screen. When Talk is
checked, processing status information appears on
your screen at the specified Reporting Interval. The
default Reporting Interval is 100, but can be adjusted
by entering a different number (from 1-32767).

Allows you to set the number of characters that can
be held in the typeahead buffer. If you set this num-
ber to zero, no characters can be held in the
typeahead buffer. If this number is set to a value be-
tween 1 and 32,000 (the maximum), up to 128 charac-
ters can be held in the typeahead buffer. A high
typeahead setting is ideal for people who type very
quickly.

Allows you to set how sensitive your pointer will be to
movements made with the mouse. When set to 1, the
pointer is least sensitive. When set on the maximum
of 10, however, the pointer speeds across the screen
with the slightest movement of the mouse.
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Saving and Restoring Views

It is possible to save the environment settings from the View win-
dow to a view (.VUE) file. With the View window frontmost, choose
Save as... from the File menu popup.

A Save As dialog appears. Enter the name of the new .VUE file
and choose Save. Any environment settings, files, alias names,
and established relations from the View window are saved.

To restore a view, choose Open... from the File menu popup and
make sure that View appears on the Type popup. Select the ap-
propriate .VUE file from the list and choose Open. When a view
file is opened, the View window appears with its settings the same
as when it was saved.

Relating Database Files

G8-28

The ability to set relations is the power center of FoxPro. A rela-
tion is a link between two open database files that is based on a
common reference point, such as a field or record number. You
create a relation to temporarily connect records from different
databases so you can access their information at the same time.

In a relation, one database is the parent database and the other is
the child database. The parent database controls the child so that
when you move the record pointer (select a record) in the parent
database, FoxPro automatically moves the record pointer to the
first corresponding record in the child database. If a matching
record cannot be found in the child database, the record pointer is
moved to the end of the child file.

For example, each record in CUSTOMER.DBF contains a customer
identification number and customer address information. Each
record in INVOICE.DBF contains a customer identification number
and a billing amount. INVOICE.DBF is indexed on the customer
identification number. If you set a relation on the customer iden-
tification number in INVOICE.DBF, you could select each customer
record in CUSTOMER.DBF and see the amount of the customer’s bill
selected in INVOICE.DBF.

When you set a relation, it doesn’t matter if the parent database is
in indexed or unindexed form. The child database must be indexed
unless you only want to relate the databases by record number.
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Relation by Matching Field

When the child database is indexed, the relational expression you
create must match the index expression of the child database.
FoxPro evaluates the relational expression for the current record
in the parent database, then finds the first corresponding record in
the child database. In a relation of this sort, the relational expres-
sion must be the same data type and field length as the index
expression for the child database.

Relation by Record Number

When the child database is unindexed, the relational expression
you create must be numeric because it will be used to find a record
number. If the relational expression is not numeric, the message
“Database is not indexed” appears. FoxPro evaluates the relation-
al expression for the current record in the parent database, then
locates a corresponding record number in the child database.

Setting Relations

Before you begin to relate databases, make sure that the View
panel is displayed. All database files that you want to relate must
be open in their own work areas.

From the Work Areas list, select the database that will be the
parent database. Choose the Relations push button. The name of
the parent database appears in the Relations list with an arrow
pointing from it.

Now, select the database in the Work Areas list that will be re-
lated to the first database — the child database.

0 If a relation is based on anything except record number, the

child database must be indexed on an expression that is the
same data type and length as the relational expression.

— —— —————— ma——

If the child database is indexed and has the order set, the Expres-
sion Builder appears. If a field that the child is ordered on exactly
matches a field in the parent database, FoxPro automatically
enters that field in the expression box because this is the field
upon which your relation is nearly always based. You can change
this field or create another expression in the expression box.

If the child database is indexed but the order is not set, a Set
Index Order dialog appears so you can specify an order.
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Select the index entry that you want to control the order of your
database and choose OK.

If the child database is not indexed, FoxPro assumes that you will
create a relational expression based on record number.

When you're satisfied with the expression in the expression box,
choose OK. The View window reappears with the complete rela-
tion in the Relations area.

Creating One-To-Many Relationships

A 1-To-Many push button appears to the right of the Relations
push button at the top of the View panel.

< Vieu > Uork Areas <{Relations> <1-To-Many>

<On/0f > » - CUSTOMER CUSTOMER
» INUOICE L INUOICE
<Files >

< Misc >

<{Setup >

<{Brouse>

< Open >

<Close > |CUSTOMER Records: 54

View Window with Relation Set

The 1-To-Many push button is enabled when there is at least one -
relationship originating from the currently selected database.
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When you choose the 1-To-Many push button, the 1-To-Many
dialog appears so that you can establish a one-to-many relation-

ship.
Establish 1-To-Many Relationship:
Parent Alias is CUSTOMER
Child Aliases: Selected Aliases:
< Move + >
INUOICE
< A1l » >
< Remove >
{Remove All>
« OK » < Cancel >

One-to-Many Dialog

A one-to-many relationship can contain multiple records in the
child file for each record in the parent filee. When databases in-
volved in a one-to-many relationship are processed, the record
pointer remains on the same record in the parent database until
all related records in the child database have been processed.

The parent alias is displayed at the top of the 1-To-Many dialog.
Child aliases appear in the list on the left side of the dialog. The
Selected Aliases list will display aliases of all databases currently
involved in a one-to-many relationship with the current database.

Six push buttons are located in the 1-To-Many dialog:
Move Copies the selected child alias(es) in the Child Aliases
list to the Selected Aliases list. This push button is

disabled unless an alias is selected in the Child
Aliases list.

All Copies all of the child aliases in the Child Aliases list
to the Selected Aliases list.

Remove Removes the selected alias(es) from the Selected
Aliases list. This push button is disabled unless an
alias is selected in the Selected Aliases list.

Remove All Removes all aliases from the Selected Aliases list.
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Cancel

OK

Exits the 1-To-Many dialog without creating or
removing any one-to-many relationship.

Confirms the

one-to-many relationship among the

selected alias(es) and exits the dialog.

A square bullet appears in the work areas list to the right of the
parent database when a one-to-many relationship is set.

< Vieuw >
<On/0fE>
{Files >

< Misc >

<Setup >

<{Brouse>
< Open >

<{Close >

Work Area

s <Relations> <1-To-Many>

» < CUSTOMER
+INUOICE

n CUSTOMER
L+ INUOICE

CUSTOMER

Records: 54

Picture of View Window with Relation Set

For more information, refer to SET SKIP in the FoxPro Commands

& Functions

manual.

Modifying Relations

In the View window, you can modify existing relations between
database files. First, make sure the View panel is displayed. To
see the existing relation and make modifications:

* With the keyboard, Tab to the Relations area and arrow to
the child database. Press the Spacebar.

® With the mouse, click on the child database in the Relations
area. The Expression Builder appears.

Change the expression as necessary. When you have established a
valid relational expression, choose OK.
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Removing Relations

In the View window, you can remove relations between database
files. First, make sure the View panel is displayed. Choose the
child database in the Relations area. The Expression Builder ap-
pears. Remove the existing relational expression from the expres-
sion box and choose OK. The View window reappears and the
relation has been removed from the Relations area.

Other Options

List names of all active windows

In addition to these options, the names of all open windows appear
at the bottom of the Window menu popup. The first ten windows
at the bottom of the Window menu popup have a number hot key,
0-9, which you can use to choose the window name. If an open
window is hidden or behind other windows, you can bring it to the
front by choosing its name from the Window menu popup or press-
ing the appropriate hot key.
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9 Filer Menu

Filer Menu

The Filer helps you maintain order on your hard disk. You can
copy files, create directories, move files and delete files. You can
also view and change file attributes, find specific files, rename files
or check the size of one file or a group of files.

The Filer has two panels: the Files panel and the Tree panel. The
Files panel is used to manipulate individual files or groups of files.
The Tree panel is used for operations on entire directories and
their subordinate directories.

To use the Filer, choose Filer from the System menu popup or type
FILER in the Command window. The Filer window appears with
the Files panel displayed and a Filer menu pad is added to the end

of the menu bar.

Copy... ~C
Move... ~0
Delete... “D
Rename... "R

Edit... “E
Attr... T
Size... ~Z
Tag All “A
Tag None “N
Invert ~V

Find... “F
Mkdir... “K
Chdir “H
Sort...

Tree Panel "L

Filer Menu
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Files Panel

The Filer menu popup contains menu items that correspond to the
push buttons in the Files and Tree panels, and a Panel option used
to toggle back and forth between the two panels. Ctrl key
shortcuts exist for most options on the Filer menu popup.

You can leave the Filer from the Files panel or the Tree panel by
pressing Escape or choosing Close from the File menu popup. If
you use a mouse, you can also click the close box.

Files Panel

The Files panel contains thirteen push buttons, two popup con-
trols, a text box and a list. A scroll bar appears to the right of the
list when it contains more files than can be seen.

Last Modified

[..]
CLABEL
CLIENTS
CLIENTS
CLIENTS
CONFIG
CREDITS
CSTLEDGR
Cus-cus
CUSTLABE
CUSTLIST
CUSTMENU

.LBL
.DAT
.DBF
.FPT
.FP
.PRG
.PRG
. IDX
.PRG
.PRG
.PRG

27-Jul-89
27-Apr-89
13-Aug-89
12-Aug-89
12-Aug-89
16-Aug-89

11-Aug-89
11-Aug-89
15-Aug-89
11-Aug-89
11-Aug-89
11-Aug-89

[ ]
Dir. SAMPLE ﬂ

Files Like

< Tag All >
< Tag None >
Invert >

G9-2

< Copy >
< Attr >

< Move >
< Rename >

< Delete >
< Size >

Files Panel

Sort >
Tree >
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Changing Drive and Directory

The popup controls in the upper right portion of the dialog display
the current drive and directory.

Name Last Modified Attr

[..1 27-Jul-89 6:26p .... Dru. I
CLABEL . 27-Apr-89 3:46a .a.. c:

FOXPRO

CLIENTS . 13-Aug-89 5:18p
CLIENTS . 12-Aug-89 2:55p
CLIENTS . 12-Aug-83 2:55p
CONFIG . 18-Aug-89 11:208p

CREDITS . 11-Aug-89 3:42a
CSTLEDGR . 11-Aug-89 3:42a
Cus-Ccus . 15-Aug-89 2:082p
CUSTLABE . 11-Aug-89 3:42a
CUSTLIST . 11-Aug-89 3:43a
CUSTMENU . 11-Aug-83 3:43a

Files Like

< Tag All >
< Tag None >
Invert >

o s s e e 6 e e e o
9 NY YWY Y
o e e e e o e e e e o
e o 4 e e s e s e o

< Find > < Copy > < Move > < Delete > Sort >
< Edit > < Atte > < RenamMe > < Size > Tree >

Files Panel with Directory Popup

You use the Drive popup control to change the current drive.
When you change drives, the name of the current directory on the
new drive appears on the Directory popup control. The files and
subordinate directories in the list change to reflect the new drive
and directory.

The Directory popup is used to change directories. You can quick-
ly move up the directory tree structure many directories at a time
by choosing options from this popup. When you choose a new
directory, the list in the Filer changes to reflect the contents of the
new directory.

Besides using the Directory popup, you can move up the directory
tree structure by choosing the first entry in the list, the parent
directory. By choosing [..], you move up the directory tree one
parent directory at a time.

To display the files in a subordinate directory, choose the directory
name from the list. The list displays all subordinate directories in
the new directory, followed by the files in that directory. The
name of the new directory appears on the Directory popup.
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When the list contains only the parent directory symbol ([..]) and
file names, you know no subordinate directories are in the current
directory.

The parent directory symbol always appears at the top of
the list except when the current directory is the root direc-
tory.

Files are displayed in the Files panel with the file name, exten-
sion, size, the date and time the file was last modified and any
attributes assigned to that file. The attributes are Read Only,
Archived, Hidden File or System File. For more information on
attributes, see the Attributes section later in this chapter.

Limiting File Display

The files displayed in the Filer can be customized/limited by using
the Files Like text box to designate files or file types. Enter any
legitimate file name or any portion of a file name combined with
wildcard characters in the Files Like text box. You can specify
more than one by separating the specifications with a semicolon.
For example, you could enter *.EXE;*.TXT;*.BAT. Do not put
spaces between each specification. When you press Enter, only the
files that meet the Files Like specification are displayed in the list.

By default, the files are displayed in the following order:

1. Directories

2. Alphabetically by file name, then alphabetically by extension.

Tagging Files

G9-4

Selecting the file(s) on which to perform an operation such as
move, copy and delete, is called tagging. When a file is tagged, a
triangle appears in the list to the left of the file name. You can
tag files individually or in groups.

To tag files individually using the keyboard, press Tab until an
item in the list is selected. Press the Up/Down Arrows until the
desired file is highlighted, then press the Spacebar. To tag multi-
ple files, hold down the Shift key and select the files you wish to
tag. While holding down the Shift key, pressing the Spacebar on
selected files toggles them between tagged and untagged. To tag
multiple consecutive files, tag one file, then hold down the Shift
key and press the Up/Down Arrow key.

To tag files individually using a mouse, point to the file name and
click. To tag multiple files, hold down the Shift key and select the
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files you wish to tag. With the Shift key held down, drag the
mouse to tag groups of consecutive files. Holding down the Shift
key while clicking on files changes them from tagged to untagged.

Three push buttons are located beneath the Files Like text box:
Tag All, Tag None and Invert. The Filer menu popup contains op-
tions that correspond to these buttons.

Tag All tags all the files in the list. This feature is most useful
when you have specified a file type in the Files Like text box. You
might want to copy, move or delete all the files of a specific type.
Choose this push button to tag them all at once.

Last Modified Attr

[..] 27-Jul-89 6: ceen Drv. C ﬂ
»CLABEL . 27-Apr-89 3: 2.,

»CLIENTS . 13-Aug-89 5:
»CLIENTS . 12-Aug-89 2:
»CLIENTS . 12-Aug-89 2:
»CONFIG . 18-Aug-89 11:

»CREDITS . 11-Aug-89
»CSTLEDGR . 11-Aug-89
»CUS-CUS . 15-Aug-89
»CUSTLABE . 11-Aug-89
»CUSTLIST . 11-Aug-89
»CUSTMENU .PRG 11-Aug-89

Dir. SAMPLE “

Files Like

< Tag A1l >
< Tag None >
Invert >

o e e e e e s e e
[T
e ¢ e e e e o & e o o
P T T

< Find > < Copy > < Move > < Delete > Sort >
< Edit > < Attr > < Renanme > < Size > Tree >

W

Filer Menu

Files Panel with Tagged Files

Tag None untags all tagged files in all directories. Use Tag None
after you perform an action on tagged files to ensure that you don’t
manipulate them unintentionally.

Tag All only acts on files in the current directory (as
displayed in the list). Tag None performs a global action.
After choosing Tag None, no files will be tagged in any
directory.

Tagged files in all directories remain tagged until you untag them,
change drives, switch to the Tree panel or exit the Filer.
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Invert untags all tagged files and tags all untagged files in the
currently displayed directory. This is very useful when you want
to tag most of the files in a directory. For example, if you want to
tag all except three files, you would tag the three, then choose
Invert.

Find Files

G9-6

Find is used to specify files to be tagged based on the file name
and/or the contents of the file. The Find option uses two dialogs to
iocate and tag files.

Find tags files containing specified text in entire directories and
their subordinate directories. Choose the Find push button or
Find... from the Filer menu popup to bring forward the Find File
dialog.

Find and tag files uhich have names like
< x|
[ 1 Specify text to search for...
[ 1 Search subdirectories

« Find » < Cancel >

Find Files Dialog

In this dialog you specify the file type you want to find by entering
the specification in the text box. This text box works the same as
the Files Like option in the Files panel. Enter any legitimate file
name or any portion of a file name combined with wildcard charac-
ters in the text box. You can specify more than one by separating
the specifications with a semicolon. For example, you could enter
* EXE; *.TXT; *.BAT.

The difference between the find option and the Files Like option is
that Find displays and tags all files that meet the specification in
all directories on the current drive if you have instructed it to do
so. If the specification is *. *, all files will be tagged.
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Files Panel

Beneath the text box in the Find Files dialog are two check boxes.
Checking the Specify text to search for... check box brings for-
ward the Specify Text dialog.

Tag only those files that contain

() fAny
> All

of the follouing strings:

| |
I |
| |

[X1 Ignore case « OK »

[ 1 Match words < Cancel >

Specify Text Dialog

This dialog has three text boxes in which you enter character
strings you want the Filer to locate in the files it searches. Enter
up to three strings no longer than 256 characters each. The Filer
searches through all the specified files and tags the ones that con-
tain these strings.

Above these text boxes are two radio buttons: Any and All. If you
choose All, a file is tagged only if it contains all of the specified
strings. If you choose Any, a file is tagged if it contains any one of
the specified strings.

Two check boxes are located at the bottom of the specify text
dialog. Ignore case tells the Filer to treat upper- and lower- case
letters as if they were identical. If you have entered the string
“The Quick Fox”, checking Ignore case allows the Filer to locate
and tag files containing “the quick fox” as well as “The Quick Fox”,
“THE QUICK FOX”, and so on. If this check box is not checked, only
files containing “The Quick Fox” are tagged.

Match words tells the Filer to match entire words in the specified
string. For example, if you enter the string “can”, files containing

» o«

strings such as “candle”, “incandescent” and “decanter” are tagged
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as well as “can”. You must check the Match words check box if
you only want to tag files containing the exact word “can”.

When you have entered the strings and checked the desired op-
tions, choose OK to return to the Find Files dialog. Another check
box in the Find Files dialog is Search subdirectories. Search
subdirectories finds files that meet your specifications in the cur-
rent directory and all its subdirectories. If this box is not checked,
the Filer searches only the current directory that is displayed on
the Dir popup.

After you enter file specifications and choose the desired options,
choose Find to begin the search. The Filer begins locating and
tagging files. Choose Cancel to return to the Files panel without
performing any action.

If you want to search parent directories, choose the highest level
directory in which you want to begin the search from the Dir popup
before you choose Find.

The Find feature can be used to search an entire drive. To search
a drive, choose the root directory from the Directory popup, then
check Search subdirectories in the Find dialog and choose Find.

If you are searching through many files or large files, Find
may take some time. The Filer shows you the name of the
file being searched and, for large files, the progress through
the file.

When the Filer finishes searching the files, you are returned to the
Files panel. All files that meet your specifications are tagged.
Also, when you choose Edit in the Filer to open a file tagged with
Find, the string specified in the first text box of the Find dialog
will be highlighted in each file. The string also appears in the text
box of the Find dialog accessed through the Edit menu popup. You
can then use the usual search and replace options to alter the file.

Directories that had files tagged in them during the Find are
marked with an arrow to the left of the directory name in the list.
You can choose a marked directory to see which files have been
tagged and untag some, if desired, before you perform a mass
operation (copy, move, delete, edit) on all the tagged files in all the
directories.
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Copy Files

Filer Menu

Choose the Copy push button or Copy... from the Filer menu
popup to copy tagged file(s) to a new location (the target directory)
without disturbing the files in their original location. This option
also allows you to rename the files in a mass operation during the
Copy process.

Choosing Copy brings forward the Copy Files dialog.

Copy tagged files as LG

<Target directory...> C:\FOXPRO\

[ 1 Replace existing files
[ 1 Preserve directories

« Copy » < Cancel >

Copy Dialog

In this dialog you specify the output name of the file(s) in the first
text box, and then designate the target directory to which the
file(s) are to be copied. The default setting in the output file text
box is *.*, This specifies that all tagged files will be copied to the
target directory without changing their names. By entering
wildcard characters in this text box, you can rename all the tagged
files in one operation during the copy process. For example, if you
had tagged all the text (.TXT) files and wanted to copy them with
the extension .OLD, you would enter *.0LD in the output file name
text box. All the tagged files would be copied to the specified tar-
get directory and renamed with an .OLD extension in one opera-
tion.
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You specify the target directory by entering the drive and directory
in the text box next to Target Directory..., or by choosing the Tar-
get Directory... push button and using the Target Directory dialog.

Select Target Directory
C:\FOXPRO

I rive [ ¢
[SAMPLE]
[TUTORIAL]

Directory | FOXPRO Il

« Select »

< Open >

< Cancel >

Target Directory Dialog

You can change drives and directories by choosing the desired
drive and directory from the appropriate popups. The Directory
popup displays the name of the current directory and the list dis-
plays the subordinate directories in the current directory of the
current drive.

If you don’t change drives, the Directory popup displays all the
parent directories of the current directory, and the list displays all
the subordinate directories. Choose the drive and directory to
which you want the tagged file(s) copied. Then choose the Select
push button to return to the Copy Files dialog. The target direc-
tory now appears in the text box.

If you enter a directory that does not exist, the Filer will
create the directory on the specified drive before copying the
files to that directory.

Two check boxes are located in the Copy Files dialog: Replace ex-
isting files and Preserve directories. When you check Preserve
directories, the directory structure is copied as well as the files
themselves. The complete structure will be copied through the
lowest directory in the tree (the one farthest from the root) that
contains all tagged subdirectories. For an extended example of
preserve directories, see Copy Directories later in this chapter.
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Files Panel

Check Replace existing files to overwrite files in the target direc-
tory having the same name as files being copied. Choosing this
option will not overwrite directories. If a directory by the same
name exists in the target, the files that correspond to that direc-
tory will be copied. When you are ready to copy, choose Copy.

If Replace existing files is not checked and a file with the same
name exists in the target, an alert appears asking if you want to
overwrite the file. Choose Yes to overwrite or No to skip the file
and continue the operation. Choosing Cancel returns you to the
Files panel.

If you enter an invalid file name, an alert comes forward asking if
you want to continue. Choose Yes to skip the currently displayed
file and continue the copy operation. Choose No to halt the opera-
tion and return to the Files panel. Files that are currently open
cannot be tagged or copied.

Files that have been copied remain tagged in the original direc-
tories but do not appear tagged in the target directory. Remember,
if you perform further operations, those operations are performed
on all tagged files in all directories. This is very important to
remember when you use the Filer to delete files.
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Move Files

G9-12

Move functions exactly the same way as Copy except that it
deletes the original file immediately after copying it to the target
directory.

When you choose the Move push button or Move... from the Filer
menu popup, the Move Files dialog appears.

Move tagged files as G
<Target directory...> SHNIBIITIINITIVIITTEN

[ 1 Replace existing files
[ 1 Preserve directories

« Move » < Cancel >

Move Files Dialog

This dialog is the same as the Copy Files dialog. For information
on specifying an output file name or designating a target directory
in which to move files, see Copy Files earlier in this chapter.

When you are satisfied with your settings in the Move Files dialog,
choose Move.

Filer Menu



Files Panel

Delete Files

O

Filer Menu

Delete can quickly free up large areas of disk space by erasing
unwanted files, either individually or in groups. You can specify
files for deletion by tagging them individually by directory, or by
tagging groups of files in single or multiple directories using the
various options for file specification (Files Like, Find, Sort). When
you have tagged the desired file(s), choose the Delete push button
or Delete... from the Filer menu popup. The Delete Files dialog
appears.

Are you sure you uant to delete this File?
C:\FOXPROX\TUTORIAL\CUS_COM. IDX

« Delete » < Skip > < Delete All > < Cancel >

Delete Files Dialog

The name of the currently selected file appears, along with four
push buttons: Delete, Skip, Delete All and Cancel.

Choose Delete to erase only the displayed file from the disk. If
more files are tagged, the next file appears in the Delete dialog.
You may confirm the deletion or skip the deletion of the file.

Choose Skip to pass over the currently displayed file without delet-
ing it.

Delete All bypasses the confirmation function of this dialog and
deletes all the files that are tagged. This is a quick way to erase

files and free disk space, but make sure that only the files you
want to delete are tagged.

Delete All erases all tagged files across all directories, even
those that aren’t visible in the current Files panel display.

The name of each file appears as it is deleted. In most cases, the
names flash by so quickly that you aren’t able to read them. If you
suddenly see file names that you didn’t want to delete, press Es-
cape to stop deleting. Any files that already appeared in the dialog
are lost.
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Make backups of important files frequently, especially before
massive delete operations.

Choosing Cancel before or between individual delete operations
returns you to the Files panel.

Edit Files

G9-14

Choose the Edit push button or Edit... from the Filer menu popup
to open text editing windows for all tagged files. The number of
files you can open is limited only by available memory and the DOS
FILES = parameter. If you have numerous tagged files you may
exhaust available memory or DOS channels. In this case, an error
message appears. Before you can continue, you must return to the
Files panel and untag some of the files.

Once the editing windows are open, you can cut, copy and paste
text among windows to alter programs and text files, or you can
position the cursor at any point in the file and enter new text or
code.

If you choose Edit to open files that have been tagged by searching
for strings with the Find option of the Filer, the first occurrence of
the first specified string (from the Specify Text dialog) will appear
highlighted in the editing windows when they are opened. The
string will also appear in the Find text box of the Find dialog ac-
cessed through the Edit menu. Use the usual editing techniques to
find and replace text with this dialog.

For information on the FoxPro text editor, refer to the Interface
Basics chapter of this manual.
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File Attributes

Filer Menu

In the Files panel, the list displays the DOS attributes of each file.
These are switches that can be turned on or off to change the
status of a file in specific ways.

You can change the attributes of files either individually or in
groups. After you tag the files you want to change, choose the Attr
push button or Attr... from the Filer menu popup. The Attributes
dialog appears.

Do you uant to change the attributes of
C:\FOXPROXNTUTORIAL\CUS_COM. IDX

[ 1 Read Only [ 1 Hidden File
[X]1 Archived [ 1 System File

« Change » < Change All > < Cancel >

Attributes Dialog

This dialog displays the name of the currently selected file and the
attributes for that file. The first letter of each attribute cor-
responds to the letters displayed in the attributes column of the
list in the Files panel. Attributes are described below.

Read Only (r) A file with a read only (r) attribute can be read
but cannot be modified. Read Only protects the
file from accidental deletion or modification.

To assign this attribute, check the Read Only
check box.

You can overwrite a Read Only file in the Filer
although you are prompted for confirmation first.

The Filer cannot delete, move or rename a Read
Only file.
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Archived (a) This attribute signifies that the file has been
modified or newly created. Many backup
programs back up only files that have the -
Archived attribute. After the files are backed up,
the Archived attribute is removed.

To assign this attribute, check the Archived check
box.

System File (s) This attribute classifies the file as a system file.
DOS operating files are protected with the System
File attribute. System files are in a specific physi-
cal position on the disk and should not be moved.
The Filer does not let you move, delete, rename or
overwrite a file with the System File attribute set
on.

To assign this attribute, check the System File
check box.

Hidden File (h) This attribute hides the file so that it does not
appear in a DOS directory listing even though it is
on the disk. Filer does not let you move, delete,
rename or overwrite a file with the Hidden File
attribute.

To assign this attribute, check the Hidden File
check box.

Changing File Attributes
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When the desired attributes are checked in the Attributes dialog,
choose Change to assign attributes to the file displayed in the At-
tributes dialog. The attributes are assigned and the next tagged
file appears so you can assign attributes to it.

You can alter the attribute settings file by file, or you can change
all the tagged files in one operation by choosing the Change All
push button. Like Delete All, this operation goes through all the
tagged files very quickly and gives them all the same attributes
that you have selected. Remember that when you choose Change
All, all tagged files (even those not in the currently displayed direc-
tory) are affected by the operation. To stop a Change All operation
once it begins, press Escape. This stops the Change All operation,
but any files already changed remain changed.
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Choosing Cancel before you begin an operation returns you to the
Files panel.

Rename Files

Filer Menu

Renaming files is accomplished quickly and easily using Rename.

Choose the Rename push button or Rename... from the Filer menu
popup to bring forward the Rename Files dialog.

Rename: CUSTOMER.DBF
To: CUSTOMER.DBF

« Rename » < Cancel >

Rename Files Dialog

When you rename a file, the new name is usually similar to the
original name. Therefore, the current file name appears by default
in the text box. You change the name in the text box by editing
the old name or entering a new name. Choose Rename when you
are ready to rename the file.

If a file already exists with the new name you specified, an error
message appears.

Error Renaming

C: \FOXPROXNTUTORIAL\CUSTREP1. FRT. Do you uish
to continue?

« VYes » < No >

Choose Yes to leave this file name unchanged and skip to the next
tagged file. Choose No to halt the operation and return to the
Files panel. If you choose Yes when you are on the last tagged file
or when only one file is tagged, you will automatically return to
the Files panel.

Choosing Rename without changing the name of the file in the
text box has the same effect as skipping that file.
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File Size

I\

The Files panel displays the size of tagged files in bytes. When
you are using the Filer to move or delete files to make room on
your disk, you want to know how much space the operation actual-
ly frees up. Choose the Size push button or Size... from the Filer
menu popup to get this information.

Tagged file statistics

Files: b
Bytes: 35,586

Actual space occupied:

Clusters: 208
Bytes: 408, 960
« OK »
Size Dialog

Size provides you with information about the files you have tagged
on your disk. The information in the Size dialog reflects files
tagged in all directories, not just the directory currently displayed
in the Files panel.

The first line of this dialog displays the number of files you have
tagged and the second line displays the number of bytes those files
contain.

Just adding the bytes together does not provide you with the
amount of space those files actually occupy on your disk.
Disk space is allocated to files in units called clusters. The
size of a cluster depends on your particular system.

For example, if the cluster size on your system is 2048 bytes, DOS
allocates at least 2048 bytes for every file. A file could actually
contain only 73 bytes, but DOS reserves 2048 bytes. Therefore, the
actual number of bytes the files occupy on the disk could be much
greater than the number of bytes displayed in the top portion of
the dialog.
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The lower portion of the dialog displays the actual number of
clusters occupied by the tagged files. This number is then multi-
plied by the cluster size of your system. The outcome is the actual
space occupied in bytes.

Sort Files

Filer Menu

To change the order of the files in the list, choose the Sort push
button or Sort... from the Filer menu popup. The Sort Files dialog
appears. You can change the order with or without specifying a
Files Like entry.

The radio buttons in this dialog allow you to change the sort se-
quence of the files and directories in the list. By default, the -
Ascending and Name radio buttons are chosen.

Select Sort Criteria

() Name
C ) Extension (+) Ascending
C ) Size
C ) Date C ) Descending
C ) Attributes
C ) Unsorted

« OK » < Cancel >

Sort Files Dialog
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Choosing the radio buttons in this dialog will display the files in
the following sort order:

Sort Files Dialog Radio Buttons
Sort Order Display

Name Alphabetical Order:
Ascending — A - Z
Descending — Z - A

Extension | Alphabetical Order:
Ascending — A - Z
Descending - Z - A

Size Size Order (in bytes)
Ascending — smallest to largest
Descending — largest to smallest

Date Date Order:
Ascending — oldest to most recent
Descending — most recent to oldest

Attributes | Attribute Order:
Ascending — r,a,s,h
Descending — h,s,a,r

Unsorted DOS Order

Once you have chosen the desired sort options, choose OK. The
files are displayed in the sort order you chose. Choose Cancel to
exit the Sort Files dialog without changing the order of the files.

Display Tree Panel

Tree displays the Tree panel of the Filer. The Tree panel is
designed to perform some of the same functions that can be per-
formed in the Files panel, but it performs them on entire direc-
tories and all the files they contain.

Tree Panel
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In the Tree panel you can copy, move and/or delete entire directory
structures with the same ease as any other FoxPro operation —
simply choose a push button or menu option and complete a dialog.
This panel also has options that enable you to rename directories,
make new directories, change the current working directory or
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quickly determine the size (in bytes and clusters) of any directory
or set of directories.

Directory tree of Uolume:

| —FOXPROX . c “
EXAMPLES

FABRIC
FOXBASE
ELPINT
IAT
LD Files: 1,683
—HSG Used: 86,832,384
—LL Free: 17,235,968
—NETS
—NORTON

<Renane> <Chdir > < Mkdir >
< Copy > < Move > < Delete > < Size > < Files >

Tree Panel

Some of these operations will be quite familiar because they are
the same operations you can perform in the Files panel. The dif-
ference is that in the Files panel you tagged individual files. In
the tree panel, you tag directories. The actions you select are auto-
matically performed on all the files located in those directories.

e ———— ——

Use extreme caution when performing operations in this
panel. It is best to back up before deleting entire
directories. This way, if you discover you accidentally
deleted any directories from your disk, you can restore them

from an alternate location.

|

r—

Choosing a Drive

When the Tree panel is first displayed, the list shows the direc-
tories and subdirectories for the current drive. The root directory
is at the top of the list. If more directories are present than you
can see in the window, scroll with the vertical scroll bar or use the
Up/Down Arrows on the keyboard.

To the right of the list is a popup that displays the current drive.
To change drives, choose the desired drive from the popup. The
list changes to reflect the directory structure on the specified drive.
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Beneath this popup is an area that displays the number of files on
that drive and the space those files occupy. It also displays the
remaining space on the current drive.

At the bottom of the panel are push buttons that bring forward
dialogs and perform actions, just as they did in the Files panel.
Options on the Filer menu popup are activated and deactivated to
reflect the push buttons and available options in this panel.

Any time you want to leave the Filer from the Files panel or the
Tree panel, press Escape or choose Close from the File menu
popup. If you have a mouse, you can click the close box.

Tagging Directories
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You choose the directories you wish to manipulate in much the
same way that you chose the files you wanted to alter in the Files
panel — you tag them. Keep in mind that when you tag a direc-
tory, all the files in that directory are tagged as well. Any actions
you specify will be performed on all tagged directories and all the
files located in those directories.

To tag directories individually using the keyboard, press Tab until
the list is selected. Press the Up/Down Arrows until the desired
directory is highlighted, then press the Spacebar. A triangle ap-
pears in the list to the left of the selected directory. To tag multi-
ple directories, hold down the Shift key and select the files you
wish to tag. While holding down the Shift key, you can press the
Spacebar on selected files to change them from tagged and un-
tagged.

To tag directories individually using a mouse, point to the direc-
tory name and click. To tag multiple directories, hold down the
Shift key and select the directories you wish to tag. While holding
down the Shift key, you can click on directories to toggle them
between tagged and untagged.

With the Shift key held down, drag the mouse to tag groups of
consecutive directories.

To tag groups of consecutive directories with the keyboard, tag a
file, then hold down the Shift key while pressing the Up or Down
Arrow key.

You can tag and untag directories as many times as you like
without altering them in any way. No changes are made to any
directories until you choose a push button to invoke an action.
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When the desired directories are tagged, choose the appropriate
push button at the bottom of the dialog or choose an option from
the Filer menu popup.

Rename Directory

Choose the Rename push button or Rename... from the Filer menu
popup to bring forward the Rename Directory dialog. This dialog
displays the name of the tagged directory. Beneath the name is a
text box in which you enter the new name. Choose Rename when
you are ready to rename the directory, or choose Cancel to return
to the Tree panel without making any changes.

If multiple directories are tagged, the first directory in the tree will
be renamed first. When you choose Rename and rename a direc-
tory, the next tagged directory in the tree is displayed in the text
box. This continues until all the tagged directories have been
renamed.

When you rename a directory, none of the files in the directory are
altered. Only the name of the directory changes. What may also
change is the position of the directory in the tree. Because the
tree is organized alphabetically, changing the directory name will
move it to the corresponding location in this order. The directory
will not, however, leave the parent directory in which it is current-
ly located. You can only rename the directory with this dialog —
you cannot change the path name.

When renaming directories, the new name must be a valid name
according to standard DOS conventions (maximum 8 characters
with an extension of up to 3 characters). If you enter an invalid
name, an error message appears.

If the root directory of a drive is tagged when Rename is chosen,
then the drive’s volume label may be renamed.

Change Directory

Filer Menu

The Chdir option is a convenient way to change the current work-
ing directory so you can issue commands and open files without
entering entire paths in the Command window. The directory
specified with this action becomes the default directory where
FoxPro will look for files that are not specified with a path.

The current directory is designated by a bullet in the far left
column. To change the current working directory, simply tag the
desired directory and choose the Chdir push button or menu op-
tion. The bullet appears next to the new current directory.
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Make Directory

To make new directories, tag the directories that will be the
parents to the new directories and choose the Mkdir push button or
Mkdir... from the Filer menu popup. A Make Directory dialog ap-
pears so you can type the name of the new directory in a text box.

Make subdirectory in: C:

New Subdirectory name: | ]

« Mkdir » {Cancel >

Make Directory Dialog

Enter a valid name (use the standard DOS conventions for naming
directories) and choose Mkdir. The new directory is inserted in the
appropriate place among the other subdirectories of the parent you
have specified.

If you enter an invalid name, an error message similar to the one
displayed in the Rename Directory dialog will appear. Choose Yes
to leave this directory unchanged and continue making new sub-
directories under other tagged directories. Choose No to cancel the
operation and return to the Tree panel. If no other directories are
tagged, you will return to the Tree panel automatically.

Copy Directory
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When you choose the Copy push button or Copy... from the Filer
menu popup, the Copy Directory dialog appears. This dialog is
similar to the Copy Files dialog in the Files panel. You can enter
the target drive and directory in which to copy the tagged direc-
tories, or you can choose the Target Directory... push button and
choose a drive and directory in the Target Directory dialog. For
information on the Target Directory dialog, see Copy Files in this
chapter.

When you copy directories, you have the option of preserving the
directory structure or performing a flat copy. When a flat copy is
performed, all the files in all the tagged directories are copied to
one single directory. The directory structure is not preserved.

When you preserve the structure, the directory structure is copied
as well as the files themselves. The complete structure will be
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copied up to the lowest directory in the tree (the one farthest from
the root) that contains all the tagged subdirectories.

In the following example, directories that are tagged are desig-
nated with a triangle. The target directory is D:\D2. Preserve
directories is checked.

C: D: D:
ALICE D1 D1
BRUCE D2 D2 (contains files copied from Connie)
CONNIE t D2A E c1
D2B C3 (Empty)
C1 o4 C3A
Target Directory
C2 Before Copy C3C
C3 — D2A
C3A — 2B
b D4
C3B
Target Directory After Co
C3C 9 y Py
— C4
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Move

The target directory, D2, will contain its original files and all the
files from directory Connie (which is tagged). Connie is the far-
thest directory in the tree (from the root) that contains all the
tagged subdirectories. Directory C1 is created as a subdirectory of
D2 and all its files are copied to that directory. Because directory
C3 (which is not tagged) is the parent of C3A and C3C (which are
tagged), C3 is also created as a subdirectory of D2, but the files in
C3 are not copied. C3A and C3C are created off of C3 and all their
files are copied into their respective directories.

The Copy Directory dialog in the Tree panel contains the same
Replace existing files check box as the Copy Files dialog. If
Replace existing files is not checked and a file with the same
name exists in the target, an alert appears asking if you want to
overwrite the file. Choose Yes to overwrite or No skip the file and
continue the copy operation. Choosing Cancel returns you to the
Tree panel. If Replace existing files is checked, the files are over-
written without confirmation.

Files that are currently open cannot be copied. If you copy a direc-
tory with files that are currently open, the open files will not be
copied.

Directory

Move acts identically to Copy except that the files and directories
are deleted from one location as they are moved to the new one.
The same options that apply to Copy apply to Move.

If you move a directory structure but have not tagged all the sub-
directories in the structure, any parent directories with subdirec-
tories remaining in the original location will not be moved — they
will only be copied. Because Move is actually a Copy and Delete
combination, the Filer does not delete a directory in which other
untagged subdirectories are located. The files in the tagged direc-
tory are moved and all the tagged subdirectories and the files in
them are moved, but the parent directory itself remains in its
present location if it contains untagged subdirectories.

As with Copy, if you try to move a directory with files that are
currently open, those files will not be moved and the directory it-
self will be copied instead of moved. The open files remain in their
present directory in its present location.

When you Move a directory to a new location on the same drive,
you are actually performing an extended rename operation, just as
if you were moving files to a new location on the same drive. This
operation is much faster than moving the directories (to other
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drives) because they are not being copied and deleted, they are
being renamed.

Delete Directory

Filer Menu

The Delete push button and the Delete menu option should be
used with extreme caution. When working in the Files panel, you
have the option of confirming each file as it is deleted, as well as
choosing Delete All to perform the operation quickly. The Tree
panel gives you these same options, but with directories instead of
files.

After tagging the desired directories, choose the Delete push but-
ton or choose Delete from the Filer menu popup to bring forward
the Delete Directory dialog.

Delete directory: C:\LL

[ 1 Delete files only
[X]1 Remove all sub-directories

«Delete » < Skip > <Delete All > <Cancel >

Delete Directory Dialog

The name of the first tagged directory in the tree appears in the
dialog, along with two check boxes — Delete files only and
Remove all sub-directories.

When Delete files only is checked, the files will be removed from
the disk, but the directory structure will remain intact. When
Remove all sub-directories is checked, you need only tag the
parent directory. The parent and all its subdirectories will be
deleted. To remove specific subdirectories, tag each directory in-
dividually as described earlier in this chapter and make sure
Remove all sub-directories is not checked.

As in the Files panel, you can choose Delete to remove a tagged
directory and all the files it contains. The next tagged directory
will then be displayed. Continue choosing Delete until all the
desired directories are removed.

If a directory appears that you don’t want to delete but you still
want to continue the operation, choose Skip. The directory will
remain unchanged and the next tagged directory will be displayed
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in the dialog. To halt the operation without deleting any addition-
al directories, choose Cancel.

In the Delete Directory dialog, you only see the names of the direc-
tories, not the names of the files in those directories. Remember
that all the files are deleted along with the directory.

This dialog, like the Delete Files dialog in the Files panel, also has
a Delete All option. When you choose this option, a final confirma-
tion/warning message appears. This message asks, “Are sure you
want to do this?” If you choose Yes, all the tagged directories and
all the files in those directories are removed from your disk in one
operation. There will be no other confirmation prompts after this
point.

Be very careful when deleting in the Tree panel. As stated
earlier, it is best to back up all files to an alternate location
(floppy disk, tape, network) before deleting them from your
disk.

Directory Size

When a directory is tagged and you choose the Size push button or
choose Size from the Filer menu popup, the Size dialog appears.
The Size dialog is the same as the Size dialog in the Files panel.
This dialog displays the number of files in the tagged directory(s)
as well as the size of the tagged files in bytes and clusters. For
more information on this dialog, see File Size in this chapter.

Display Files Panel
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When you choose the Files push button or choose File Panel from
the Filer menu popup, you are returned to the Files panel of the
Filer. The features and options in the Files panel are described
earlier in this chapter.
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10 Introduction to FoxPro Power Tools

This chapter introduces you to the FoxPro power tools. FoxPro
power tools automate the construction of user interfaces, the
retrieval and display of information, the gathering of application
components from various locations into an .APP or an .EXE, and the
updating of applications when components change.

The power tools available in FoxPro are:
® Project Manager
¢ Screen Builder
¢ Menu Builder
® Relational Query By Example (RQBE)
® Report Writer
* Label Designer

Power tools make it easy for you to design screens, menus, queries,
reports and labels without programming — then FoxPro generates
the code needed to include these elements in your applications.
When you want to modify an interface element, simply make ad-
justments through the interface then regenerate the code. You
never need to look at the associated code for an interface element.

You combine interface and other types of elements for each ap-
plication into a project. A project manages the interrelations be-
tween the interface elements and ensures that the pieces are up-
to-date when you are ready to build the application.

For additional information about any power tool, refer to the ap-
propriate chapters in this manual and in the FoxPro Developer’s
Guide.
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FoxPro Projects

G10-2

A project is the central mechanism used to unify and coordinate
the elements of a FoxPro application. Creating a project is usually
the first step in the process of developing a FoxPro application. A
FoxPro project:

Remembers the location of every file it contains.

A project keeps track of the location of all programs, screens,
reports, etc., that comprise an application. This makes it very con-
venient to organize programs, screens and other components in
directories according to function, subsystem, or other appropriate
category. This also makes it easy to maintain an application.

Accesses prewritten programs and interface components easily.
Because projects permit application components to be scattered
across many directories, they also make it easy to access libraries
of prewritten program elements (like control panels, browsers, etc.)
that are stored in a common directory and used by many applica-
tions.

Stores object code.

Object .FXP code is stored in the project itself (in memo fields).
This reduces clutter on your disk caused by saving individual .FXPs
for each compiled version of a program.

Locates and assembles referenced files.

When you build a project, FoxPro automatically locates and
gathers all components of the application. To create a project from
an existing application, just add the startup program for the ap-
plication and rebuild the project. All referenced programs, screens,
menus, reports, queries, labels and libraries are automatically in-
corporated in the project.

Tracks current versions of files.

When you build a project, FoxPro checks that the object code
stored in the project is up to date. If it isn’t, FoxPro recompiles
programs, regenerates and recompiles screens and menus, etc.
This project feature is similar to “make” utilities with which you
may be familiar.

Streamlines distribution.

When an application or an .EXE is generated from a project, all the
elements of the application (except reports and labels) are gathered
together into a single .APP or .EXE file. This makes distribution of
an application particularly convenient.
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Project Contents

All the components of an application are coordinated by a project.
FoxPro projects can contain the following components: programs,
screen sets (containing one or more screens), menus, formats,
queries, reports, labels and libraries.

The components can be grouped according to function:
¢ Procedural: programs
¢ Interface: screen sets, menus, formats
¢ Data Retrieval/Reporting: reports, labels, queries
¢ External API Routines: libraries

¢ Other components: databases, mem files, keyboard macros

Project Components
Procedural:
« programs
Interface: \ External Routines:
- screen sets . « libraries
. menus Project
- formats
Retrieval/reporting: Other Files:
- reports - databases
- labels « mem files
- queries - keyboard macros
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Procedural Components

Programs are procedural components that can be included in a
project. In a project, you can include individual programs as well
as programs that call other programs.

Interface Components

Interface components that can be included in a project are screen
sets, menus and formats.

The Screen Builder allows you to create screen sets consisting of
one or more screens. Each individual screen is a functionally com-
plete interactive element that can be part of a larger functional
group of control panels and full screen displays. You design and
modify individual screens in a Screen Design window, then com-
bine them into a screen set and let FoxPro generate the code.

The Menu Builder is used to create menus to add onto or replace
FoxPro’s system menu bar. You design and modify menus in a
Menu Design window, then let FoxPro generate the necessary
code.

A format is a custom screen design that can be included for back-
ward compatibility.

Data Retrieval/Reporting Components

Reports, labels and queries used for data retrieval and reporting
can be part of a project.

The Report Writer makes it easy to create custom reports by plac-
ing objects in a Report Layout window.

The Label Designer allows you to create labels in standard or cus-
tom formats by specifying options in a Label Layout window.

A query is a specific type of program that contains commands
needed to extract information from one or more databases. The
RQBE window allows you to create and modify a query without
knowing any of the commands needed to extract information. You
can choose buttons and options and FoxPro generates the neces-
sary code.

External API Routine Components

External API routine components that can be included in a project
are libraries. You can reference libraries of prewritten routines by
including the libraries in a project.
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Other Components

A project can contain database files, index files, keyboard macro

files, view files, memory variable save files and any other type of
file.
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11 Project Manager
L

This chapter focuses on project management and the creation of
applications. More information about projects is available in the
FoxPro Developer’s Guide and in the chapter titled Introduction to
FoxPro Power Tools.

A project is the central mechanism used to unify and coordinate
the elements of a FoxPro application. Creating a project is usually
the first step in the process of developing an application. You
specify the files that are required to create an application and the
project manages the interrelations between the files, ensuring that
the files are up-to-date when you build an application.

A FoxPro project:
* Remembers the location of every file it contains
® Accesses prewritten programs and interface components easily
® Stores object code
® Locates and assembles referenced files
® Tracks current versions of files
® Streamlines distribution

A project is a special database that has a .PJX extension and an
associated memo file (.PJT).

Once you create a project, you can use it to build an application
(.APP). The application created from a project contains code
generated from screens and menus, as well as program code.
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Creating a Project

You can create a project in the Project window. The steps involved
in creating a project are listed below and each step is described in
detail in its own section.

To create a new project:

1. Open the Project window.
2. Add files to the project.
3. Build the project.

Open the Project Window
To open the Project window so you can create a project, do one of
the following:

¢ Choose New... from the File menu popup, then choose the
Project radio button and choose OK.

® Type CREATE PROJECT [<project_name>] in the Command
window and press Enter.

The Project window appears so you can specify the files to be in-
cluded in the project. The Project window is untitled unless you
specified a <project_name> with CREATE PROJECT.

UNTITLED. PJX

Edit >
Info >

< Add >

< Remove >

< Build >

Project Window
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When a Project window is frontmost, a Project menu popup is
added to the menu bar. Each menu option on the Project menu is
described in this chapter.

7rose- S

Options... "0
Project Info "J
Shou Errors S
Set Main
Exclude ~C
Edit “E
File Info... "I
Add “A
Remove )
Build... “B
Pack

Project Menu

Add Files To the Project

A project keeps track of all the files needed to create an applica-
tion, but you must add these files to the project initially. You can
add any type of file to a project.

RIS In the case of a program that calls other programs, you only
_" need to add the main program to the project. The called
g programs are added to the project automatically when you

build the project.
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To specify files to include in a project, choose Add in the Project
window or from the Project menu popup. An Add File dialog ap-
pears so you can add an existing file or a new file to the project.

Add:

[BAT] Drive C ﬂ

[BIN]

LCOMMAND]

[DEMORG]

[DEMO1 Directory c: "

[FOXPROX1

[FOXPRO]

[HSG] « Add »

[ 1 All Files < Neu >
Program ﬂ Type < Cancel >

Add File Dialog

You can include any type of file in the project: program, screen,
menu, query, report, label, library, format, database (any as-
sociated memo file and structural .CDX are automatically added),
index, or any other type of file. You can even add files such as
keyboard macro, view and memory variable save files.

From the Type popup, select the file type you wish to add. The file
list displays only files of the selected type. Now, you can add an
existing file or a new file.

Add an Existing File

I\

When the desired file type appears on the Type popup in the Add
File dialog, select the file you want to include in the project and
choose the Add push button. (Any .FXPs with no source code are
listed with .PRGs in the Open File dialog when Program appears
on the Type popup.) The file name appears in the Project window.

The first file added to the project that FoxPro can execute
(menu, screen or program) appears with a bullet next to its
type, indicating that it is the main file. The main file is
similar to a main procedure file — it contains references to
all the other parts of the project. To specify a different main
program, select the desired file in the Project window and
choose Set Main from the Project menu popup.

Project Manager
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You may continue adding files one by one until all the files in your
application appear in the Project window.

Add a New File

When the desired file type appears on the Type popup in the Add
File dialog, choose the New push button. A Save As dialog ap-
pears so you can name the new file. Once you name the file and
choose Save, the appropriate type of window appears so you can
create the new file.

The Project window displays the name of the new file, regardless
of whether you add information to the file and save it, leave the
file empty and save it, or don’t even save the file.

You may continue adding files one by one until all the files in your
application appear in the Project window.

Build the Project

To create the project file, choose Build in the Project window or
choose Build... from the Project menu popup. A Build Option
dialog appears.

Select Build Option
*) Rebuild Project
) Build Application
> Build Executable « OK »
(+> Compact
¢ > Standalone
C ) Standalone Extended < Cancel >

<
<
C

[ 1 Display Errors
[ 1 Rebuild All

Build Option Dialog

Choose the Rebuild Project radio button to indicate that you want
to build a project.

RIS In the case of a program that calls other programs, you only

__ need to add the main program to the project. The called

£ programs will be added to the program automatically when
you build the project.
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Two check boxes appear in the Build Option dialog:

® Check Display Errors if you want any errors that occur during
the build process to be displayed in a window after the build
is complete. If you don’t check this check box, you can still
see the errors anytime after you build by choosing Show
Errors from the Project menu popup.

® Check Rebuild All if you want to refresh all files in the
project. Otherwise, FoxPro only refreshes files with a source
time stamp that is later than their time stamp in the project
file.

When you are satisfied with your choices, choose OK. If your
project is untitled, FoxPro asks if you want to save the project.
Choose Yes to save the project. A Save As dialog appears. Name
the project and choose OK. FoxPro automatically builds a project
file unless it can’t locate a file in the project.

If FoxPro can’t find a file in the project, it looks for the file in the
following locations and in this order: the default directory, the
directory where the project is located, any place where it has pre-
viously found a file in the project, or along the FoxPro path.

If FoxPro still can’t find the file, a Locate File dialog appears.
This dialog displays the name of the file that cannot be located,
along with the following push buttons:

Locate Displays an Open File dialog so you can adjust the
drive and directory as necessary to locate the file that
FoxPro cannot find. Once you find the file, select it
and choose Open. FoxPro stores the location of the
file in the Project so it can locate it in the future. The
build process continues.

Ignore Ignores the file that it can’t find and builds the
project without knowing where the file is located.

Remove Removes the specified file from the project then con-
tinues with the build process. When you remove a file
from a project, the associated record in the project’s
.PJX database remains but is marked for deletion.
When you have removed several files from a project,
you may want to choose Pack from the Project menu
popup to remove records from the .PJX database that
are marked for deletion.
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Cancel Cancels the build process and returns you to the
Project window.

When you build a project, code is generated for any menus or
screen sets that are part of the project.
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Creating Applications

G11-8

When you build an application from a project, any files in the
project that can be executed (programs, screens, menus) are com-
bined as part of the application code. Any other types of files are
included in read-only form as part of the application unless you
choose Exclude from the Project menu popup.

When you choose Exclude, a ¢ appears in the Project window next
to the selected file name, indicating that the file will not be in-
cluded as part of the final application.

Excluded files are listed in the Project window for your ref-
erence but must be manually distributed if they are needed
by the application.

You will want to exclude any files such as databases, indexes,
reports and labels that you want the end user to be able to modify.
If you change your mind and want to include a file you excluded,
select the file in the Project window and choose Include from the
Project menu popup.

To create an application from a project:

1. Display a project in the Project window.

2. Choose Build in the Project window or choose Build... from the
Project menu popup.

The Build Option dialog appears.
3. Choose Build Application.

The Build Executable radio button and the associated
Compact, Standalone and Standalone Extended radio buttons
are disabled unless you purchase the FoxPro Distribution Kit.

4. If you want to see any errors that occur during the build
process, check the Display Errors check box.

If Display Errors is checked, any errors that occur during the
build process are displayed in a window after the build is com-
plete. If you don’t check this check box, you can still see the
errors anytime after you build by choosing Show Errors from
the Project menu popup.

Project Manager
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5. If you want to refresh all files in the project, check Rebuild All.

Otherwise, FoxPro only refreshes files with a project time-
stamp that is not current.

6. When you are satisfied with the settings in the Build Options
dialog, choose OK.

A Save As dialog appears so you can name the application or ex-
ecutable. Name the application and choose OK. FoxPro automat-
ically builds the application unless it can’t find a file in the project.

If FoxPro can’t find a file in the project, it looks for the file in the
following locations and in this order: the default directory, the
directory where the project is located, any place where it has pre-
viously found a file in the project, or along the FoxPro path.

If FoxPro still can’t find the file, a Locate File dialog appears.
This dialog displays the name of the file that cannot be located,
along with the following push buttons:

Locate

Ignore

Remove

Cancel

Project Manager

Displays an Open File dialog so you can adjust the
drive and directory as necessary to locate the file that
FoxPro cannot find. Once you find the file, select it
and choose Open. FoxPro stores the location of the
file in the Project so it can locate it in the future. The
build process continues.

Ignores the file that it can’t find and builds the
project without knowing where the file is located.

Removes the specified file from the project then con-
tinues with the build process. When you remove a file
from a project, the associated record in the project’s
.PJX database remains but is marked for deletion.
When you have removed several files from a project,
you may want to choose Pack from the Project menu
popup to remove records from the .PJX database that
are marked for deletion.

Cancels the build process and returns you to the
Project window.
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Specifying Project Options

For each project, you can specify customized information for use
when the project is built. To specify this information, choose
Options... from the Project menu popup. The Project Options
dialog appears.

- Developer Information
Author:
Company:
Address:
City: St: Zip:

Comment Style rr Build Options
(+) Box [::] [ 1 Debugging Information
C ) Asterisk [ 1 Encrypt

- Screen/Menu Code
[X] Save Generated Code

(<) UWith Screen/Menu ¢ > Uith Project ¢ ) In Directory
<{Directory...> |

Home Directory

<{Directory...> [HNIEIZT]N

[ 1 Make these the default settings

« OK » < Cancel >

Project Options Dialog

In the Project Options dialog, you can specify developer informa-
tion such as name, company and address. You can also specify the
style of comments in the code, build options and where generated
screen and menu code will be stored. If you want the settings you
specify in this dialog to be used for all new projects, just check the
Make these the default settings check box.

Developer Information

You can specify developer information for the project by entering
information in the text boxes labeled Author, Company, Address,
City, St(ate) and Zip in the Project Options dialog.
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Comment Style

In the Project Options dialog, you can specify the style of com-
ments in generated code. Choose the Box radio button if you want
comments to appear in a single line box. Choose the Asterisk
radio button if you want comments to appear surrounded by
asterisks.

Build Options

You can specify whether you want to include debugging informa-
tion with compiled code when you build the project and whether
you want to encrypt the compiled code when you build the project.
You can specify none, one or both of these options.

If you want your compiled file(s) to be scrambled for security,
check the Encrypt check box in the Project Options dialog. If any
encrypted .FXPs are included in your project, the code created
when you build the project must be encrypted. The Encrypt check
box is checked automatically if this is the case.

If you want to include debugging information with your compiled
code so that you can see each line highlighted in the Trace window
during execution, you must check the Debugging Information
check box. When Debugging Information is not checked, informa-
tion needed for FoxPro to trace through the code is not saved,
reducing the size of your compiled code by approximately two bytes
per source program line (excluding comments and blank lines).

Location of Screen and Menu Code

In the Project Options dialog, you can specify that generated
screen and menu code should be saved by checking the Save
Generated Code check box. If you decide to save the generated
code, you must choose one of the following radio buttons to deter-
mine where the generated code will be saved:

With Saves generated code in the same directory as the cor-
Screen/ responding source screen and/or menu file. In the
Menu case of a screen set containing multiple screens with

source files in more than one directory, the generated
code is saved with the first screen in the set.

With Saves generated code in the same directory as the
Project project file.
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In Directory Enables a Directory... push button that you can
choose to display the Select Directory dialog and
specify a location for the generated code. Make sure
that the desired drive and directory appear on the
popup controls and choose Select. Instead of choosing
the Directory... push button, you can type the location
in the text box next to the Directory... push button.

Home Directory

Each project has a home directory that, by default, is the current
working directory. The home directory is used to make your ap-
plications portable. During development, you should save the
project and the application built from the project in the home
directory. Any files needed by the project should be stored in sub-
directories of the home directory. Many developers create a sub-
directory for each type of file needed by the project, allowing them
to organize their files by file type.

You can specify a home directory in the Home Directory area of
the Project Options dialog. By default, the directory where FoxPro
is located appears in the text box in the Home Directory area. To
specify a different home directory, type the desired path in the text
box or choose the Directory... push button to display the Select
Directory dialog. In the Select Directory dialog, make sure that
the desired drive and directory appear on the popup controls and
choose Select.

When you distribute an application to others, you can use any
directory on the destination machine as the new home directory.
The new home directory can be any directory with any name at
any level of the directory structure, as long as it has the same
subdirectories containing the same needed files. Just copy the ap-
plication to its new home directory then create the same subdirec-
tories off of the new home directory and copy the needed files to
these subdirectories. (You may want to create an installation
routine to create directories and copy files.)

Use Settings for All Projects
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If you check the Make these the default settings check box in the
Project Options dialog, the same options are specified by default
every time you create a new project. You can always adjust these
options by choosing Options... and making changes in the Project
Options dialog.
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Modifying a Project

You can modify a project in the Project window. To modify an
existing project:

1. Display a project in the Project window.
2. Modify the project.

3. Refresh the project.
4

. Check project and file information.

Display a Project in the Project Window

To display an existing project in the Project window so you can
modify it, do one of the following:

® Choose Open... from the File menu popup and choose the
desired project file (.PJX), then choose Open.

® Type MODIFY PROJECT <project_name> in the Command
window and press Enter.

The Project window appears so you can modify the project.

Modify the Project

You can modify the project by adding and removing files, editing
files and specifying the main file.

To add a file to the project, refer to the section titled Add Files To
the Project.

To remove a file from the project, select the desired file and choose
Remove in the Project window or from the Project menu popup.
An alert appears to confirm that you want to remove the file from
the project. Choose Yes to confirm your intention to remove the
file or No to cancel the removal.

When you remove a file from a project, the associated record in the
project’s .PJX database remains but is marked for deletion. When
you have removed several files from a project, you may want to
choose Pack from the Project menu popup to remove records from
the .PJX database that are marked for deletion.

To edit a file in a project, select the file and choose Edit. The file
appears in the appropriate type of window so you can modify it.
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To specify the main file, select the file in the Project window and
choose Set Main on the Project menu popup. The main file is
similar to a main procedure file — it contains references to all the
other parts of the project.

Refresh the Project

You never need to refresh a project manually. When you build a
project or an application, FoxPro automatically refreshes the
project to guarantee that applications created from a project al-
ways use the most recent source. You may want to refresh a
project manually when you make changes to files in the project or
when dependencies change. To refresh a project manually, follow
the instructions in the section titled Build the Project.

Check Project and File Information

To see status information for project, choose Project Info from the
Project menu popup. The Project Information dialog appears.

C:\FOXPROX\UNTITLED. PJX
Date of Last Build:

Type Current Out of Date TOTALS

Program
Screen Set
Menu
Query
Report
Label
Library
Format
Database
Index
Other

© OO0 OOO®
N OO OOON
N OCODONDOODOOON

TOTALS

« OK »

Project Information Dialog
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The Project Information dialog displays the full file name and path
for the project, as well as the most recent date that the project was
built. This dialog also lists each type of file that the project can
contain, along with:

¢ The number of files of each type having current time stamps

® The number of files of each type having out-of-date time
stamps

® The total number of files of each type included in the project
When you are ready to return to the Project window, choose OK.

To see build information for a specific file in the Project window,
select the file and choose the Info button in the Project window or
choose the File Info... option on the Project menu popup. The File
Information dialog appears.

Name: C:\FOXPROX\GENMENU.PRG
Type: Main Program

Current Version: 83-Jan-31 8:34a
Uersion Last Built:
Date of Last Build:

Symbol Type Usage

< Prior > < Next > « OK »

File Information Dialog

The File Information dialog displays:
¢ The name and path of the selected file
¢ The type of the selected file

¢ Time stamp for the current version, the version last built and
the date of the last build

¢ Information about symbols
Project Manager G11-15



Modifying a Project

To see this information for the next file in the Project window,
choose Next. To see this information for the previous file in the
Project window, choose Prior. When you are ready to return to the
Project window, choose OK.
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Debugging an Application
=2ebugging

When you debug an application created from a project, the source
for the files in the project does not need to be located in the same
directory as the application. The project file can locate the source

files because it contains information about the location of these
files.
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12 Screen Builder

When you build a screen, you are actually creating a piece of
FoxPro source code for your application.

Instead of writing code to create the screen line by line, the Screen
Builder allows you to position and size fields, push buttons, radio
buttons, check boxes, popups, lists, text edit regions, text, lines and
boxes in a Screen Design window.

When you define an object, you can assign it a RANGE clause, a
VALID clause, a WHEN clause, a DEFAULT clause, color and other
attributes. Clauses can be assigned a value that is an expression
or a procedure. If the value is a procedure, you can write code
snippets to specify the behavior of the object. A code snippet is a
procedure or expression associated with a specific clause for a
specific object in a screen. You can also define code snippets that
perform actions on the entire screen.

Other code may also be associated with a screen file. You may
create code snippets that include setup code, cleanup code and ad-
ditional procedures. Setup code might include code to open files,
set filters, declare memory variables, etc. Cleanup and procedure
code might include code to close files, deactivate windows or re-
store the previous environment. Any procedures called by name in
other screen code snippets should be included in the cleanup and
procedure code.

Because these code snippets are stored within the screen file, a
screen file is actually a form of source code for an application. It
becomes a piece of an application just like a program file.

Information about the objects on the screen is saved in a database
file with an .SCX extension. Once the screen has been designed,
code is generated using the screen generator. The screen generator
uses the screen information stored in the .SCX database to create a
program file.

The generated code includes the object definitions, code snippets,
and optional setup and cleanup code specified in the Generate
dialog. The program file can then be executed to activate the in-
terface you have designed. For a complete description of the se-
quence of generated code, see the Screens section of the FoxPro
Developer’s Guide.
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Multiple screen panels, defined by the .SCX files, can even be com-
bined by the generator into screen sets. Screen sets become part of
an application and are included in a project file just like any piece
of source code.
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About This Chapter

About This Chapter

This chapter documents Screen Builder features in the following
order:

Starting the screen painter

Types of objects that can be defined

How to manipulate objects in the Screen Design window
Assigning code snippets to individual objects

Options on the Screen menu popup including instructions on
how to define windows and objects in the Screen Design
window

The options in the Screen menu popup are described in the order
they appear. All dialogs associated with the menu options are
described.

This chapter does not include a tutorial on screen design. Instruc-
tions for beginners are available in the Screen Builder chapters of
the FoxPro Getting Started manual. Information for advanced
users is available in the FoxPro Developer’s Guide.

Screen Builder

Unless otherwise noted, all pictures in this chapter are from
the BROWSER.SCX screen. This screen and all associated
files are located in the FOXPRO\SAMPLE\SCREENS\
directory.

——
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Starting_; the FoxPro Screen Builder

The Screen Builder is a fully integrated feature of FoxPro.

Before you start the FoxPro Screen Builder, you can create the
working environment by opening the necessary database(s), setting
the index order, and establishing relations. All fields in open
databases are available for use in the Screen Builder. This en-
vironment information can be saved in the .SCX database.

It is not necessary to have a database open to access the Screen
Builder. It is possible to design stand-alone screens that can be
used to access and display data in a variety of ways.

Creating a New Screen
To create a new screen:

1. Choose New... from the File menu popup.
2. Choose the Screen radio button.
3. Choose OK. An untitled Screen Design window appears.

If you prefer, you can create a new screen in the Command win-
dow by typing:

CREATE SCREEN
A Screen Design window appears with UNTITLED.SCX as its title.

You will be prompted to name the screen the first time it is saved.
Alternately, you can type:

CREATE SCREEN <filename>

in the Command window. A Screen Design window appears with
the file name followed by the default .SCX extension as its title.
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Opening an Existing Screen
To open an existing screen, choose Open... from the File menu
popup to display the Open File dialog.

Make sure Screen appears on the Type popup. Choose the desired
screen file from the list, then choose Open.

Any associated database and index files are opened automatically
if the Restore Environment check box is checked in the Open File
dialog. Any relations that have been set are re-created as well.
Restore Environment is checked by default.

If you uncheck the Restore Environment check box in the Open
File dialog, the screen opens without restoring any previously
saved environment conditions.

If you prefer, you can type the following command in the Com-
mand window to open an existing screen with its environment:

MODIFY SCREEN <filename>

A Screen Design window with the specified screen file appears.

[ BROUSER. SCX
R: 3C 1 Hove

Criteria

<{Delete >
|1= fieldna“ 3: sought....

« Brouse » < Reset > < Quit >

If the environment information saved with a screen becomes
invalid (e.g., an index tag no longer exists), the screen will
open without error.
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To open an existing screen without its environment, you can type
the following command in the Command window

MODIFY SCREEN <filename> NOENVIRONMENT

Opening Multiple Screens

You may open many screen files at the same time so that you can
cut and paste objects between screens. The number of screen files
you may open is limited only by available memory and available
file handles.

When you copy an object from one screen and paste it into another,
all information associated with the object, including code snippets,
is copied as well.

Quick Screen
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Quick Screen is a feature of the Screen Builder that automatically
places selected fields in the Screen Design window. All you need
to do is position the fields and insert text or graphics to finish
creating the screen. For more information on this feature, see the
corresponding section later in this chapter.
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Screen Builder Objects

FoxPro screens are composed of objects that can be manipulated in
a variety of ways. These objects include graphic objects (lines and
boxes), field objects, controls and text objects.

Graphic Lines and boxes are available for use in screens.
Objects These optional items often make screens easier to
comprehend and aesthetically pleasing as well.

Field Field objects display data from a database field, a
Objects memory variable, a complex expression or a user-
defined function.

When a field object is a database field or a memory
variable, it can be edited. Expressions such as calcu-
lated values can be displayed but not edited.

Field objects can be defined to be edit regions. Edit
regions can be several lines deep and can have scroll
bars to allow the display and editing of large amounts
of data.

Controls Controls include push buttons, radio buttons, check
boxes, popups and lists.

Text In the Screen Design window, text is treated as an
Objects object and can be selected, moved, stacked or deleted.

Creating Objects

Options on the Screen menu popup allow you to create the objects
described above. You may assign code snippets to these objects as
you define them. For complete descriptions of each object type and
how to define objects, see the appropriate sections later in this
chapter.

Selecting and Moving Among Objects

When several objects are present in the Screen Design window,
you can press Tab and Shift+Tab to move from object to object.
The cursor moves from object to object in the Screen Design win-
dow from left-to-right and top-to-bottom.

To select an object with the keyboard, press the Spacebar when the
cursor is positioned on it.
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To select an object with the mouse, point to the desired object and
click.

Selecting Multiple Objects

With the keyboard, you can select multiple objects by selecting the
first object, then holding down the Shift key and using the arrow
keys to move the cursor to the next object. When the cursor is on
the next object, press Shift+Spacebar. Continue until all desired
objects are selected.

Select multiple objects with the mouse by holding down the Shift
key and clicking on the desired objects.

Multiple objects can also be selected with the selection marquee.
The selection marquee appears as a dotted line in the Screen
Design window.

To use the selection marquee with the keyboard:

1. Position the cursor outside the objects to be selected.

2. Press the Spacebar to anchor the marquee. A dot appears in
the Screen Design window in place of the cursor.

3. Use the arrow keys to draw the marquee around the objects
you want to select.

4. Press Enter. All objects in the marquee are selected. Objects
that are partially contained in the marquee are selected as
well.

To use the selection marquee with the mouse:

1. Position the pointer outside the objects to be selected.

2. Press the mouse button and drag the selection marquee around
the desired objects.

3. Release the mouse button. All objects enclosed in the marquee
are selected. Objects that are partially contained in the mar-
quee are selected as well.

Use the keyboard or mouse to select any combination of objects.
When multiple objects are selected they act as one object when
moved, edited (cut, copied, pasted) or deleted.
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Inverting Selected Objects

You can invert selected objects with the selection marquee. When
you invert objects, selected objects become deselected and
deselected objects become selected.

To invert objects with the keyboard:

1. Press the Shift key, then use the arrow keys to position the
cursor outside of the objects you wish to invert.

2. While holding the Shift key down, press the Spacebar to anchor
the selection marquee. A dot appears in the Screen Design
window in place of the cursor.

3. Use the arrow keys to draw the selection marquee around the
desired objects.

4. When the marquee surrounds the desired objects, press Enter.
Objects that were selected are now deselected and objects that
were deselected are now selected.

To invert objects with the mouse

1. Press the Shift key, then drag the mouse to draw the marquee
around the objects.

2. Release the mouse button. Objects that were selected are now
deselected and objects that were deselected are now selected.

Deselecting Objects

To deselect all selected objects in the Screen Design window, posi-
tion the cursor off of any selected objects and press the Spacebar.

To deselect all selected objects with the mouse, position the pointer
off of any selected objects and click.

To deselect single objects when multiple objects are selected, hold
down the Shift key and use the arrow keys to position the cursor
on the object you want to deselect. Press the Spacebar. The
specified object is deselected while all other selected objects remain
selected. With the mouse, Shift+click on each selected object that
you want to deselect.
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Sizing Objects

To size an object with the keyboard:

1. Position the cursor on the desired object.

2. Ctrl+click on the object. The object blinks to show that it is
ready for sizing.

3. Use the arrow keys to make the object the desired size.
4. Press Enter to confirm the action.

To size an object with the mouse:

1. Ctrl+click on the desired object. The object blinks to show that
it is ready for sizing.

2. Hold down the mouse button and drag until the object is the
desire size.

3. Release the mouse button.

When you resize objects they may overlap each other. After resiz-
ing an object, you can move it to a new location in the Screen
Design window.

Moving Objects

To move objects with the keyboard, select the desired object and
use the arrow keys to move the object to its new location in the
Screen Design window. Press Enter or the Spacebar to confirm
the move.

With the mouse, click on the desired object to select it, then drag
the object to its new location in the Screen Design window. Click
anywhere outside the object to deselect it.

When moving multiple objects with the mouse, be sure the pointer
is positioned on any selected object in the Screen Design window.
Click and drag the objects to the desired location. If you click the
mouse on an area in the Screen Design window that is not a
selected object, all objects will become deselected.

If you move an object and press Escape while the object is still
selected, the object will revert to its previous location.

Deleting Objects
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To delete an object, select it and press Backspace or Delete.
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Object Dialogs

Every object in the Screen Design window has an associated
primary dialog. Some primary dialogs can bring forward addition-
al dialogs.

To bring forward the primary dialog for an object with the key-
board:

1. Position the cursor on the desired object.

2. Double-click with the Spacebar or press Enter. The primary
dialog for the specified object appears.

To bring forward the primary dialog for an object with the mouse:

1. Position the pointer on the desired object.

2. Double-click on the object. The primary dialog for the specified
object appears.

Assigning Code Snippets to Objects

Entire screens and individual objects within each screen may be
assigned certain clauses to define the behavior of a screen or ob-
ject. Options in the Screen Layout dialog and in the primary
dialog for specific objects allow you to specify or define a procedure
or an expression associated with a specific clause for the screen or
object. All code snippets for clauses are defined in the same man-
ner.

When you define fields and controls in the Screen Design window,
a dialog associated with the specified object appears. This dialog
contains many options associated with the field or control you are
defining. All of these dialogs contain check boxes that allow you to
define clauses for the object.
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READ and Object Level Clauses
The Screen Layout dialog contains READ level clauses (Screen

Layout... is an option on the Screen menu popup).

Clauses

defined in this dialog apply to the entire screen. The READ level
clauses you may define are ACTIVATE, VALID, DEACTIVATE, SHOW

and WHEN.
C ) DeskTop (+) Windou
Nane: <{Type...>
Title:
Footer:
Size: Screen Code:
Height: 22| [X1 Setup...
Width: 61 [X]1 Cleanup & Procs...
Position: READ Clauses:
Rou: [ 1 Activate... [X] Shou...
Column: [ 1 Valid... [ 1 When...
[X] Center [X] Deactivate...
Environment:
< Save > < Restore > < Clear >

« OK »

< Cancel >

Screen Layout Dialog

READ
Level Clauses

For information on these clauses, see the READ command in the
FoxPro Commands & Functions manual.

Clauses defined for specific objects are called object level clauses.
These clauses are defined for a specific object in the screen. The
Object level clauses you may define are WHEN, VALID, DEFAULT,
and MESSAGE. You can also define an ERROR clause for GET and

EDIT fields.

G12-12

Screen Builder



Screen Builder Objects

Fiela:

C ) Say () Get (> Edit

< Eait... >

« OK »
< Forrat.... >
< Cancel >
Range:
[ 1 Upper... [ ] Lower...
[ 1 UWhen... [ 1 Error... [ 1 Scroll bar Obi
[X1 Valid... [ 1 Comment... [ 1 Allou tabs ject
[ 1 Message... [ 1 Disabled [ 1 Refresh Level Clauses

Screen Field Dialog

For information on these clauses, see the @ ... GET command for
the appropriate object in the FoxPro Commands & Functions
manual.

To specify or define a clause, choose the check box for the desired
clause in the primary dialog for the specified object. A Code Snip-
pet dialog appears with the clause name in the upper left corner.
Below the clause name are two radio buttons, Procedure and Ex-
pression. An Edit... push button is located in the upper right
corner of the dialog.

Ualid:

Procedure < Edit... >

C
C Expression

)]
]

£ " "$sought
uait windou "Can’t have singl < Cancel >
return @

endif

return .t.

Code Snippet Dialog
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Clauses as Procedures

G12-14

The Procedure radio button is selected by default. You may write
code snippets for the procedure in the text editing region of the
Code Snippet dialog or choose the Edit... push button to open a
program editing window behind the dialogs.

The text editing region of this dialog allows the use of tabs to in-
dent code. In all other FoxPro dialogs, pressing Tab moves you
from one area of a dialog to the next. Since pressing Tab in the
text editing region inserts a tab in the region, you must press
Ctrl+Tab to exit the text editing region and move to the next area
of the dialog. With a mouse, you may exit the text editing region
by pointing and clicking on another area of the dialog.

To open an editing window, choose the Edit... push button to exit
the Code Snippet dialog and launch a program editing window be-
hind the primary dialog. Choose OK in the primary dialog. The
procedure editing window is frontmost and you can begin coding.

—er

Windows cannot open on top of dialogs. Program editing
windows open behind the primary dialog

BROWSER sought UALID

$sought
uvait uindou "Can’t have single quote in
value" nouwait

return 8
endif Field:
return .t.
I C ) Say C ) Get C+*) Edit |
< Edit... >
< OK »
< Format... >
< Cancel >
Range:
I
F 1 UPPBP... [ 1 Louer... |
[ 1 Uhen... [ 1 Error... [ 1 Scroll bar
[X] Valid... [ 1 Comment... [ 1 Allou tabs
« Brojf| [ ] Message... [ 1 Disabled [ 1 Refresh

Program Editing Window Behind Screen Field Dialog

This also allows you to open multiple editing windows without
having to choose the object and bring forward the primary dialog.
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Do not enter a PROCEDURE or FUNCTION command when
writing code for a clause at the READ or object level.

The screen generator automatically creates a unique name for each
procedure at the READ and object level. This unique name is in-
serted in the generated code as the value for the specified clause.
The procedure file is assigned the unique name and the code snip-
pet you write follows it in the code. The screen generator docu-
ments the procedure to show specifically the screen, object and
clause with which the procedure is associated.

It is not necessary to place a RETURN at the end of your procedure.
FoxPro will assume “RETURN .T.” if a RETURN is not provided. If
you want to return a value other than .T., the RETURN must be
included.

Editing Multiple Procedures

To open several program editing windows at the same time;:

1. Choose the desired clause check box.
2. Choose the Procedure radio button in the Code Snippet dialog.

3. Choose the Edit... push button to exit the Code Snippet dialog
and open a program editing window for the specified clause.
The editing window opens behind the primary dialog.

4. Choose the next desired clause in the primary dialog and repeat
the process. Another procedure editing window will open on
top of the previous editing window but behind the dialog.

Choose as many clauses as you like, then choose OK in the
primary dialog. The cursor will be positioned in the topmost edit-
ing window. All program editing windows will remain open for
you to enter and edit code. The title bar of each window displays
the file name and the clause for READ level clauses, and the field
name for the object and the clause for the specified field for object
level clauses.
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lmﬂ!!?g

BROUWSER. SCX

BROUWSER SHOU
tg = iif(lenCorder())>=0, Record# ,order()>>

Database BROUSER DEACTIVATE

= 7?7 CHR(?)
Cri RETURN .F.

............

.......................

.......................

BROUSER sought UALID
$sought
uait uindou “Can’t have single quote in
return 8

<Delete >
|1= ?ieldna“ | = “

« Brouse »

BROUSER ad UALID

private x, y, 2z

*

% Add neu condition to list
e

>

Multiple Procedure Editing Windows

When you save the screen with the Save option on the File menu
popup, the code entered in the program editing window is saved in
a corresponding field in the .SCX database.

All open editing windows appear as options on the Window menu
popup. If you leave procedure editing windows open when you
close the screen, they are opened automatically when you reopen
the Screen Design window for modification. The windows open in
the same position as when they were closed. If the windows were
minimized and/or docked, they will open in that state.

Dock your program editing windows before you close the
screen. The next time the screen is opened, the program
editing windows open in their docked state. You can then
maximize the windows to edit code without having to open
them through their associated dialogs.

To close a program editing window, choose Close from the File
menu popup, click on the close box or press Ctrl+W.

Clauses as Expressions
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If the clause is an expression or a named procedure, choose the
Expression radio button in the Code Snippet dialog.

A named procedure is a procedure you write and assign a name for
with a PROCEDURE or FUNCTION command. A named procedure
may be defined with the Cleanup & Procs... option in the Screen
Layout dialog. It may also be any defined procedure located in
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your path. You may define your path with the Setup... option in
the Screen Layout dialog. The Setup... and Cleanup & Procs...
options are described later in this chapter. Named procedures are
called with a DO <procname> command.

Choosing the Edit... push button while the Expression radio but-
ton is selected brings forward the Expression Builder. You may
use options in the Expression Builder to create the expression.
Choose OK to return to the Code Snippet dialog where your ex-
pression will appear in the text editing region. Choose OK again
to return to the primary dialog for the specified object.

Comments

You may assign comments to any object in the Screen Builder.
These comments are for reference purposes only. They do not af-
fect the generated output in any way.

Comment:

These are comments for the sought field
in BROUSER. SCX

« OK » < Cancel >

Comment Dialog

To enter comments, choose the Comment... check box in the
primary dialog for the defined object. The Comment dialog ap-
pears.

Enter your comments in the text editing area of this dialog. If
your comments are lengthy, a scroll bar appears at the right of the

editing area, allowing you to make your comments as long as you
like.

When you are finished writing your comments, choose OK to
return to the primary dialog for the specified object. When you
save the screen, these comments are stored in a corresponding
memo field of the .SCX database.
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Screen Menu

When you start the FoxPro Screen Builder, the Screen menu pad
is added to the menu bar.

Screen

Screen Layout...
Open All Snippets S

Box “B
Field... ~F
Text ~T
Push Button... “H
Radio Button... I
Check Box... “K
Popup... “0
List... “L
Bring to Front “G
Send to Back ~J
Center

Reorder Fields
Color...

Group

Ungroup

Quick Screen...

Screen Menu Popup

The options on this menu popup allow you to create or modify an
input screen definition file quickly and easily. An explanation of
each Screen menu option follows.
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Screen Layout...

Specify type and assign attributes to screen

Screen Layout... displays the Screen Layout dialog so you can
define the location where the input screen will appear (on the
monitor) and whether the screen will appear on the desktop or in a
window. If you define a window, this option allows you to define
the type and attributes for that window.

C > DeskTop C+> Uindouw
Name: <Type...>
Title:
Footer:
Size: Screen Code:
Height: 22 [X1 Setup...
Width: 61 [X]1 Cleanup & Procs... « OK »
Position: READ Clauses: < Cancel >
Rou: [ 1 Activate... [X]1 Shou...
Column: [ 1 Valid... [ 1 UWhen...
[X] Center [X] Deactivate...
Environment:
< Save > < Restore > < Clear >

Screen Layout Dialog

Options in Screen Layout allow you to enter setup code for the
screen and write code for procedures to be used with the screen.
You can also write code snippets for ACTIVATE, SHOW, VALID, DEAC-
TIVATE and WHEN clauses. These code snippets are stored in cor-
responding memo fields in the .SCX database.

At the top of the Screen Layout dialog there are two radio buttons,
Desktop and Window.
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Desktop Screens

W

Choose Desktop to indicate that the screen is to be placed on the
desktop.

A desktop screen cannot be brought forward over other
windows and cannot be assigned any of the attributes
available for FoxPro windows.

When the Desktop radio button is selected, you may define the
size of the desktop (in rows and columns). Editing the row and
column settings simply controls the available area where you can
place objects in the Screen Design window. It does not change the
size of the desktop.

The Screen Code, READ Clauses and Environment sections in this
dialog are available for desktop screens. These options are
described later in this section. All other options in this dialog cor-
respond to window definitions and are dimmed when the Desktop
radio button is selected.

Window Screens
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Choose the Window radio button to define a window in which the
screen will appear. When you choose the Window radio button, all
the options in the Screen Layout dialog are active.

Name You may enter a window name in the Name text box.
If you define the window without a name, the window
will be assigned a unique name upon generation. Un-
less you need to call a window by name, it is best not
to assign a name to the window.

Title The Title text box allows you to specify the text that
will appear in the title bar of the window. The title is
centered in the top border of the window. If the title
is wider than the window, the title is truncated. If
you do not enter a title, the window will be defined
with no title.

Footer The Footer text box acts identically to the Title option
except that the footer appears in the bottom border of
the window. If you do not enter a footer, the window
will be defined with no footer.
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Position

Screen Builder

Screen Menu
Screen Layout...

The Size options allow you to specify the size (in rows
and columns) of the window. A window may be
defined with coordinates that exceed the size of the
Screen Design window. You can scroll the Design
window to view areas not visible on your display.

By default, a window is defined to be the size of the
Screen Design window. If objects are defined in the
Screen Design window before the window is defined,
the window is defined large enough to contain the ob-
jects.

To specify the size of a window by enter the desired
height and width in the Height and Width text boxes.

A size control is located in the lower right corner of
the window definition. If the window is defined with
a border other than the System border, the size con-
trol is available but it is hidden. With a mouse, you
can resize the window in the Screen Design window
by clicking on the size control and dragging the mouse
until the window is the desired size.

The Height and Width text boxes in the Screen
Layout dialog reflect any changes you make when
resizing a window with the size box.

The Position options allow you to specify the location
of the window on the monitor. The row and column
coordinates are relative to the upper left corner of the
desktop. Enter the desired coordinates in the Row
and Column text boxes. These settings define the
location of the window after the code is generated.

When you generate code for your screen(s), an option
in the Generate dialog allows you to reposition the
window(s) for generation purposes only. This feature
is described in the Code Generation section of this
chapter.
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The Center check box is checked by default. When this option is
selected, windows are centered on the desktop after generation. If
all screens in a screen set are centered, they will be stacked on top
of each other. You will need to reposition them prior to genera-
tion.

When you generate code for your screen(s), an option in the
Generate dialog allows you to reposition the window(s) for genera-
tion purposes only. This feature is described in the Code Genera-
tion section of this chapter.

Window Types
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Choose the Type... push button in the Screen Layout dialog to
bring forward the Window Type dialog.

Type: Dialog ||

Attributes: Border:
[ 1 Close C ) None
[X]1 Float C ) Single
[X]1 Shadou (+> Double
[ 1 Minimize C ) Panel
C ) System

« OK » < Cancel >

Window Type Dialog

At the top of this dialog is the Type popup. When you choose an
option on this popup, predefined attributes and a border are auto-
matically assigned to a window. The following table shows the
predefined borders and attributes associated with each window

type.
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Window Types and Default Settings
Window Type Attributes Border
System Close System
Float
Shadow
Minimize
Dialog Float Double
Shadow
Alert Float Double
Shadow
User Shadow Single
(all options available) | (all options available)

Choosing User from the Type popup enables all options in the
Window Type dialog. You may use these options to specify at-
tributes and a border for user windows.

The following window attributes are available:

Close

Float

Screen Builder

This option allows you to close the window with a
menu option, with the keyboard or with the mouse.

If the window is defined with the System border op-
tion, you may also click the mouse on the close box in
the upper left corner of the window’s border.

If the window is not defined with the System border
option, a hidden close box is still available in the
upper left corner of the window’s border. Clicking the
mouse on this corner will close the window, even
though you can’t see a close box.

A window may be moved to any position on the screen
if the Float option is checked.

A window defined without the Float option cannot be
moved.
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Shadow A window defined with the Shadow option checked
has a darkened area behind it resembling a shadow.
Any text or objects covered by the shadow will still be
visible.

Minimize A window defined with the Minimize option checked
can be shrunk to a size of 1 row by 16 columns. The
minimized window will contain its title if one is
defined. If you have not defined a window name, the
minimized window contains a window name
generated by the code generator. The minimized win-
dow can then be placed anywhere on the screen and
maximized back to its original size at any time.

The following borders are available:

None The window will have no border.

Single The window will have a single line border.

Double The window will have a double line border.

Panel The window will have a wide border (like system win-

dows) and any defined controls will be hidden.

System The window will have a wide border and any assigned
controls will be visible.

Storing Code for Screen Setup and Procedures

Two options in the Screen Layout dialog allow you to enter proce-
dure code and screen setup information that is stored in the .SCX
database.

Setup Code
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When you choose the Setup... check box, a program editing win-
dow with the title <filename> Setup is opened behind the Screen
Layout dialog. The <filename> is the name of the .SCX file with
which the Setup program editing window is associated. Choosing
OK in the Screen Layout dialog exits the dialog and positions the
cursor in the first line of this program editing window.
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Because windows cannot open on top of dialogs, program editing
windows are launched behind the dialog. This also allows you to
open multiple editing windows without having to choose the option
and bring forward the dialog.

Use the Setup... option to enter initialization code for the program.
Initialization code can include any commands to select work areas
and use databases, set indexes and relations, etc. You can setup
the environment with set commands and initialize memory vari-
ables with this option.

BROWSER. SCX
R: 14 C: 31 Move

Database Order

Criteria

BROUSER Setup
private sought, seektype, bact, :
flds, fl, qptr, query, op, qp, :
tags, tg, i, bact, qy, dbfs, dx, dbc, :
fieldnane

dimension F1ds(256), query(5@), tags(256>, dbfs(25)

dbc = @
for i =1 to 25
if len(dbf(id> # 8
dbc = dbc + 1
dbfs(dbe) = alias(i)

« Brouse » < Reset > < Quit >

Setup Code for BROWSER.SCX

S When defining memory variables for screens, the REGIONAL
—— commands allows you to define variables to be specific to
one screen. Declaring screen variables as regional in the set

up code ensures that a variable is not affected by a variable
with the same name used in another screen in the screen
set. If the variables are declared as regional variables in
their setup code, FoxPro automatically resolves the conflicts.
For a complete description on the regional variables, see the
REGIONAL section in the FoxPro Commands & Functions
manual.

You may also define windows for your screens in this section.
When you generate screens, an option in the Generate dialog al-
lows you to suppress the generation of DEFINE WINDOW commands
that use the information stored in the .SCX database to define the
windows. If you suppress the generation of these commands,
define your windows in your setup code.
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l /
mx@ —
AN
I

If you want to restore your existing environment upon com-
pletion of the generated program, type CREATE VIEW
<filename> at the beginning of your setup code. This
creates a view file of the current environment. Later, in the
closing procedure, you will restore the environment with the
SET VIEW TO <filename> command.

When you define and generate screen sets containing
|| multiple screens, setup code from successive screens is
concatenated with the setup code from the first screen. It is
possible to write code for one screen that will
unintentionally change the desired output of code written for
a previous screen. Careful planning and coding will ensure
that you obtain the results you intended.

——— — —

When you close the Setup program editing window, you are
returned to the Screen Design window. When you save the screen,
the setup code is saved in a corresponding memo field in the .SCX
database.

Upon generation, code from this field is always reproduced in the
program. This code follows the automatic setup information from
the .SCX database unless Open Files is deselected in the Generate
dialog. When Open Files is deselected, the automatic setup infor-
mation is not generated at all. Only the user defined setup is
reproduced in the program. The Open Files option is described in
the Code Generation section of this chapter.

Cleanup & Procs... Code
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When you choose the Cleanup & Procs... check box, a program
editing window with the title <filename> Cleanup is opened be-
hind the Screen Layout dialog. The <filename> is the name of the
.SCX file with which the Cleanup program editing window is as-
sociated. Choosing OK in the Screen Layout dialog closes the
dialog and positions the cursor in the first line of this program
editing window.

Because windows cannot open on top of dialogs, program editing
windows are launched behind the dialog. This also allows you to
open multiple editing windows without having to choose the option
and bring forward the dialog.
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The Cleanup program editing window is where you may enter code
to close files, release windows, restore your environment, etc. All
code entered with the Cleanup & Procs... option is inserted into
the generated program.

BROUWSER. SCX

&
BROUSER Cleanup

*

* Routine to control the

% scrollable list buttons

»*

procedure setaction

if qptr = 8 or qp > qptr
shou get bact disable
if qp = qptr + 1

shou get bact,4 enable

endif

<{Delete > shou gets

return

endif
1: fieldnal EI H shou get bact,1 enable
ifqptr =1 orgp =1

shou get bact,Z2 disable

« Brouse »

Cleanup Code for BROWSER.SCX

Commands to release windows and close files can be automatically
generated with the Close Files and Release Windows option in
the Generate dialog. If these options are selected, the automatic
closing code is generated and executed before the user-defined clos-
ing code.

You can also use this option to enter code for procedures that will
be used throughout the screen. For example, if you will be using
the same VALID procedure for several objects in the screen, writing
your code here will prevent code duplication upon generation.

When writing procedure code with this option, you must
include a PROCEDURE <procedure name> command.

When defining code snippets at the READ and object level
(described earlier), the screen generator creates a unique name for
your procedures. This does not occur with procedures defined with
the Cleanup & Procs... option.
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All code defined with the Cleanup & Procs... will be inserted into
the generated program. You may enter many procedure files here,
but be sure to give each a unique name and issue a RETURN at the
end of each procedure. You may include your own comments or
use FoxDoc to document your procedures if you like.

Editing Setup and Procedure Code

Program editing windows for setup and procedure code act like any
FoxPro text editing window. You may use all the usual options to
cut, copy, paste, find and replace, etc.

Choosing both the Setup... and the Cleanup & Procs... check
boxes will display editing windows for each of these options behind
the Screen Layout dialog. When you choose OK, the editing win-
dows remain open.

When you save the screen, the code is saved in a corresponding
memo field in the .SCX databases.

The size and location of program editing windows is saved when
you close a screen file. When you modify the screen file, any pro-
gram editing windows open in the same state as when the screen
was closed.

READ Clauses
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ACTIVATE, SHOW, VALID, WHEN and DEACTIVATE are READ level
clauses to which you can assign code snippets for a screen. For a
complete description on how to define code snippets for clauses, see
the section on Assigning Code Snippets to Objects earlier in this
chapter.

These clauses are documented in detail in the READ section of the
FoxPro Commands & Functions manual. Examples of how these
clauses are used are also available in the FoxPro Commands &
Functions manual and in the FoxPro Developer’s Guide.
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Saving Screen Environment Information

At the bottom of the Screen Layout dialog are three push buttons
that affect screen environment information: Save, Restore and
Clear.

The following information about the environment can be saved
with a screen:

¢ Open database files in all work areas
® The currently selected work area

® Index order on any open database file
¢ Any relations that have been set

¢ Any SET SKIP TO condition

When you create a screen there are usually open databases, in-
dexes, etc. that you will want to use whenever you modify or dis-
play the screen. The Save button in the Screen Layout dialog is
used to save this environment information in the .SCX database
when the screen is saved.

Restoring Screen Environment Information

If you have changed the environment by opening or closing
databases, indexes, etc. while modifying a screen, you can restore
the environment information previously saved with the screen by
choosing the Restore button in the Screen Layout dialog. The Re-
store button will be disabled if no environment information is
saved for the screen.

Clearing Screen Environment Information

You can clear the environment information previously saved with
the screen by choosing the Clear button in the Screen Layout
dialog.

The Clear button is disabled if no environment information is
saved for the screen.
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Saving the Screen
Choose Save from the File menu to save the screen. Any modifica-

tions to the screen are saved on disk. The first time you save the
screen, you will be prompted to name the screen file.

If you have not previously saved the environment information, an
alert appears asking if you want to save the environment informa-
tion now.

Save environment information?

« Yes » < No >

Choosing Yes saves the environment information in the cor-
responding fields of the .SCX database on disk. Choosing No saves
the screen without environment information.

0 If the environment information saved with a screen becomes

invalid (e.g., an index tag no longer exists), the screen will
open without error.

—

Open All Snippets

Opens code snippet windows for all code snippets in the screen

Choose Open All Snippets to open program editing windows for all
code snippets associated with the screen. The number of windows
that are opened is limited by memory and available file handles.

To close all program editing windows associated with the screen,
hold down the Shift key while choosing the Screen menu pad. The
Open All Snippets option changes to Close All Snippets.
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Creating Objects

Screens are composed of objects that can be manipulated in a
variety of ways. These objects include graphic objects (lines and
boxes), field objects, text objects and controls.

Box

Draw lines and boxes

Choose Box to place a box or line anywhere in the Design window.
Boxes and lines can improve the look and readability of an input
screen and bring attention to a particular area of the screen.

Creating a Box
To place a box in the Design window:

1. Position the cursor in the Design window in the location you
would like the box to appear.

2. Choose Box from the Screen menu popup. A box, two columns
wide by two rows deep, appears in the Design window. The box
will blink to show that is immediately available for sizing.

Sizing a New Box

To size a new box with the keyboard:

1. Press the Right and Down Arrow keys to stretch the box to the
desired size.

9. Press Enter to confirm the action. Only the right and bottom
borders of the box stretch during sizing. When the box is the
desired size, you can select the box and move it to a new loca-
tion.

To size a new box with the mouse:

1. Click on the box and drag until the box is the desired size.
2. Release the mouse button. Only the right and bottom borders

of the box stretch during sizing. When the box is the desired
size, you can select the box and move it to a new location.
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Manipulating Boxes

Bozxes can be selected, moved, sized and deleted in the same man-
ner as all screen objects. For more information, see the section
titled Screen Builder Objects earlier in this chapter.

Box Dialog

Place the cursor on the box border and press Enter or double-click
on the border with the mouse to bring forward the Box dialog.

Box:

(+> Single line

C > Double line « OK »
C > Panel

¢ > Character... < Cancel >

[ 1 Comment...
< Fill Character... >

Box Dialog

Border and Fill

In the box dialog you can specify whether you want a box with a
single line, double line, panel or character border.

Choosing the Character... radio button brings forward the Charac-
ter dialog so you can specify a character for the border of the box.
Choose a character from the scrollable list, then choose the Select
push button to return to the Box dialog.

Select a character:

« Select »

< Cancel >

Character Dialog
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Choose the Fill Character... push button to bring forward the Fill
Character dialog. Select the desired character from the list, then
choose the Select push button. You are returned to the Box
dialog. Choose OK in the Box dialog to return to the Design win-
dow. The box is now filled with the selected character.

When you draw a box around existing objects in the Design win-
dow, the box is the topmost object in the window. If the box is
filled, it covers the objects underneath it.

To place the box beneath these objects you must select the box and
choose Send to Back from the Screen menu popup. The Send to
Back option is described later in this chapter.

Comments

Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding section
earlier in this chapter.

Drawing a Line

Drawing a line in the FoxPro Screen Builder is similar to drawing
a box except you move the cursor or mouse in only one direction.
To draw a line:

1. Position the cursor in the Design window in the location you
would like the line to appear.

9. Choose Box from the Screen menu popup. A box, two columns
wide by two rows deep, appears in the Design window. The box
will blink to show that is immediately available for sizing.

With the keyboard, use the arrow keys to shrink the box so that it
has not width or depth. Press the Right Arrow key to draw a
horizontal line, or press the Down Arrow key to draw a vertical
line. You can only draw horizontal and vertical lines. Using a
combination of Down and Right Arrow keys will cause a box to be
drawn. Press Enter to confirm the action.

With a mouse, click on the box and drag until the box has no
depth and the line is the desired length. You can only draw
horizontal and vertical lines. Dragging the mouse diagonally will
cause a box to be drawn.
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Options for Lines

Position the cursor on the line and press Enter, or double-click on
the line to bring forward the Box dialog. The options available for
boxes are also available for lines.

Manipulating Lines

Lines can be selected, moved, sized and deleted in the same man-
ner as all screen objects. For more information, see the section
titled Screen Builder Objects earlier in this chapter.

Field...

Place fields in the Design window

To place a field in the Design window, choose Field... from the
Screen menu popup. The Screen Field dialog appears.

Field:

<> Say (> Get (:> Edit

< Edit... > ETTTE

« 0K »
< Format... >
< Cancel >
Range:
[ 1 Upper... [ 1 Louer...
[ 1 Uhen... [ 1 Error [ ] Scroll bar
[X]1 Valid... [ 1 Comment... [ ] Allow tabs
[ 1 Message... [ 1 Disabled [ 1 Refresh

Screen Field Dialog

The Screen Field dialog allows you to define the field display in
several ways. At the top of this dialog are three radio buttons —
Say, Get and Edit. When you choose one of these buttons, the
push button below changes to reflect your selection. These options
differ in the way data is displayed and the clause options that are
available at the bottom of this dialog.
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After defining a field in the Screen Field dialog, the field is placed
in the Design window. The size of the field in the Design window
is evaluated in the following order:

e If a PICTURE format is defined in the Format text box, the
field is the defined width of the picture.

¢ If there is no picture defined, the field in the Design window
is the size of the field as defined in the structure of the
database unless one of the following is true:

— If the field is a SAY expression of character type uses
more than one field or variable, the size of the fields is
concatenated and the field in the Design window is the
total of all the fields in the expression.

— If the field is a SAY expression of numeric type and uses
more than one field or variable, the size of the field in
the Design window is the size of the largest numeric
field in the expression.

— If the field is a SAY expression of date type, the field
will be eight characters wide, even if calculations are
performed.

— All fields of memo type are defined as the width
specified in the SET MEMOWIDTH statement in the
CONFIG.FP. If there is no SET MEMOWIDTH statement in
the CONFIG.FP, the width is the default SET
MEMOWIDTH value of 50.

e If the field is not defined in the structure and has no picture
clause, the size of the field will default to 10 characters wide.

You can change the size of fields after they are placed in the
Design window.

Manipulating Fields

Fields can be selected, moved, sized and deleted in the same man-
ner as all screen objects. For more information, see the section
titled Screen Builder Objects earlier in this chapter.

Modifying Fields

Double-click on a field with the keyboard or the mouse to bring
forward the Screen Field dialog for the specified field. Make any
desired changes in this dialog, then choose OK to return to the
Design window.
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Say Fields

When the Say radio button is selected, you may enter the SAY ex-
pression in the text box to the right of the Say... push button, or
you may choose the Say... push button to bring forward the Ex-
pression Builder. SAY expressions are for display purposes only
and cannot be edited in the generated screen. The expression may
be a calculated value, a combination of fields or any valid expres-
sion.

You can define fields from any open database. Enter
<alias.fieldname> in the text box, or use the Database popup
in the Expression Builder.

When you define a SAY expression, only the Comment... and
Refresh check boxes are available. These options are described in
detail later in this chapter.

Get and Edit Fields
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You may enter a GET or an EDIT field or variable in the text box to
the right of the corresponding push button, or you may choose the
Get... or Edit... push button to bring forward the Choose a Field or
Variable dialog.

You can define fields from any open database. Enter
<alias.fieldname> in the text box, or use the Database popup
in the Choose a Field or Variable dialog.

When defining a GET expression, you may use any data type for
display and editing. The When..., Valid..., Message..., Error...
Comment... and Disabled check boxes are available. These op-
tions are described later in this chapter.

When you choose the Edit option, you may use only Character and
Memo data types. All of the GET check boxes are available for
EDIT fields with the addition of Scroll bar and Allow tabs. These
options are described later in this chapter.
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Format...

When an expression is displayed in the Say/GeVEdit text box, the
Format... push button is active and a text box appears to its right.
Choosing the Format... push button brings forward the Format

dialog.
Format: Editing Options:
[47 I [ 1 Alpha Only
(<) Character C ) Numeric [ 1 To Upper Case
C ) Date C ) Logical L 1R
[ 1 Edit “SET" Date
[ 1 British Date
[ 1 Trin
[ 1 Right Align
[ 1 Center
[X]1 Select on entry
« OK » < Cancel >

Format Dialog

The Format dialog for SAY, GET and EDIT fields allows you to
specify automatic data editing options. Choose the appropriate
check box to specify any of these default options. If any of the
options are mutually exclusive of another, the corresponding option
is disabled. These formatting commands, in conjunction with other
data manipulation functions, let you design your output data in
many ways.

Typical formatting of field data might include converting all al-
phabetical output to uppercase, inserting commas or decimal
points in numeric output, or converting the American date format
(mm/dd/yy) to British format (dd/mm/yy).

Formatting Options

The Format dialog displays editing options that are available for
Character, Numeric, Date and Logical field types, or you can cre-
ate a format template by entering characters in the Format text
box. The formatting options available for each type of database
field are listed in the tables on the following pages.
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Character Data Formatting Options
Option Output

Alpha Only Only alphabetic characters allowed.

To Upper Case All characters are converted to upper-
case.

R Non-format characters are displayed but
not stored.

Edit “SET” Date | Edit data as a date using the current
SET DATE format.

British Date Edit data as a European (BRITISH) date.

Trim Remove all leading and trailing blank
spaces.

Right Align Data is printed flush right in field.

Center Data is centered in field.

Select on Entry Selects the entire field when cursor
enters the field.

Numeric Data Formatting Options
Option Output

Left Justify All numeric data for the specified field
will begin at the leftmost position in the
field.

Blank if Zero If the field output is zero, the zero will
not be printed.

(Negative) Negative numbers will be placed in
parentheses.

Edit “SET” Date | Edit data as a date using the current
SET DATE format.

British Date Edit data as a European (BRITISH) date.
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Numeric Data Formatting Options

Option Output

CR if Positive CR (credit) will appear after the number
if the number is positive.

DB if Negative DB (debit) will appear after the number
if the number is negative.

Leading Zeros Prints all leading zeros.

Currency Displays currency format (as specified
in the Misc panel of the View window
or with the SET CURRENCY command).

Scientific Displays in scientific notation (useful for
very large or very small numbers).

Select on Entry Selects the entire field when cursor
enters the field.

Date Data Formatting Options

Option Output
. Edit data as a date using the current
Edit “SET” Date | oo parg format.
British Date Edit data as a European (BRITISH) date.
Select on Entry Selects the entire field when cursor
enters the field.

Logical Data Formatting Options

Select on Entry

Selects the entire field when cursor
enters the field.
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Format Template
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When you choose options in the Format dialog, the formatting
codes are automatically entered in the Format line of the Screen
Field dialog. You may, however, enter these codes yourself and
bypass the Format dialog altogether.

A format template (the characters entered on the Format line) may
include any desired characters. However, only the characters that
are listed in the table below actively participate in the formatting
of output. If any characters other than those listed below are
entered in the format template, they will be displayed on output.

Code Output

A Displays only alphabetic characters.

K Selects the entire field when cursor enters the
field.

L Displays logical data only.

N Displays letters and digits only.

Y Allows logical Y,y,N and n only. Converts y and
n to Y and N, respectively.

X Displays any character.

9 Displays digits only for character data. Displays
digits and signs for numeric data.

# Displays digits, blanks and signs.

$ Displays fixed dollar sign in front of the numeric
value.

$$ Displays floating dollar sign in front of the
numeric value.

Displays asterisks in front of the numeric value.
This function may be used in combination with a
$ for check protection.

-

Converts lower-case letters to upper-case.

Specifies decimal point position.

, Separates digits left of the decimal point.
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Range

The Range option is available only when a Get or Edit radio button
is selected. The Range option may be used with character, date
and numeric fields to specify a range of values within which input
must lie. The values specified in the Range must be character,
date or numeric expressions depending on the value of the cor-
responding data field.

Two check boxes, Upper... and Lower..., make up the Range sec-
tion of this dialog. Choosing either of these check boxes brings
forward the Code Snippet dialog. To set a range, define a valid
expression or procedure using the Code Snippet dialog. For a com-
plete description on how to define code snippets for clauses, see the
section on Assigning Code Snippets to Objects earlier in this chap-
ter.

0 Do not enter a PROCEDURE or FUNCTION command when

writing code snippets for clauses at the object level.
I

e

The screen generator will automatically create a unique name for
each procedure at the object level. This unique name is inserted in
the code as the value for the specified clause. The procedure file
with this unique name and the code snippet you write is generated
at the end of the program file.

When you set a range it is not necessary to set both upper and
lower boundaries. If one boundary is omitted, that portion of the
range check is bypassed.

After the screen is generated, a message will be displayed when-
ever input is attempted with data that is not in the specified
range. The message will display the correct range.

SAY Clauses and Options

The only options available for SAY fields are Comment... and
Refresh.

Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding documen-
tation earlier in this chapter.

When Refresh is selected, a SHOW routine is generated for the
READ. This routine refreshes the SAY fields and displays data for
the next selected record.
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GET Clauses and Options

W

The clauses available for GET fields are WHEN, VALID, MESSAGE,
DEFAULT and ERROR. For a complete description on how to define
code snippets for clauses, see the section on Assigning Code Snip-
pets to Objects earlier in this chapter.

For complete descriptions on these clauses, see the @SAY...GET or
@...EDIT sections of the FoxPro Commands & Functions manual.

Do not enter a PROCEDURE or FUNCTION command when
writing code snippets for clauses at the object level.

The screen generator will automatically create a unique name for
each procedure at the object level. This unique name is inserted in
the code as the value for the specified clause. The procedure file
with this unique name and the code snippet you write is generated
at the end of the program file.

Disabled

If Disabled is selected for a GET field, you will be unable to access
the field upon generation. Data will be displayed, but the cursor
will skip the field and editing of the field is prohibited.

Comment
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Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding section
earlier in this chapter.
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EDIT Clauses and Options

All the clauses allowed for GET fields are allowed for EDIT fields.

In addition, the Scroll bar and Allow tabs options are enabled.

Scroll Bar

Choosing the Scroll bar option places a scroll bar on the right side
of all editing regions that are at least two lines deep. After
generation, if data for the field is greater than the display area,
the scroll bar allows the user to scroll up and down to view and
edit all the data in the field.

Allow Tabs

Text

Choosing the Allow tabs option allows the user to Tab in the EDIT
field. To exit the field in the generated screen, the user must
press Ctrl+Tab.

Tell the user how to exit an EDIT field by placing “Ctrl+Tab
to Exit” in text just below the EDIT field.

Display and edit text objects

Text can be used where words are required to make the screen
easier to read and understand. The text appears in the screen
exactly as it is typed. Text is treated as an object and can be
selected, moved, stacked or deleted.

Creating Text

To create text, position the cursor in the Design window where you
want the text to appear. Type the text and press Enter. Once you
press Enter or reach the end of a row, the text becomes an object.

Editing Text

To edit a text object, Ctrl+click on the text with the mouse or
select the text and choose Text from the Screen menu popup. The
text is no longer treated as an object. Use FoxPro text editing
techniques to make the desired changes. Press Enter when you
are done editing to make the text an object.
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You can enter comments for a text object. Double-click on the text
object to bring forward the text dialog. The only option in this
dialog is a Comment... check box. Choosing Comment... brings
forward a Comment dialog. For a complete description of this op-
tion, see the corresponding section earlier in this chapter.

Push Button...

Define push buttons in the Design window
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Push buttons allow you to get information from the user that typi-
cally initiates an action. The user chooses the desired button to
perform an action described by the button’s prompt. If push but-
tons are defined as terminating, input is ended when the user
chooses the button.

Push buttons appear as a set of angle brackets surrounding the
specified prompt. The prompt is the text that appears between the
two angle brackets of the push button. Push button prompts may
contain any desired characters except a quote or a semicolon.
Prompts should contain information indicating the type of action
that will take place when the button is chosen.

All buttons will be created the same size based on the length of the
longest prompt. Spacing between the buttons is set to one line or
space and can be changed through the Spacing dialog.

The number of push buttons that can be specified is limited only
by the number that can fit on the screen and the 2048 character
limit for the resulting command line.

The variable specified with the button may be a character or
numeric memory variable or a character or numeric field in a
database.

The value returned to this variable is determined by the button
selected by the user. If a button is not selected, the variable will
be set to 0 (zero).
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Defining Push Buttons

To define push buttons, choose Push Button... from the Screen
menu popup. The Push Button dialog appears.

Push Button Prompts: (+) Horizontal ( > Vertical

[ 1 Terninating <Spacing...>

3 Delete

tt Variable:

E 2R

t Group < Choose... >

Options:

[ 1 UWhen... [ 1 Comment...
[X1 valid... [X] Disabled

[ ] Message...

« Q0K » < Cancel >

Push Button Dialog

In the left portion of this dialog you specify the prompts for the
push buttons. A prompt is the text that appears between the two
angle brackets of the push button in the Design window and in the
generated screen. Push button prompts may contain any desired
characters except a quote or a semicolon.

To define a prompt:

1. Position the cursor in the first text box.

2. Enter the desired prompt and press Enter. When you press
Enter, the cursor is positioned on the next line and you may
enter the prompt of the next push button.

When you enter a push button prompt, a double-headed arrow ap-
pears to the left of the prompt.

Changing the Order of Push Buttons

When more than one button is specified, you can change the order
of the buttons. to change the order of the buttons with the key-
board:

1. Press Tab until the prompt for the first push button is high-
lighted.
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2. Press the Down Arrow key until the prompt for the button you
wish to move is highlighted.

3. Press Ctrl+PgUp to move the prompt up in the list. Press
Ctrl+PgDn to move the prompt down in the list. The button is
now in a new location in the list and will appear in this loca-
tion in the Design window and in the screen after generation.

If your keyboard supports the use of Ctrl+Arrow key combinations,
you can press Ctrl+Up Arrow to move a prompt up in the list and
Ctrl+Down Arrow to move a prompt down in the list.

To change the order with the mouse:

1. Click on the double-headed arrow and drag the button to the
desired location.

2. Release the mouse button. The button is now in a new location
in the list and will appear in this location in the Design window
and in the screen after generation.

Defining Hot Keys and Default/Escape Push Buttons
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Special characters can be used to define hot keys for push buttons,
radio buttons and check boxes. Pressing a hot key in a generated
screen positions the cursor on and selects the prompt of the object
with which it is associated. Special characters can also be used to
define a default or escape push button.

Hot Keys

When defining the prompts of the push buttons, you may define
hot keys associated with the prompts by placing \< before the
letter of the prompt that will be the hot key.

For example, you are defining a push button with the prompt
“Save” and you would like the “S” to be the hot key. When enter-
ing the prompt in the Push Button Names section of the dialog,

type:
\<Save

Upon generation, the “S” will be the hot key for the “Save” push
button.

If you want to make the “v” in “Save” the hot key, you would type:

Sa\<ve

Upon generation, the “v” will be the hot key for the “Save” push
button.
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Default and Escape Push Buttons

Special characters may also be used to define a default or escape
push button.

As in most FoxPro dialogs, the default push button is automat-
ically chosen when the user presses Ctrl+Enter in the generated
screen. Default push buttons appear in the Design window and in
the generated screen with double angle brackets (« ») surrounding
the prompt.

To define a default push button, enter a backslash and an ex-
clamation point (\!) before the prompt when it is defined. For ex-
ample, if you enter:

\!0K

«OK» will appear in the Design window and in the generated
screen as the default push button.

You can define an escape push button that is automatically chosen
when the user presses the Escape key in the generated screen.
The escape button looks like any other push button in the Design
window and in the generated screen.

To define an escape push button, enter a backslash and a question
mark (\?) before the prompt when it is defined. For example, if
you enter:

\2Cancel
Cancel will be designated as the escape push button even though

it appears as all other push buttons in the Design window and in
the generated screen.

When defining a default push button that also has a hot key, the
special characters for the hot key must immediatly precede the hot
key. For example:

\ '\<OK

will make the “O” the hot key and the button will be the default
push button for the screen.
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Deleting Push Buttons

To delete one push button in a group with the keyboard:

1. Press Tab until the prompt for the first push button in the list
is highlighted.

2. Press the Down Arrow key until the prompt for the button you
wish to delete is highlighted.

3. Press Delete.

To delete one push button in a group with the mouse:

1. Click on the double-headed arrow to the left of the desired
prompt to select it.

2. Press Delete.

Deleting the prompt without selecting the double-headed arrow
will not delete the push button.

To delete all push buttons in a group, select the object in the
Screen Design window and press Backspace or Delete.

Terminating Push Buttons
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When code is generated for a screen, objects are activated with the
READ command and its various clauses.

Push buttons perform actions within a READ and are, by default,
non-terminating buttons. When a button is non-terminating, all
controls remain active and you can make further selections and
enter additional data in the generated screen.

Examples of non-terminating buttons occur in FoxPro when push
buttons are present in a window, such as the View window. When
you choose a push button in the View window, the View window
remains active and dialogs may come forward.

Terminating push buttons exit the READ and execute the next line
in the controlling program.

Examples of terminating push buttons occur in FoxPro dialogs.
When you choose a terminating push button in a FoxPro dialog,
the dialog is exited and you are returned to the previous level.

To keep your programs consistent, use non-terminating but-
tons in all windows that are non-modal. Define terminating
push buttons in all modal dialogs. For more information
refer to the FoxPro Developer’s Guide.
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Push Button Spacing

As described earlier, when push buttons are defined, there is one
space between each button if they are defined horizontally and one
line between them if they are defined vertically. To change the
default spacing of the buttons, choose the Spacing... push button.
The Spacing dialog appears.

Button Spacing:

Characters: JJE

< Cancel >

Spacing Dialog

By default, the number 1 is displayed in the Characters text box.
Select this text box and enter a new number. The push buttons
will appear in the Design window with the specified number of
spaces or lines between the buttons.

Sizing Push Buttons

By default, all push buttons that are defined together (associated
with the same variable) are the size of the button with the longest
prompt. Sizing push buttons changes the space between the
prompt and the angle brackets. It does not change the space be-
tween the closing and opening brackets of two push buttons that
are defined horizontally or the number of lines between push but-
tons that are defined vertically.

Push buttons can be sized only as small as the longest prompt of
all push buttons. For example, if the longest prompt is 10 charac-
ters, all buttons are 10 characters wide. Prompts with less than
10 characters are padded with spaces.

If you modify the prompts of push buttons, their size does not
change. If you modify the longest prompt in the previous example
to be 5 characters, all buttons remain 10 characters wide and are
padded with spaces. You must resize the buttons in the Screen
Design window.

Use the standard sizing techniques to resize push buttons. For
more information, see the section titled Screen Builder Objects ear-
lier in this chapter.
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Variable

The variable specified with push buttons may be a numeric or
character memory variable or a numeric or character field in a
database.

To define the variable, enter the variable name in the text box to
the right of the Choose... push button. You can enter a variable
name that has not yet been defined. If FoxPro can’t find the
specified memory variable, a memory variable with the specified
name is automatically created and assigned a default value of 0
(zero).

Alternately, you can choose the Choose... push button to bring
forward the Choose Field/Variable dialog. In this dialog you can
choose a database field or an existing public memory variable.

Choose a Field or Uariable:<varN>

bact
Database Fields: Memory Variables:
Database:

»LASTNAME c | > _ALIGNMENT | C
FIRSTNAME C CLIENTS “ _BoX L
MIDINITIAL | C _INDENT N
DEPARTMENT | C _LMARGIN N
COMPANY c _PADUANCE c
ADDRESS C « OK » _PAGENO N
CITY c _PBPAGE N
STATE c < Cancel > _PCOLNO N
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Choose Field/Variable Dialog

To choose a field or variable with the keyboard:
1. Select the desired field or variable in the appropriate list.

2. Press Enter. The field or variable name appears in the text box
at the top of the dialog.

3. Choose OK to return to the Push Button dialog. The field or
variable name appears in the Variable section of the dialog.
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To choose a field or variable with the mouse:

1. Double-click on the desired field or variable name in the ap-
propriate list.

2. Choose OK to return to the Push Button dialog. The field or
variable name appears in the Variable section of the dialog.

If the memory variable or database field is of numeric type, a num-
ber corresponding to your choice is stored to the variable or field.
For example, if you create four push buttons and choose the third
button, 3 is stored to the memory variable or field. If the variable
or field is of character type, the prompt of the push button (with
all special characters removed) is stored to the memory variable or
field. Special characters are described earlier in this section.

Push Button Clauses and Options

The clauses available for push buttons are WHEN, VALID, DEFAULT
and MESSAGE. For a complete description on how to define code
snippets for clauses, see the section on Assigning Code Snippets to
Objects earlier in this chapter.

For a complete description of push buttons and associated clauses,
see the @...SAY/GET or @..GET — Push Buttons command in the
FoxPro Commands & Functions manual.

Do not enter a PROCEDURE or FUNCTION command when
writing code snippets for clauses at the object level.

The screen generator automatically creates a unique name for each
procedure at the object level. This unique name is inserted in the
code as the value for the specified clause. The procedure file with
this unique name and the code snippet you write is generated at
the end of the program file.

Disabled

If Disabled is checked for push buttons, you will be unable to ac-
cess the buttons in the generated screen. The buttons are dis-
played, but the cursor will skip the buttons and the buttons cannot
be chosen.

Screen Builder G12-51



Creating Objects
Radio Button...

Comment

Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding section
earlier in this chapter.

Radio Button...

Define radio buttons in the Screen Design window
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Radio buttons allow you to get information from the user that typi-
cally indicates an action or option.

Radio buttons usually occur in groups. They appear as a set of
parentheses with one space between. When the radio button is
turned on, a dot appears in the space between the parentheses.

Radio buttons, like push buttons, are accompanied by text that
identifies the action or value associated with each button. At any
given time, exactly one button in the group is on. When the user
selects another button in the group, the newly selected button
turns on and the button that was previously selected turns off.

Radio buttons are automatically treated as non-terminating but-
tons. For a description on terminating buttons versus non-ter-
minating buttons, see Terminating Push Buttons in the push but-
ton section of this chapter.

The number of radio buttons that can be specified is limited only
by the number that can fit on the screen and the 2048 character
limit for the resulting command line.

The variable specified with the button may be a character or
numeric memory variable or a character or numeric field in a
database. The value returned to this variable is determined by the
button selected by the user.
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Defining Radio Buttons

To define radio buttons, choose Radio Button... from the Screen
menu popup. The Radio Button dialog appears.

Radio Button Prompts:

L |

C ) Horizontal (+) Uertical

Variable:

< Choose... > | ]

Options:

[ 1 UWhen... [ 1 Comment...
[ 1 Valid... [ 1 Disabled
[ 1 Message...

Initial: ﬂ « OK » < Cancel >

Radio Button Dialog

In the left portion of this dialog you will specify the prompt for
each radio button. The prompt is the text that will appear to the
right of the parentheses of the radio button in the Design window
and in the generated screen. Radio button prompts may contain
any desired characters except a quote or a semicolon.

Radio button prompts are defined and manipulated in the same
manner as push button prompts. For more information, see the
section titled Defining Push Buttons earlier in this chapter.

Defining Hot Keys

Special characters allow you to define hot keys for push buttons,
radio buttons and check boxes. Pressing a hot key in a generated
screen positions the cursor on and selects the prompt of the object
with which it is associated.

Hot keys for radio buttons are defined in the same manner as hot
keys for push buttons. For more information, see the section titled
Defining Hot Keys for push buttons earlier in this chapter.

Deleting Radio Buttons

Radio buttons are deleted in the same manner as push buttons.
You can delete one radio button from a group of radio buttons, or
you can delete all radio buttons in a group. For more information,
see the section titled Deleting Push Buttons earlier in this chapter.
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Spacing

Radio buttons may be displayed either vertically or horizontally in
the screen. Choose the appropriate radio button in the Radio But-
ton dialog for the desired display.

Spacing between the buttons is set to one space for horizontal but-
tons and zero lines for vertical buttons. You can change the
horizontal spacing of buttons.

To change the spacing of radio buttons, use the same techniques as
for sizing an object in the Screen Design window. For more infor-
mation, see the section titled Screen Builder Objects earlier in this
chapter.

You must have enough lines defined in your screen or window to
allow at least one space between each button before you try to
increase the spacing. If the screen or window definition is too
small, the buttons will blink when they are selected for spacing,
but you will not be able to increase the spacing.

Variable

The variable specified with push buttons may be a numeric or
character memory variable or a numeric or character field in a
database.

Use the same techniques to define a variable for radio buttons that
you use to define a variable for push buttons. For more informa-
tion, see the push button variable section earlier in this chapter.

If the memory variable or database field is of numeric type, a num-
ber corresponding to your choice is stored to the variable or field.
For example, if you create four push buttons and choose the third
button, 3 is stored to the memory variable or field. If the variable
or field is of character type, the prompt of the push button (with
all “special” characters removed) is stored to the memory variable
or field. Special characters are described earlier in this section.

Radio Button Clauses and Options
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The clauses available for radio buttons are WHEN, VALID, DEFAULT
and MESSAGE. For a complete description on how to define code
snippets for clauses, see the section on Assigning Code Snippets to
Objects earlier in this chapter.

For a complete description on radio buttons and their associated
clauses, see the @...SAY/GET or @...GET — Radio Buttons sections of
the FoxPro Commands & Functions manual.
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Do not enter a PROCEDURE or FUNCTION command when
writing code snippets for clauses at the object level.

The screen generator will automatically create a unique name for
each procedure at the object level. This unique name is inserted in
the code as the value for the specified clause. The procedure file
with this unique name and the code snippet you write is generated
at the end of the program file.

Disabled

If Disabled is checked for radio buttons, you will be unable to ac-
cess the radio buttons upon generation. The radio buttons will be
displayed, but the cursor will skip the buttons and they cannot be
chosen.

Comments

Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding section
earlier in this chapter.

Initial

In the lower left corner of the Radio Button dialog is the Initial
popup. This is the value with which the variable is initialized
during generation. By default, this value is 1 (the name of the
first prompt in the list).

The name of the first defined prompt is displayed in the popup
control, and any prompts defined in this dialog are displayed when
you choose the popup control. When you choose a prompt from the
popup, the chosen prompt is then displayed on the popup control.
This prompt will appear as the selected radio button in the Design
window and in the generated screen when it is first displayed.
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Check Box...

Define check boxes in the Screen Design window

Check boxes appear singly or in small groups and act like toggle
switches. Theyre used to indicate a state that is one of two
values, such as on or off.

A check box appears as a left bracket and a right bracket with a
space between them. When the check box is chosen, an “X” toggles
on or off. Typically, if the box is checked, the indication is that the
state is on; otherwise it’s off.

Check boxes act as individual objects in the Design window. They
may be selected then moved, stacked or deleted independently of
all other objects (including other check boxes).

Check boxes that appear together in a given screen act inde-
pendently of each other. Any number of a group of check boxes
may be on or off at a given time. Though check boxes may appear
in groups, they are defined individually and may be assigned
clauses independently of other check boxes.

Defining a Check Box
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To place a check box in the design window:

1. Place the cursor in the desired location and choose Check Box
from the Screen menu popup. The Check Box dialog appears.

Check Box Prompt:

I |

Variable: « OK »

< Choose... > | | < Cancel >

[ 1 When... [ 1 Comment...
[ 1 valid... [ 1 Disabled
[ 1 Message... [ 1 Initially checked

Check Box Dialog

Screen Builder



Creating Objects
Check Box

At the top of this dialog is a text box for the prompt of the check
box. This is the text that will appear to the right of the check box
brackets in the Design window and in the generated screen.

2. Enter the prompt for the check box.

Defining Hot Keys

Special characters allow you to define hot keys for push buttons,
radio buttons and check boxes. Pressing a hot key in a generated
screen positions the cursor on and selects the prompt of the object
with which it is associated.

Hot keys for check boxes are defined in the same manner as hot
keys for push buttons. For more information, see the section titled
Defining Hot Keys for push buttons earlier in this chapter.

Variable

The variable specified with check boxes may be a numeric or logi-
cal memory variable or a numeric or logical field in a database.

Use the same techniques to define a variable for check boxes that
you use to define a variable for push buttons. For more informa-
tion, see the Variable topic in the push button section earlier in
this chapter.

If the memory variable or database field is of numeric type, a num-
ber corresponding to your choice is stored to the variable or field.
For example, if you create four push buttons and choose the third
button, 3 is stored to the memory variable or field. If the variable
or field is of character type, the prompt of the push button (with
all “special” characters removed) is stored to the memory variable
or field. Special characters are described earlier in this section.

The value returned depends on the variable type that is associated
with the control. An unchecked box corresponds to the value of 0
or “F.” and a checked box corresponds to a value of 1 or “.T.”.

Check Box Clauses and Options

The clauses available for check boxes are WHEN, VALID, and MES-
SAGE. For a complete description on how to define code snippets
for clauses, see the section on Assigning Code Snippets to Objects
earlier in this chapter.

For a complete description on check boxes and the associated
clauses, see the @...SAY/GET or @...GET — Check Boxes sections of
the FoxPro Commands & Functions manual.
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writing code snippets for clauses at the object level.

0 Do not enter a PROCEDURE or FUNCTION command when

The screen generator automatically creates a unique name for each
procedure at the object level. This unique name is inserted in the
code as the value for the specified clause. The procedure file with
this unique name and the code snippet you write is generated at
the end of the program file.

Disabled

If Disabled is checked for a check box, you will be unable to access
the check box upon generation. The check box is displayed, but
the cursor will skip the check box and it cannot be chosen.

Comment

Choosing Comment... brings forward the Comment dialog. For a
complete description of this option, see the corresponding documen-
tation earlier in this chapter.

Initially Checked

The Initially checked check box assigns a default value to the
defined check box. Checking this box will make the defined check
box appear selected in the Design window and in the generated
screen. Leaving the check box unchecked will cause it to appear
deselected in the Design window and in the generated screen.
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Define popups in the Design window

Popups are used for setting values or choosing from a list of re-
lated items. Popups are represented by a box with a double line
on the right and bottom borders. A value is displayed in the box.
When the user chooses this popup control in an input screen, the
popup appears.

A popup may be defined as either a list popup or an array popup.
In a list popup, you will define all the items that appear in the
menu popup. These items remain intact every time you use the
generated screen.

With an array popup, you DIMENSION the array in your setup code
(described in the Screen Layout section of this chapter). The ele-
ments in the array can be defined in a variety of ways. For more
information on arrays, see the appropriate section of the FoxPro
Developer’s Guide.

Options in the Popup dialog allow you to determine the contents of
the first element of the array and the number of elements in the
array. These options are described later in this section.

Defining a List Popup

To define a list popup, place the cursor in the desired position in
the Design window and choose Popup... from the Screen menu
popup. The Popup dialog appears.

(> List Popup C > Array Popup

$ = UVariable:

$t O

t< < Choose. .. > I

>

$ &= Options:

$ >=

$ == [ 1 When... [ 1 Comment

$ IN [ 1 valid... [ 1 Disabled

[ 1 Message... [ 1 1st Element...
[ 1 # Elements...

Initial: = l] « 0K » < Cancel >

Popup Dialog
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At the top of this dialog are two radio buttons — List Popup and
Array Popup. Choose the List Popup radio button.

In the left portion of this dialog you specify the prompt of the
popup options. The prompt is the text that will appear in the
popup. Popup prompts may contain any desired characters except
a quote or a semicolon.

Define the prompts for a list popup in the same manner you define
prompts for push buttons. For more information, see the section
titled Defining Push Buttons earlier in this chapter.

Changing the Order of Prompts

Use the same techniques to change the order of list popup prompts
that you use to change the order of push button prompts. For
more information, see the section titled Changing the Order of
Push Buttons earlier in this chapter.

Deleting Prompts

Delete one prompt in a list popup or the entire popup in the same
manner you delete push buttons. For more information, see the
section titled Deleting Push Buttons earlier in this chapter.

Variable
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The variable specified with popups may be a numeric or character
memory variable or a numeric or character field in a database.

Define a variable for a list popup in the same manner you define a
variable for push buttons. For more information, see the section
on push button variables earlier in this chapter.

If the memory variable or database field is of numeric type, a num-
ber corresponding to your choice is stored to the variable or field.
For example, if you create four popup options and choose the third
option, 3 is stored to the memory variable or field. If the variable
or field is of character type, the prompt of the option is stored to
the memory variable or field.
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Popup Clauses and Options

The clauses available for popups are WHEN, VALID, DEFAULT and
MESSAGE. For a complete description on how to define code snip-
pets for clauses, see the section on Assigning Code Snippets to Ob-
jects earlier in this chapter.

For a complete description on popups and the associated clauses,
see the @..SAY/GET or @..GET — Popups sections of the FoxPro
Commands & Functions manual.

Do not enter a PROCEDURE or FUNCTION command when

writing code snippets for clauses at the object level.

The screen generator automatically creates a unique name for each
procedure at the object level. This unique name is inserted in the
code with as the value for the specified clause. The procedure file
with this unique name and the code snippet you write is generated
at the end of the program file.

Disabled

If Disabled is checked for a popup, you will be unable to access the
popup upon ge